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Abstract, 

The use of open pit mining has increased to extract large and low grade deposits with the 

growth in demand for raw materials, with the advances in mining technology and with 

the depletion of high grade and readily accessible orebodies. Development and extraction 

of minerals by this method is a complex operation that may extend over several decades 

and require very large investments. Before starting the operation, it is necessary to 

design the size and final shape of the pit in order to determine minable reserves and 

amount of waste to be removed. It is also needed to locate the waste dump, processing 

plant, access roads and to develop a production program. The ultimate pit limit depends 

upon many factors. One of the most important factors is the pit slopes which affect the 

stripping ratio and amounts of waste to be removed. When dealing with complex 

deposits in which the pit slopes may vary in different parts of the orebody due to slope 
stability requirements, it is necessary to take into account variable pit slopes in the 

designing of the pit limit. 

Determination of the pit limit 'in open pit mining is one of the ' most important 

design factors which may be considered many times during the life of the mine as the 

design parameters change in the future or more information is obtained during the 

operation. Therefore the use of a computer is essential in order to design the pit as 

rapidly as possible. As a result, a number of algorithms such as the various versions of 

the moving cone method, Lerchs-Grossmann algorithm, network or maximal flow 

techniques, Korobov algorithm, dynamic programming and parameterization techniques 

have been developed to determine the optimum ultimate pit limit since the advent and 

wide spread use of computers. The main objective of these algorithms is to determine the 

optimum pit limit in order to maximise the overall mining profit within the designed pit 

limit subject to the mining constraints. 
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Abstract 

Of these, the Lerchs-Grossmann algorithm is well known for being the only 

method which always yields the true optimum pit limit. However, the algorithm which 

utilises graph theory was based on fixed slope angles that are governed by the block 

dimensions when it was introduced. In spite of the fact that many attempts have been 

made to incorporate variable slope angles, none of them provide an adequate solution 

where there are, variable slopes controlled by complex structures and geology. This 

algorithm is reconsidered and modified to deal with variable slope angles. It is assumed 

that the orebody and the surrounding waste are divided into regions or domain sectors 

within which the rock characteristics are the same and each region is specified by four 

principal slope angles including North, South, East and West face slope angles. 

Consequently slope angles can vary through the deposit to follow the rock characteristics 

and are independent of the block dimensions. In addition, two methods were also 

developed to estimate the four principal slope angles from geotechnical information to 

use as input parameters in the optimal pit, design algorithm. 

A general PC software was also developed to determine the optimum pit limit 

with variable slope angles for an open pit mine. The software is a Windows application 

that'can be implemented under 32-bit operating systems such as. Windows 95, Windows 

NT and. Windows 98. It is capable of taking advantage of all the computer memory and 

designing the optimum pit limit for complex, large and low grade deposits due to solving 

the memory limitation. The software includes both graphical and numerical presentation 

of the, input data and the results of optimisation. Two case studies have been used to 

validate the software developed. 
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CHAPTER 1 

Introduction 

1.1- General background 

Mineral deposits are generally extracted from the earth either by underground'or surface 

mining methods with the objective of extracting the ore ̀  at a profit. In underground 

mining, extraction is carried out below the surface and the mineral deposit is reached by 

driving openings such as vertical shafts, inclined' shafts or adits from the surface to the 

orebody and the mineral' is mined by a variety of stoping methods. In surface mining, on 

the other hand, ' all the operations are carried out from the surface. 

Open pit mining is one of the most-important methods of surface mining in which 

any waste material or overburden is stripped and transported to a waste dump' prior to, 

and sometimes during, mining in order to uncover, and. gain access to, the `mineral 

deposit. In general, mining proceeds from the top to the bottom of the orebody. Both 

stripping and mining are carried out in a series of horizontal layers, usually'of uniform 

thickness, called benches. The choice between an underground mining and a surface 
mining method depends on the depth, 'grade and tonnage - of the orebody and 

consequently on technical and economic criteria. Surface mining methods in the form of 

quarries or open pits are extensively used throughout the world to extract ore at or near 

the surface. Mineral deposits at depth may be extracted by underground mining methods 
but in general, significantly higher grades are required for profitability as the depth 

increases. 
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Open pit mining operations tend to be on a larger scale (i. e. higher production 

tonnages) than underground operations partly because of the usually lower grades but 

also because they are amenable to the use of highly mechanised, high production 

equipment which, although : capital intensive, has relatively, low labour costs. The 

advantages of open pit mining are high productivity, low operating, costs, high 

production rates, good recovery, low, labour requirements and good health and safety 

conditions. The method is also suited to the use of large equipment and the extraction of 

low-grade ore. However, the disadvantage of the method is that it is limited by depth and 

progressively more waste must be mined to reach -ore at greater, depths. Ultimately, 

deeper ore must either be mined by an underground mining method or left in place. 

The development and extraction of ore by open pit mining is a complex operation 

that may extend over several decades and require very large, investments. The major 

exception to this is open pit mining of gold which'is often on a relatively-'small scale with 

a mining life as short as five years. Before extraction, it is necessary to determine the size 

and final shape of the pit at the end of its life. This final shape, or ultimate pit limit, 

represents the, volume beyond which further extraction of ore, using current or assumed 

economic and technical parameters, is uneconomic. The ultimate-pit limit determines 

minable reserves and the total -amount of waste to be removed. It is also used to 

determine locations for the waste dump, and surface infrastructure (such as, processing 

plant and access roads) and to develop a production, programme. Determination of the 

ultimate pit limit is one of the most important design considerations in open pit mining 

and it, may , be recalculated many times during- the life -of the mine as prices, costs, 

technical considerations and geology change. There are a number of factors which affect 

the size and shape 
, of the ultimate pit. - These include, geology, grade, topography, 

production rate, bench height, pit slopes, mining and processing costs, metal recovery, 

marketing and cut-off grade. Some of these factors are discussed below: 

Cut-off grade 

Cut-off grades can be defined for any number of purposes. In general, a cut-off grade is 
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any grade that is used to distinguish two courses of action, e. g. to ý classify as ore or 

waste. 

The open pit mining method' is usually used for low-grade deposits in which the 

ore is not contained within well-defined geological boundaries. In such deposits ore and 

waste are defined by a cut-off grade as opposed to a geological boundary. This cut-off 

grade is a very important factor in mine planning as it 'determines the overall ore reserve 

and the physical location of 'ore -as well as the amount of waste to, be removed. It is a 

complex function of many variables such as grade, price, pit slopes, size of mining 

(selection) equipment, and mining and processing costs. As the cut-off grade increases, 

the tonnage of ore above the cut-off decreases and its average grade increases. Up to a 

certain point the quantity of metal contained in the ore above the cut-off grade (product 

of tonnage and average grade) will remain constant. Beyond this point (and certainly for 

cut-off grades at or above the mean grade of the orebody) the quantity of contained 

metal, and hence the profit, will decline. 

There are several commonly used cut-off grades. The break-even cut-off grade is 

one of the simplest and most widely used. This is the grade at which the, recoverable 

revenue is exactly equal to the cost of mining, processing and marketing. Cut-off grades 

may be classified as either planning or operating cut-off grades depending on the time 

scales to which they refer. Planning cut-off grades are-usually used to define geological 

or minable reserves before the start of operations or for long periods of time. Operating 

cut-off grades are usually used during the operation to make short-term to medium-term 

decisions, e. g. to mine or not, to stockpile or process. A review of earlier work on the 

determination of optimum cut-off grades is given in Chapter 2. 
. 

Bench height 

In open pit mining, the extraction of ore and the stripping of waste material are done in a 

series of layers called benches. Figure 1.1 shows an idealised cross section through a 
hypothetical open pit mine-The vertical distance between each horizontal level in the pit 
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is called the bench height. This height depends on the type of metal/mineral, the manner 

in which it is dispersed in the host rock, the size and type of equipment used to extract 

the ore, the blasting method, the production rate and the geotechnical characteristics of 

the orebody. The height is usually set as high as possible with regard to the size and type 

of equipment selected for the operation. 

The bench height is often reflected in the vertical dimension of the blocks that 

comprise the orebody block model used by computer methods to determine pit limits. 

Ground surface 

Bench height 

Working pit slo 

Haul road 
Mineral deposit 

Pit bottom 

Figure 1.1- A vertical section through a hypothetical open pit mine 

Stripping ratios 

The stripping ratio is another important factor in open pit mining as it has a major 

bearing on profitability, scheduling and pit design. The stripping ratio is the ratio of the 

amount of waste that must be removed in order to mine a unit quantity of ore and is 

usually expressed as: 

SR = 

Bench slope angle 

Waste (tonne) 
--- Ore (tonne) 
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The break-even stripping ratio (BESR) is calculated from the following equation: 

BESR =R-C, W 

where 

R is the revenue per tonne of ore 
C is the production cost of per tonne of ore (including all costs except 

stripping cost) 
W is the striping cost per tonne of waste 

In some circumstance a minimum acceptable profit is included in the equation: 

BESR = 
R-(C+P) 

---- -w 

where 

P is the minimum" acceptable profit per tonne of ore 

Pit slopes 

The pit slope is a major. factor affecting the size and shape of an open pit. Stability is an 

over-riding consideration, as pit walls must remain stable during the life of the mine. The 

steeper the final slope can be designed, the smaller the amount of waste that has to be 

removed. However, as slopes become steeper, the probability, of failure increases. An 

optimum mine'plan should, therefore, have the steepest final pit limit commensurate with 

stability throughout the period of mining activity. As illustrated in Figure 1.1, there are 
four types of pit slope used in open pit mining: 

1- Pit slope angle, ultimate pit slope or overall slope angle which is the, angle 
between the horizontal and the line connecting the toe of the lowest bench to 

the crest of the uppermost bench. This slope makes no allowance for safety 
berms and haul roads. 
Average pit -slope angle or average ultimate. pit slope which is the angle 
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between the horizontal and the line connecting the toe of the lowest bench to 

the crest of the uppermost bench allowing for the haul road or access ramp 

and safety berms. 

3- Bench slope angle which is the angle between the bench face and the 

horizontal. 

4- Working pit slope angle which is the slope of the pit wall during the mining 

operation. This is usually smaller than the ultimate pit slope angle so as to 

ensure stability and provide a wider space for operation. The working pit 

slope increases during the mining operation until it reaches the pit slope angle 

at the end of mining. 

33° 

45 ° 

40 ° 

I 

350 

480 

52 ° 

Figure 1.2- An example of pit slope varying through the 

deposit. (Plan view of deposit) 

In general, the overall slope is designed to be as steep as possible in order to 

reduce the stripping ratio. Pit slope angles may vary through the orebody and may vary 

with direction due to changes in geological structure and stability requirements. They 

may also vary with elevation. Any realistic method of pit design must, therefore, take 

into account variable slope angles. Figure 1.2 provides an example (in plan view) of how 
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pit slopes may vary though 'a deposit due to changes in lithology' and geological 

structure. 

The determination of pit slopes is essential and must be done before planning the 

pit limit. These are' determined mainly by slope stability methods 'from geotechnical 
information gathered during the site investigation. 

1.2- The objective of the research project 

The present study is focused on the initial stages of open pit design and planning in 

which the main task is to establish the ultimate pit limit. The main objective of the 

research project was to develop general PC-based software for optimal open pit design 

with variable slope angles and incorporating geotechnical design. The stages in reaching 

this objective were: 

The development of a computer program to determine the optimum pit 

outline based on the Lerchs-Grossmann method with variable slope angles. 

Designing the optimal pit outline with an unlimited number of blocks in the 

deposit block model. 
Developing a graphical and numerical interface for data entry and the display 

and interpretation of the results. 

Incorporation of geotechnical information in the design of slope angles. 

Since the advent and widespread use of computers a number of algorithms have 

been developed to determine the optimum ultimate pit limit. Of these, the algorithm 
developed by Lerchs and Grossmann (1956), based on graph theory, is the only 

algorithm that can be proved mathematically always to generate the true optimum pit 
limit. The original algorithm, however, was limited to a single slope angle defined by the 

block dimensions and was incapable of taking into account variable slope angles: Since 

pit slope angles may vary through the - deposit, solving the °general problem -, of slope 
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constraints in the Lerchs-Grossmann algorithm makes it much more flexible, practical 

and reliable. This problem is dealt with in Chapter 3. 

Almost all computer, algorithms are based on a block model of the deposit which 

requires a large amount of, memory to store block characteristics. - Under the DOS 

operating system the memory limitation makes it impossible to implement optimal pit 
design algorithms for block models with large numbers of blocks. DOS programs can use 

only 640 kb of RAM memory, irrespective of the amount of total memory. To overcome 

this limitation and to take advantage of all available PC computer memory a general 

Windows-based program for optimal open pit design was developed to run under a 

32-bit operating system such as Windows 95, Windows 98 or Windows NT in which 

dynamic memory allocation can be used to store block characteristics. 

The functionality of software is enhanced by meaningful presentation of output. 
One of the easiest ways to present optimum pit limit results is by means of plans and 

sections. Several programs were developed to present the results of optimisation and 
input data both in numerical and graphical forms. Graphical presentation includes the 

optimum pit limit both in plan and sections. These are explained in Chapter 5. 

Having modified the Lerchs-Grossmann algorithm to take account of variable 

slope angles, the next step was to determine slope angles based' on geotechnical 

information. Chapter 4 presents two methods for estimating the safe slope angles to use 

as input parameters in the' optimal pit design algorithm. 

1.3- Organisation of the thesis 

The remainder of this thesis is organised into the following chapters: 

Chapter 2 Literature review and survey of previous work- This chapter presents a 

literature review and survey of the previous work including the various 
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algorithms for optimal pit design together with the different methods of 

slope design used in open pit mining. 

Chapter 3 The Lerchs-Grossmann algorithm with variable slope angles- This 

chapter deals with the Lerchs-Grossmann algorithm and incorporation of 

variable slope angles into the algorithm. It also covers the calculation of 

the revenue block model as input for the optimal pit design algorithm and 

a method of smoothing the pit bottom. 

Chapter' 4 Slope design procedure- This chapter provides two methods which are 

incorporated in the optimal pit design software to estimate a set of safe 

angles from geotechnical information as input parameters to determine the 

optimum pit limit. 

Chapter 5 The software- This chapter describes the structure of the software, 

numerical and graphical presentation of the results, data requirements and 

operation of the software. 

Chapter 6 Case studies- This, chapter presents two case studies using real data from 

an operating open pit mine and from a mineral prospect currently 

undergoing a feasibility study. Both data sets are used to validate and 

evaluate the software. 

Chapter 7 Conclusions and recommendations for future work- This chapter 

presents a final evaluation of the significance of this work, and directions 

for future research. 
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CHAPTER. 2 

Literature review and survey of previous work 

2.1- Introduction 

The ultimate limits of an open pit define its size and shape at the end of the mine's life. 

In addition to defining total minable reserves and determining total profitability, these 

limits are needed to locate the waste'dump, processing plant and other facilities. They are 

also required for the'design of overall production schedules within the planned pit shape. 

Since the advent 'and widespread use of computers a number of algorithms have been 

developed to determine the optimal pit outline all with a'common objective: to maximise 

the'overall mining profit within the designed pit limit. This chapter presents a literature 

review and survey of the previous work including an assessment of the different 

algorithms for optimal pit design together with the methods of slope design used in open 

pit mining. _ 

2.2-. Optimal open pit design 

2.2.1- General introduction 

One of the most important Objectives in open pit mining is to design the ultimate pit 

outline and thereby determine the minable ore reserve and the size and shape of the pit at 

the end of its life. The size and shape of the ultimate open pit depends upon many factors 

including geology, grade, topography, production rate, bench height, pit slope angles, 
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mining and processing costs, percentage metal recovery, marketing and' cut-off grade. 
The most basic form of a cut-off grade is a grade that is used to classify mineralised 
material as ore or waste. Taylor (1972) defines cut-off grade as: 

"Any grade that for, any specified reason is used to separate any two 

courses of action, e. g. to mine or to leave, 'to mill or. to dump.... " 

Many attempts have been made to devise a general theory of cut-off grades 

within the context of which an optimal sequence of cut-off grades can be defined and, in 

practice, determined, for the life of a mine. The criterion for optimality is almost 

universally taken to be the maximum Net Present Value of production that results from 

applying a sequence of cut-off grades. The most advanced approach is that of Lane (1964 

and 1988) which is based on the assumption that there are three stages in the mining 

operation comprising mining, concentrating or processing, and refinery and/or marketing. 
Each stage has ' its own associated costs and a certain capacity. The optimum cut-off 

grade is determined by the manner in which these three stages limit `the operation. Lane 

proposed three 'sets of cut-off grades, each , set comprising "three cut-off grades 
determined by the three stages. 

The first set of cut-off grades, called limiting cut-off grades, is determined by 

considering the three stages of the operation, on the assumption that each stage limits 

only the total capacity of the operation. These cut-off grades depend indirectly on the 

grade distribution of the deposit and directly on the price of the final product and the 

cost of producing it. 

The second set of cut-off grades, called balancing cut-off grades, is determined 

by balancing the capacities of each pair, of stages. 

The third set of cut-off grades comprises three optimum cut-off grades one for 

each pair of stages., These optimum cut-off grades are determined by considering the 
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balancing cut-off grades between upper and lower limits imposed by the limiting cut-off 

grades. 

Finally, the effective optimum cut-off grade is, the middle value of the three 

optimum cut-off grades. Lane's method is regarded as a landmark in the determination of 

optimum cut-off grades. His method, however, relies on the assumption that prices, costs 

and recovery remain constant throughout the operation., Dowd (1973), Dowd and Xu 

(1995) and Whittle and Wharton (1995) 
_ 
have coded Lane's method into a computer 

program. 

Blackwell (1970) revised Lane's method, again with three stages, and 
incorporated an additional time cost by using a computer-based algorithm to determine 

the optimum cut-off grade. Taylor (1972) presented a general theory of cut-off grades 

with the inclusion of Lane's method. He also differentiated between planning and 

operational cut-off grades. A planning cut-off grade is normally used to distinguish 

between ore and waste for long-term planning prior to the start, of the operation. An 

operational cut-off grade is used for short-term planning during production. In this study 

the planning cut-off grade is a grade that is used to classify ore and waste on the basis of 

a break-even analysis. 

Roman (1973) introduced dynamic programming to determine production rates 

and Dowd (1976) `extended this work to optimise both production rates and cut-off 

grades. ' Both Lane's method and ' the dynamic programming approach developed by 

Dowd have shown that in order to maximise present value the operation must begin with 

life a relatively high grade which then declines over the of the mine. 

The open pit mining method is normally used to extract orebodies at or near the 

surface., It is usually a large-scale method and requires very large expenditure. The 

development and extraction of ore by, this method may extend over several decades. 

Before extraction is started it is necessary to locate the waste dump and processing plant, 

and determine the size and final shape of the mine-at, the end of its life. There are many 
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ways of designing an open pit. These methods can be classified broadly into two groups: 

manual methods and computer methods (Dowd, 1994a). 

Manual methods of designing pit limits are based on'stripping ratio's and involve 

considerable time and engineering judgment. The pit limits are set on various sections by 

applying economic and technical criteria. The types of section used depend on the shape 

of the orebody and include vertical, longitudinal and radial -sections. The pit limits are 

placed on each section independently using the stripping ratio and pit slope angle. The 

stripping ratio is calculated and compared to the break-even stripping ratio. If the 

calculated stripping ratio is less than the break-even stripping ratio the pit limit is 

expanded. Otherwise it is reduced: This process is repeated until the pit limit is set at a 

point where both stripping ratios become equal. Once the pit limits have been established 
on the individual sections, they are evaluated as a group to examine how they fit together 

and any discontinuities between- sections are smoothed out (Armstrong, 1990). This 

method is time consuming and the result depends on the engineer's knowledge and skill. 

It is also difficult to use this method on a large or complex deposit. Another 

disadvantage of the method is that when smoothing is carried out to combine the various 

sections, the result may not yield the best overall pit. 

Computer methods can be divided into two groups: computer-assisted hand 

methods and optimal open pit design =algorithms. The first group of methods, which are 

the computerised versions of manual techniques (e: g. those in SURPAC), follow the 

same procedure as the manual methods. They have been developed to assist the mining 

engineer to make the necessary calculations ina short time. These methods also allow an 

evaluation of a large number of potential designs quickly and cheaply., 

The . objective of optimal open pit design algorithms is to determine the ultimate 

pit outline for an orebödy together' with the associated grade and tonnage that optimise 

some specified 'economic and/or technical criteria whilst satisfying''practical operational 

constraints. The most common criteria used ' in optimisation are: maximum net profit, 
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maximum net present value, maximum metal content and optimal mine life.. Of these the 

most widely used criterion is maximum net profit. 

Dowd (1994a) provides an overview and classification of the various approaches 

to optimal open pit design and their relationship to the types of orebodies to which they 

are applied. Apart from elementary methods which are used for some 'stratiform deposits, 

most computer algorithms for open pit design use block models of the orebody which are 

either a: 

" Block grade model obtained by considering the deposit as a large box, 

covering the entire orebody, and then subdividing it into smaller blocks and 

assigning estimated grades to each block. 

or a 

" Revenue block model created by applying costs and prices to the grade 

block model of the deposit. 

There are many types of block models including 3D fixed-block model, 3D 

variable block model, 2D irregular block model and 3D irregular block model (Kim, 

1978). Among these, the three-dimensional fixed-block model is the most widely used. 

This model is shown in Figure 2.1 and is obtained by dividing the orebody, into three- 

dimensional blocks of fixed size. Each block is identified within the model by its location 

co-ordinates comprising Easting, Northing and vertical. 

The dimensions . of the blocks depend. on the size of -mining equipment, 

topography and shape of the orebody and the data available for estimating the block 

grades. A number of papers have been written about the, selection of the size of blocks 

namely Whittle (1989), Cai (1992),. Hulse (1992) and, Dowd (1994b). 
- 
Larger blocks 

decrease the number of blocks in the block model which results in-reduced computing 

time. On the other -hand using a larger, block results- in a loss of definition of grade 

variation within the, deposit. Smaller blocks increase computing time and require more 
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memory to store the information. Furthermore, blocks with dimensions that are 

significantly smaller than the drilling, or sampling, grid will give rise to significant 

estimation errors and the variance of the estimated values will be artificially low. If the 

block size is too small in relation to the drilling grid the estimation errors will render the 

estimates meaningless. The vertical height of the blocks is usually set to the bench height 

planned for the mining operation. The horizontal dimensions of the blocks depend on the 

information gathered during exploration and evaluation and the technique used to assign 

grades to the blocks. As a general rule of thumb the horizontal dimensions should not be 

less than one-third of the average sample spacing (Dowd, 1994b). 

Figure 2.1- Three-dimensional fixed block model 

After deciding on the block size a grade must be assigned to each block. 

Methods of doing so include the inverse distance squared method, the polygonal method, 

the triangulation method and the various geostatistical methods. Once the block grade 

model of the deposit is obtained, the next step is to create a revenue block model of the 

deposit. In other words to assign monetary value to each block. This is the value that 
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would be obtained by mining and treating the block and selling its mineral contents. The 

revenue block model can be obtained by applying costs and prices to the block grade 

model providing a net revenue or net profit value for each block. In general, the 
following equation is used to determine a net value of each block: 

NV=R-C 

Where 

NV is the net value of a block 

R is the recoverable metal value 

C is the cost of mining and processing 

In the revenue block model of the deposit air blocks, have a zero value, waste 
blocks have a negative value representing the stripping cost and the ore block with 

sufficient grade have a positive value. A mine may consist of a large number of blocks 

each of which with an estimated grade or net profit. Since not all blocks are extracted, 

the objective of optimal pit design now can be defined as selecting a set of blocks which 

should be mined to maximise some criteria such as net profit or metal content. 

Almost all . computer algorithms 'of optimal design except the parameterization 

approach use a net profit as a criteria and their objective is to the find ultimate pit limit 

that maximise the net profit. Ideally, optimal pit limits must be determined on the basis of 

maximising net present value. As Whittle (1989) stated and paraphrased by Dowd and 
Onur (1993): 

"The pit- outline with the highest net present value can not be 

determined until the block values are known; the block values are not 
known until a mining sequence is specified; and a mining sequence can 

not be specified until a pit "outline is available. " , 

Thus the problem is intractable. One of. the most common. approaches to this 

problem is to design the pit limits' on the basis of maximising net profit, and then 
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determine the' sequence of extraction of blocks, which is called the scheduling program. 
This is undertaken in such a way that the net present value will be a maximum. The 

scheduling program is excluded from this study. 

Lerchs and Grossmann (1965) published the first paper describing a true optimal 

pit design algorithm in 1965. Since then many-'algorithms have been developed for 

determining -optimal pit outlines. Some authors, namely, Kim (1978), Dowd 'and Onur 

(1993) and more recently- Gill, 'Robey and Caelli (1996), have provided surveys and 

comparative studies of these methods. Kim classified the various methods of optimal 
design as "rigorous" and "heuristic" techniques. He used the word "rigorous" for the 

methods that have mathematical proofs such as graph theory and dynamic programming. 

Kim defined "heuristic" as an algorithm that works in nearly all cases but lacks a rigorous 

mathematical proof, examples include the various versions of the floating or moving cone 

method. The most common optimal design methods may be listed as follows: 

1- Graph theory 

2- . Network or maximal flow techniques 

3- Various versions of floating or moving cone 

4- Korobov algorithm 

5- Dynamic programming 

6- Parameterization techniques 

7- Other methods 

2.2.2- Graph theory 

Although many algorithms have been developed since 1965, only the Lerchs-Grossmann 

method (1965), based on graph theory, can be proved,; rigorously, always to yield the 

optimal solution. However, - disadvantages of this approach are complexity of the 

method, computing time and difficulty in incorporating variable pit-slopes. This method 

converts the revenue block'model of the' deposit into a directed graph which is a simple 
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diagram consisting of a set of small circles, called nodes or vertices, and a set of 

connecting arcs (lines with direction) used to indicate the relationship between the 

vertices. A vertex represents each block. Each vertex is assigned a mass that is equal to 

the net value of the corresponding block. Vertices are connected by arcs in such way as 

to represent the mining constraints. These arcs indicate which blocks should be removed 

before a particular block can be mined. Figure 2.2 shows a directed graph for a simple 

two-dimensional example in which the pit slope angle is 45° and the blocks are squares. 

In this example, to mine block 10 it is first necessary to remove blocks 2,3 and 4. 

O 
Node or Vertex -> Are A closire 

Figure 2.2- Directed graph representing a vertical section 

A set of vertices is defined as closure if they represented as a feasible pit. Thus 

the vertices 2,3,4 and 10 is a closure. The value of a closure is the sum of the masses of 

the vertices within it. A maximum closure of the graph is the solution. Therefore this 

algorithm involves the finding of the maximum closure of the graph, in other words, the 

set of vertices or blocks yielding the maximum total value of the deposit. This is found by 
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a set of. rules. The algorithm, of this method will be discussed in more details, in the 
following chapter. 

This algorithm is the only method that can be proved; rigorously, 'always to yield 
the true optimum pit. However, due to the disadvantages, such as complexity of the 

method, computing time and difficulty to incorporate variable pit' slopes, many workers 

have continued to seek alternative methods. Many of the disadvantages are perceived, 

rather than real, and one of the objectives in this thesis is to demonstrate that the Lerchs- 

Grossmann algorithm can be adapted to overcome them. 

The most recent algorithm based on graph theory is that of Zhao and Kim (1992). 

They reported that their algorithm is more efficient in terms of computer representation 

of arcs and, therefore, tree construction compared to the Lerchs-Grossmann algorithm. 

Zhao and Kim also claimed that their algorithm' requires less memory and computing 

time to reach a solution than the Lerchs-Grossmann algorithm. The claim remains to be 

independently verified. 

Computing time 

There is no doubt that the Lerchs-Grossmann algorithm requires more computing time 

than other methods to reach a solution. Because of this problem many alternative 

algorithms have been developed to reduce computing time. The longer computing time is 

the price to be paid for -a guaranteed optimum pit design. Computing time is fast 

becoming irrelevant -with' the advent of faster PC - computers using' 32-bit operating 

systems provided that the software is adapted to the improved hardware. Modern PCs 

can now run the Lerchs-Grossmann algorithm for block models, that only a few years ago 

would have required large mainframe computers. ,, 

Complexity .... 

Another perceived disadvantage of the method is the complexity of the mathematics and 

programming required. This argument implicitly holds that both are beyond the capability 
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of the, average mining engineer. This is not, however, a valid reason for not using the 

method. It is not necessary for the "engineer to have a detailed knowledge of the 

algorithm once it has been coded into a validated software package. Few, if any, 
engineers would understand the algorithms ̀  employed in CAD or contouring packages 

but this does not impede their widespread use. It is, however, essential for the user to be 

awar'of any limitations on software implementations of this (or any other) algorithm. 

Difficulties in incorporating variable slope angles 

There may be many types of rocks, joints and discontinuities within a deposit and, 

because of stability requirements, pit slopes may vary throughout the pit. Any truly 

optimal pit design algorithm must, therefore, take into account variable slope angles. The 

original formulation of the Lerchs-Grossmann algorithm was limited to one vertex to the 

left, one vertex to the right and one vertex' above to define mining constraints (and, 

implicitly, pit slopes) which makes it difficult to incorporate variable slope angles. This 

procedure implicitly assumes that the dimensions of the blocks determine the pit slope. 

Different pit slopes, therefore, require different block dimensions that may . not 

correspond to the required bench height. Furthermore, it_ is not possible to use different 

pit slopes for different parts of the deposit. Many attempts have been made to overcome 

this difficulty, e. g., Chen (1976), Lipkewich and Borgman (1969), Zhao and Kim (1992), 

Dowd and Onur (1993). Alford and Whittle (1986) have also reported incorporation of 

variable pit slopes into the algorithm but they give no details. Lipkewich and Borgman 

(1969) proposed a `knight's move' pattern` to approximate a conical expansion to the 

surface. Zhao and Kim (1992) defined a method based on cone templates. 

Dowd and Onur (1993) used the idea of cone templates to derive a general 

technique to deal with the problem. This method involves the construction of a cone, , or 

extraction volume, from the block on a , given level to the surface by joining rings or 

envelopes of blocks corresponding to the pit slope angles. If the midpoint of any block 

lies within the extraction cone it is assumed that it must be removed before removing the 

base block. The program developed-by Onur (1992) using this technique does not'give 
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the correct solution in all cases. 

It is apparent that all these previous works rely on using one slope angle in the 

design. In practice, it may be necessary to use different slope angles for each direction 

and for each domain sector. In the work presented here the method of Dowd and Onur 

(1993) has been modified to derive a general technique for variable slope angles which 

will be discussed in the following chapter. 

1 2 3 4 

-2 -2 -3 -2 

Figure 2.3- Simple network representing a vertical section 

2.2.3- Network or maximal flow techniques 

The maximum, or network, flow problem is a classical problem in the field of operational 

research. It is possible to formulate the ultimate optimum pit limit problem as an 

equivalent network flow problem. Johnson (1968) was the first to apply this technique to 

the ultimate pit outline problem. To apply this method to the optimum open pit problem, 

a network is constructed with a source and terminal node. A node represents each block. 

21 



Chapter 2: Literature review 

Nodes representing ore blocks are connected by arcs to the source node and all nodes 

representing waste blocks are connected to the terminal node. In addition; each ore block 

node is connected to any overlying waste block nodes in such a way that the arcs 

represent pit slope- constraints. Figure 2.3 shows, an example of a- simple network 

representing a cross-section of an orebody for which the pit slope-is 45° and the blocks 

are squares. The arc capacity from the source node to an ore block node is assigned the 

block value. The are capacity from a waste block node to the terminal node is assigned 

the absolute block value. Infinity capacity is assigned to the arcs connecting ore block 

nodes to overlying waste block nodes. Once the network is created the problem is to find 

the maximum flow through the terminal node. A number of algorithms have been 

developed to solve the maximum flow problem (Ahuja and Orlin, 1989). Johnson and 

Barnes (1988) applied the labeling algorithm developed by Ford and Fulkerson (1956) to 

solve this problem. Yegulalp and Arias (1992) used an excess scaling algorithm that was 

presented by Ahuja and Orlin (1989). 

11 Although this technique has been used with some success to determine optimal 

pits it is apparent from the literature that it has not, been adopted to any great extent 

largely ' because it has the same perceived disadvantages as the Lerchs-Grossmann 

algorithm. 

2.2.4- Floating or moving cone method 

The floating, or moving, cone approach is the simplest method for determining the 

optimal pit outline and it is perhaps the most popular and widely used of heuristic 

algorithms. This method, which is the most common alternative to the Lerchs- 

Grossmann algorithm, works on a, revenue block model of the deposit and was first 

described by Carlson, Erickson, O'Brain and Pana (1966). The floating, or moving, cone 

method involves, for-each positive (ore) block, constructing a cone, with sides oriented 
parallel to the pit slope angles, and then determining the value of the_ cone by summing 
the values of blocks enclosed within it. If the value of the cone is 'positive, '' all blocks 
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within the cone are mined. This process starts from the uppermost level and moves 

downward searching for positive blocks. The process continues until no positive cones 

remain in the block model. A flow-chart of the algorithm for this method is shown in 

Figure 2.4. The method is very simple, is easy to program and reaches a solution in a 

shorter time than any other method and is an order of magnitude faster than the Lerchs- 

Grossmann algorithm. These methods do not, however, always yield a true optimum. 

This method can best be explained by a simple example applied to a vertical 

section as shown in Figure 2.5. For the sake of simplicity slope angles are assumed to be 

45° and the blocks are squares. There are five positive blocks in this section and there 

are, therefore, five cones. The optimal pit outline on this section can be determined from 

the following steps: 

1- The procedure starts from the first level. There is only one ore block on this 

level, block (1,6). As there are no overlying blocks and the value of this cone 

is +1, it is removed (Figure 2.6a). ' 

2- There are two ore blocks on the second level, blocks (2,2) and (2,5). The 

extraction cone of block (2,2) comprises blocks (1,1), (1,2) and (1,3) and its 

value is: 

-1-1-1+2 = -1 
As the value is negative, this cone is not removed. 

3- The value of the cone corresponding to block (2,5) is: 

-1-1+3 = +1 

The cone is positive and all blocks within it are mined (Figure 2.6b). 

4- There are two ore blocks on the third level, blocks (3,3) and (3,5). The value 

of the cone corresponding to block (3,3) is: 

-1-1-1+2-2-2+7 = +2 

Thus the cone is, positive and all. blocks within it are mined (Figure 2.6c). 
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Sýý 

Take first level 

Talre first ore block 

Construct cone 

Is cone positive? 

Yes 

Include this cone as part of pit 

Yes 
All ore blocks in this level? 

Take next ore block 

All level? 

Take next level 

Output the pit limit 

End 

Figure 2.4- Flow chart of the floating cone method 
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567 

-1 -1 -1 -1 -1 +1 -1 

-2 +2 -2 -2 +3 -2 -2 

-3 -3 +7 -3 +1 -3 -3 

Figure 2.5- Block values on a vertical section 

5- Finally, the value of the cone corresponding to block (3,5) is negative, and 
thus it is not mined. 

Hence, the total value of this pit is +4 and the overall stripping ratio is 7/4 

(Figure 2.6d). 

The use of the floating cone method for three-dimensional cases is the same as the 

for the two-dimensional case presented above, except that a true three-dimensional cone 

must be constructed from ore blocks to the surface with the side angles corresponding to 

the pit slope angles. 

An example demonstrating a case in which the floating cone method does not 

yield a true optimum pit is shown in Figure 2.7a 

The cone for the block in row 3, and column 4 has a value of 

V= -1-1-1-1-1-2-2-2+8 = -3 

As the value of the cone is negative (Figure 2.7b), the cone is not mined. Similarly, the 

cone for the block in row 3 and column 5, has, a value of (Figure 2.7c): 

V= -1-1-1-1-1-2-2-2+9 = 
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Figure 2.6- Floating cone method applied to a vertical section 
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Again this cone is not be mined. Using this method, therefore, no blocks would be 

mined. However, if two blocks are considered together, as shown in Figure 2.7d, the 

removal cone for these blocks have value of 

V= -1-1-1-1-1-1-2-2-2-2+8+9 =+3 

and the removal cone for the combined blocks is positive indicating that they can be 

mined profitably. In a similar way, it would be necessary to consider all combinations of 

any number of blocks. This situation often occurs in real deposits and the floating cone 

method is incapable of yielding the true optimum condition. 

Another, problem with this method is that it produces different results depending 

upon the direction of search for the ore blocks. For example, consider the simple 

example shown in Figure 2.8. If the search is carried out top down from left to right, this 

method will yield a pit of value +3 (Figure 2.8b, 2.8c and 2.8d). However, if the search 

for the ore blocks were carried out top down from right to left, a pit of value +5 would 

be obtained (Figure 2.8e, 2.8f and 2.8g). This method may, therefore, produce a different 

ultimate pit limit for the same deposit depending on the selected starting point. 

Lemieux (1979) proposed a number of techniques to overcome these problems, 
but the various forms of the floating cone method remain heuristic due to the lack of any 

mathematical proof. In spite of these problems, the method is the most widely used 
because of the following advantages: 

1- The method is straightforward, easy to understand and mining engineers feel 

comfortable with it. 

2- It is easy to use different pit slopes in'differ'ent parts of the orebody. 

3- Writing a computer program based on this algorithm is easy. 

4- The method requires significantly less computing time than any other method 

to reach a solution. 
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2.2.5- The Korobov algorithm 

This approach is a cone-based algorithm originally developed by Korobov (1974) and 

was reported by David, Dowd and Korobov (1974), and Dowd and Onur (1992 and 

1993). The first step of the algorithm is to construct, for every ore block in the revenue 
block model, an extraction cone with sides parallel to the pit slope angles. The. second 

step is to allocate. positive values within each extraction cone against negative values 

within the cone until no negative block remains or until the total value of the positive 

blocks have been allocated. If the value of the block on which an extraction cone is 

constructed remains positive after the allocation has been, completed, then this extraction 

cone is included as a member of the optimum solution set. When a non-empty extraction 

cone is added to the solution set, the algorithm starts again from the beginning with the 

original block values restored to the blocks not yet extracted from the, block model. If an 

extraction cone is empty, the positive, block is added to the solution and the algorithm 

continues for the next ore block. This process is repeated until no positive block remains 

in the block model. 

To demonstrate how the Korobov algorithm works, it is applied to the simple 

two-dimensional revenue block value shown in Figure 2.5 in which the pit slope is 45° 

and the blocks are squares. The following procedure is carried out to determine optimum 

pit limits based on this algorithm: 

1- The algorithm starts from the uppermost level. There is only, one positive 
block on this level and this, is removed and included in the solution set 
(Figure 2.9b). 

There are two positive blocks on the second level, blocks (2,2) and (2,5). 

The extraction, cone of block (2,2)' includes blocks (1,1), ý(1,2) and (1,3). A 

value of+1 from block (2,2) is allocated to block (1; 1), leaving block (1,1) 

with a value of zero and block (2,2) with a value of +1.? The remaining +1 

value of block (2,2) is then allocated to block (1,2), leaving both blocks with 

a value of zero. In the same 'way, the extraction cone of block (2,5) comprises 
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blocks (1,4), (1,5) and (1,6) of which' block (1,6) has already been 

removed. The value of block (2,. 5) is allocated against blocks (1,4) and (1, 

5), leaving both blocks with values of zero and block (2,5) with a residual 

value of-+1 (Figure 2.9c). As this block remains positive and its extraction 

cone is non-empty,, it is added to the optimal solution, set which now has a 

value of +2 and the algorithm starts from the beginning with the original block 

values restored to all non-removed blocks (Figure 2.9d). 

3- Two units of the value of block (2,2) are-allocated against blocks (1, I) and 

(1; -2), leaving all three blocks with a value of zero. Now consider block (3,3). 

Its extraction contains only blocks (1,3), (2,3) and (2,4) with negative 

values. One unit is allocated for block (1,3) and four units are allocated 

against blocks (2,3) and (2,4). After the allocation (Figure 2.9e) block (3,3) 

remains positive with a value of +2. This block and all blocks within its 

extraction cone are added to the solution set. The net 'value of this extraction 

cone is +2, and the net pit value becomes +4. As the extraction cone for block 

(3,3) is non-empty, the algorithm starts from the beginning with the original 

block values restored to all non-removed blocks (Figure 2.9f . 
Finally, only one positive block remains, block (3,5). Its extraction cone 

contains blocks (1,7) and (2,6) both with negative values. The value of block 

(3,5) is allocated against block (1,7), leaving both blocks with a value of 

zero. As the extraction cone for this block contains a block with a negative 

value, block (2,6), and the total value of the positive block been allocated, the 

cone cannot be added to the solution set (Figure 2.9g). "This algorithm gives 

the final pit shape shown in, Figure 2.9h with, a value of+4. 

This method is simple and the computing time required is shorter than that of the 

Lerchs-Grossmann method. Although the Korobov algorithm overcomes some weakness 

of the floating cone method, in some circumstances the method does not yield a true 

optimum solution. For example, consider the simple, two-dimensional example shown in 

Figure 2.10a, taken from Dowd and Onur (1993). There are two positive blocks in the 
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revenue block model. The value of the first, positive block, block (3,3), is allocated 

against blocks (1,1), (1,2) and (1,3), leaving all four blocks with a value of zero 
(Figure 2.10b). Now consider the second positive block, block (3,4). The extraction 

cone for this block contains six blocks with negative values, each of which becomes zero 

after the allocation of the value of block (3,4). When allocation has been completed, this 

block remains positive with a value of +1 (Figure 2.1Oc); and therefore this'block and its 

extraction cone are added to the solution set. As the net value of this cone is -1, the net 

value of the pit is also -1 at this stage. As the extraction cone for block (3,4) is non- 

empty, the algorithm starts from the beginning with the original block values restored to 

all non-removed blocks (Figure 2. l Od). 

There are now two blocks with negative values. (-1) within the extraction cone of 
block (3,3), each of which becomes zero when the value is allocated from block (3,3). 

After allocation, this block remains positive with a value of +1 (Figure 2.1 Oe). Thus this 

block and its extraction are added to the solution set which yields a pit with a net value 

of zero (Figure 2.100. This algorithm, therefore yields a pit with a net profit of zero. 

In the above example, blocks that are common to both extraction cones . cause the 

error. Dowd and Onur (1992 and 1993) identified the fault in the Korobov algorithm and 

modified the algorithm to yield a true optimum. They refer to the process of allocating 

positive block values to negative block values as the latter "paying" for the former; a 

negative block is "paid for" when the allocation process increases its value to zero. Their 

correction to the Korobov algorithm is based on the following logic: 

"If two or more cones have blocks in common, then blocks not in 

common must be paid for first; common blocks are only paid for after 

all blocks not in common have been paid for. " 

For example, consider again the'two-dimensional example shown in Figure 2: 10a. 

Blocks (1,2), (1,3), (1,4), (1,5), (2,3), and (2,4) are common to the extraction cones 

of blocks (3,3) and (3,4). Blocks (1,1) and (2,2), belong to the extraction cone of 
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block (3,3) but are not members of the extraction cone of block (3,4). The same is true 

for blocks (1,6) and (2,5) which are members of the extraction cone of block (3,4). 
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Figure 2.11- An example of the corrected Korobov algorithm applied 

to a simple example 

The non-common blocks must be paid for first.. Starting with the extraction cone 

of block (3,3), one unit is allocated to each of blocks (1,1) and (2,2), leaving both 

these blocks with a value of zero and block (3,3) with a residual value of +1. In the 

same way, a total of two units, from block (3,4) are allocated against blocks (1,6) and 

(2,5) leaving both these blocks with a value of zero and block (3,4) with a value of +5 

(Figure 2.11 a). 

When the allocation is completed 
, 
for the non-common blocks, the algorithm 

starts again by paying for the blocks that are common to the extraction cones of both 

blocks. One unit from block (3,3) is allocated to block (1,2), leaving both blocks with a 

value of zero. Five units from block (3,4) are allocated to, (1,3), (1,4), (1,5), (2) 3) and 

(2,, 4), leaving all the blocks with a value of zero (Figure 2.11b).,, 

After allocation, none of the positive blocks, on which the extraction cones are 

constructed, remain positive, so no blocks are added to the optimum solution set. As 

there are no other positive blocks, the algorithm stops and the solution yielded is not to 

mine any blocks. Using the original version of the algorithm, both extraction cones were 
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part of the solution set; in the revised version neither extraction cone belongs to the 

solution set. 

It is apparent that the corrected form of the Korobov algorithm produces good 

results and the method is faster and simpler than the Lerchs-Grossmann algorithm. 

However, due to the lack of any rigorous mathematical proof, the method has not been 

accepted as a general method for the determination of the optimum pit. 

2.2.6- Dynamic programming 

Dynamic programming is a reasonably well used method in the field of operational 

research and can be ° used to find an optimum. for sequential decision problems. The 

problem is divided into small sub-problems (stages) for each of which an optimal solution 

is found. The technique was developed by Bellman (1957) and it has been applied to a 

number of mining problems such as optimal cut-off grades and production rates (Dowd, 

1976 and 1980), optimal open pit design (Lerchs and, Grossmann, 1965, Johnson and 

Sharp, 1971, Koenigsberg, 1982) production scheduling (Onur and Dowd, 1993) and 

grade control in sub-level open stoping (Dowd and Elvan, 1987). 

The first two-dimensional, dynamic programming algorithm for determining the 

optimal pit was presented by Lerchs and Grossmann (1965) in the same paper in which 

they introduced the general graph theory method of pit optimisation. Like the manual 

method, this technique designs the pit on vertical sections and some smoothing will 

normally be required between sections. Although the pit is optimal on each section, the 

ultimate pit resulting from the smoothing is probably not optimal. 

The two-dimensional 'dynamic programming algorithm is simple and easy to 

program. The algorithm can best be expressed in the following steps and by reference to 

vertical section shown in Figure 2.5: 
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Figure 2.12- Dynamic programming method applied to a vertical section 
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Step 1- Add row zero containing profit values of zero and calculate cumulative the 

column value for each block starting from the top and- working down (Figure 

2.12b), that is: 

1 

M, ý =Im, v , k=1 

Where 

mý is the value of the block in row k and column j 

is the cumulative column value for the block in row i and column j 

Step 2- Start from the first column at the left end of the section and work downwards. 

Calculate the overall cumulative value (P,, ) which is the sum of the cumulative 

value of the block (M,, ) and the highest value in: 

a-' the block directly above And to the left 

b- the block on the left 

c- the block directly below and to the left 

Pif =M1j +Max{P-1, j-PP. 1-1, 
P+1. j-1} 

After calculation of P. draw an arrow pointing from the original block to the 

block with the highest value among a), b) and c). This process should be 

repeated for all blocks and the new value P, ý should be replaced with the 

cumulative value M;,, (Figure 2.12c)., 

Step 3- If the maximum value of Pf in the first row is positive the optimum pit is 

obtained by following the arrows from, and to the left of, the block that has the 

maximum value. If all values of P; in the first row are negative then there is no 

positive profitable pit (Figure 2.12d). 
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The two-dimensional dynamic programming algorithm requires additional ei%rt 

to fit and adjust sections together and to smooth out the pit bottom and end sections. 
This smoothing process almost always results in a sub-optimal solution. Johnson and 
Sharp (1971) proposed the simplest extension-of the algorithm to the three-dimensional 

case. -Their method, which is referred to -as' 2'Z -dimensional dynamic programming, is 

based on adjusting the sections row by row so that they fit together and satisfy three- 

dimensional slope constraints. Although their algorithm often gives 'a good, or near 

optimum, result it does not guarantee optimality. In addition, short of checking the result 

against the' output from the Lerchs-Grossmann algorithm, there is no way of knowing 

how close the pit is to the optimum. Koenigsberg (1982) was the first to apply dynamic 

programming to the three-dimensional case using the same principle as Lerchs and 

Grossmann. Wilke 'and Wright (1984) proposed a modified version of the Koenigsberg 

algorithm. -A recently published three-dimensional dynamic programming' method 

(Yamatomi, Mogi, ' Akaike ' and Yamaguchi 1995) yields optimum, or near-optimum 

results. However, due to the difficulties of establishing the true optimum in three 

dimensions, dynamic 'programming has not gained widespread acceptance or use as a 

method of optimal open pit design. 

2.2.7- Parameterisation 

All the methods of optimal pit design described above are based on a revenue block 

model obtained by calculating the net profit value of each block by 'applying'costs, price 

and technical parameters to a block grade model of a deposit. The' algorithm then 

searches among all possible technically feasible pits to find the optimum pit with the 

highest net profit value. It is assumed that the values of the variables, such as grade, 

costs, prices and recovery factor, used to create a revenue block model'are constant. The 

values of these variables are usually estimated and are, therefore subject to error. 

In reality the values of these variables will vary in a stochastic manner over time 

or, in the case of grade, over space. Often small changes in variables such as grade and 
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price have significant effects on the optimum pit. Any realistic pit design should at least 

address the effects of using fixed values of variables that are known to . 
be uncertain 

and/or to vary.. One possible way to deal with the ' uncertainty associated with the 

variables is to conduct sensitivity or risk analyses (see for example Dowd, 1994c and 
1997). In sensitivity analysis the value of a variable is changed systematically, and its 

effect on the result is assessed while the values of other variables are fixed. For the open 

pit problem sensitivity analysis involves changing the value of one variable (say, metal 

price) by a fixed amount, calculating the revenue block model values and then generating 

the optimum, pit. The procedure is repeated by changing the value of the variable again 

and determining the new optimum pit. A typical application might begin by, determining 

the optimum pit for a starting metal price (sometimes called the base value) and then 

varying, the base price, by ±5%, ±10% and ±20% and determining the optimum pit 

corresponding to each of these changed values. -The objective would be to measure the 

corresponding change in each pit - e. g. total profit, tonnage, average r grade, pit shape 

and depth. 

Risk analysis assesses the effects on the result of simultaneous variation in the 

values, of all variables. For the open pit problem risk analysis essentially involves repeated 

simulation of the values of the variables. Each simulation consists of selecting a value of 

each variable, from. a specified . probability, distribution. The pit is then designed on the 

basis of the set of simulated, values. The whole procedure is then repeated a number, of 

times, each time with a newly simulated, set of values., This generates a, set of, pits -; one 
for each set of simulated values - from which risk can quantified. For example, the 

proportion of pits, that did not generate a specified minimum profit would quantify the 

risk, or. probability, that the mining operation would fail to achieve the specified level of 

profits. These methods are described in Dowd (1997). 

Both sensitivity and risk analysis involve multiple generations of optimum pits and 
this can consume enormous amounts of computing time. The cost and time -involved in 

doing this must, of course, beset against the cost of the mining operation and the cost of 
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failure. Even so, it is often critical to be able to generate results very quickly. Quite apart 
from sensitivity and risk analysis it is often necessary to design pits on the basis of 
different assumptions about certain variables (e. g. bench heights, prices via sales 

contracts). It would certainly be' feasible to generate multiple'pits for small block models 
in very short periods of time but this rapidly becomes impossible as the size of the block 

model increases. These observations are especially true of the Lerchs-Grossmann 

algorithm. 

A radically different approach'to this problem is the parameterisation method that 

involves expressing the solution (i. e. the optimum pit) as a function of an input parameter 

(e. g. price). In this approach all optimum pits are generated simultaneously for all 

possible values of the input parameter. This is called single parameterisation. The process 

of generating solutions as functions of two input parameters is called double 

parameterisation and in theory, at least, this could be extended to multiple 

parameterisation. To date, however, only single parameterisation has been completely 

developed. This method which was pioneered by Matheron (1975) has been discussed in 

a number of papers (Francois-Bongarcon and Marechal, 1976, Francois-Bongargon 

and Guibal, 1982, Dagdelen and Francois-Bongarcon, 1982 and Coleou, 1989). 

Parameterisation uses the block grade model rather than a revenue block model 

and the parameterisation is normally done as a function of cut-off grade. The problem is 

divided into two separate, parts: technical and economic. The_ objective of the technical 

part is to find a series of technically optimum pits that maximise the quantity of metal for 

a given total tonnage and selected tonnage without. assuming any values. for the 

economic parameters. The result of the, algorithm is a series of maximum_ metal pits 

nested within one, another, each, corresponding to a cut-off grade determined by the 

specified block grades. These pits can then be analysed by applying economic parameters 

to determine the economically optimum pit. The method is not rigorously optimal in the 

sense used in the discussion of the previous methods. The main criticism levelled against 
it is the simple (some critics say simplistic) manner in which the economic optimisation is 
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handled. It does, however, retain- significant unrealised potential for solving many 

problems including pit optimisation by maximising net present value. ,. 

Whittle (1988) 
. used the concepts of the parameterisation technique and 

introduced a method to deal with the uncertainty, in economic parameters used in -the 
calculation of the economic block model.. He reduced to two the number of variables 

used to create the revenue block model: one major variable (metal cost of mining) and 

one minor variable (ratio between processing and mining cost). Whittle also suggested 

that a number of pit designs can be generated for risk assessment for a range of values of 
the major variable. 

2.2.8- Other methods 

The methods of optimal pit design discussed thus far are the most commonly used. In 

addition to these"a number of other methods have been devised but have found little use. 

Among these is an adaptation of the transportation algorithm (Huttagosol and Cameron, 

1992), which involves the formulation of the ultimate pit problem as a transportation 

model which is then solved by the standard simplex method. Another is the use of 

genetic algorithms (Denby and Schofield, 1994). It is, however, ' apparent from the 

literature that these methods have not been adopted to any great extent 

Genetic algorithms are search procedures based on the mechanics of genetics and 

natural selection. They can be applied ' to complex optimisation problems in which 

optimum' or near optimum solutions are required. The technique has been applied to the 

optimal open pit problem and to the open` pit scheduling problem by Denby and Schofield 

(1994), and-Denby, Schofield and Hunter (1996): The method involves 'the following 

fundamental steps in pit optimisation: 

1- An initial population of pits is generated at random. 
2- For each -pit; a fitness value is calculated by using an objective function, e. g. 

net present value., .. r 
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3- On the basis of their fitness values, pairs of pits are selected for combination 

to produce a new pit. This process is termed reproduction. Pits with higher 

fitness values are most likely to produce a new, better pit during reproduction. ' 

4- Each pit is altered at random to produce a new pit. 

5- The new pits are replaced with the old pits and the procedure is repeated from 

step 2 until the system reaches an optimum. 

The maim advantage of this technique--is that both pit . limit and production 

schedule can be optimised simultaneously and the optimisation -criterion is the 

maximisation, of net present value. However, at present the technique can only handle 

deposits defined by a small number of blocks and are impractical for large deposits. It is 

also heuristic and there is no way of guaranteeing that an acceptable solution could be 

reached. 

2.3- Slope design in open pit mining 

2.3: 1- Introduction 

The ultimate objective of a mining operation whether by underground or surface, mining 

(open pit mining) methods is to extract ore at a profit., The profitability of an operation 

depends on adequate technical and economic planning on the basis of all relevant 

parameters. One of these parameters is the pit slope angle. The determination of pit 

slopes is of vital importance in pit planning as it affects the size and shape of the final pit. 

A steeper slope decreases the stripping ratio and thereby increases the profitability of a 

mine. On the other hand, the pit wall must remain stable and the' use of a steeper slope 

increases the probability of failure. An optimum mine plane should, therefore, have the 

steepest final pit slope that will remain stable throughout the life of the mine. 

An increase or decrease ý in slope angle ' in a medium to large - open pit will 

significantly alter the stripping ratio, Le: the amount of waste that must be removed to' 

mine a unit quantity of ore. A total of 23 million extra tonnes of waste would have to be 
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removed as a result of an average slope being reduced by 5° in an open pit mine with the 

following dimensions and specific gravity: 1900m length from crest to crest, the width of 

the bottom floor 75m from toe to toe, vertical depth 150m and the specific gravity of 

material2.65 (Seegmiller, 1979). 

On the 'other hand, improper design of slopes may place the entire mining activity 
in jeopardy. Disruption of mining operations caused by slope instability can be severe. 

Some consequences are loss of ore, extra cost due to cleaning up of failures, production 

delays, and damage to `equipment and' probability of injuries. Many slope failures have 

been recorded as a result of improper slope design (Seegmiller, 1979). For instance, a 
large-scale failure that happened in Afton mine in 1986 (Reid, and Stewart, 1986). 

In general, pit slopes are designed to be as steep as possible in order to reduce the 

stripping ratio. Singh (1986) showed the importance of pit slope angles on the design 

and economics of open pits and found that the steeper slope not only yields higher net 

present value but also a shorter pay back period. The determination of pit slopes is a 

critical step during the pit planning process. The steeper slope required to minimise the 

stripping ratio must be balanced against the flatter slopes that are needed to ensure 

stability. The slope designer must, thus, reconcile these two conflicting requirements. 

There is also a circular problem involved in the determination of pit slopes, clearly stated 

by Call and Savely (1990): 

"On one hand the slope designer needs the position, orientation and the'' 

height of the pit walls to design the slopes. On the other hand, the mine 

planner needs the slope angles in order to design pit limits. " 

Due to the complexity and unknowns associated with the rock mass, any decision 

in rock engineering requires a considerable amount of experience. It is very important to 

recognise factors affecting slope stability during the design stages. These factors include 

geological conditions, structural features, groundwater conditions;,, shear strength of 
discontinuities, geometry of slopes and the excavation technique ' used in - creating the' 
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slope. Slope stability planning involves the following activities: 

1- Collecting relevant data. 

2- Identification of critical geological features. 

3- Determination of shear strength parameters of discontinuities. 

4- Determination of groundwater conditions and pore pressure acting on critical 
discontinuities. 

5- Identification of potential failure modes. 
6- Analysing potential failure modes by using an appropriate method. 

To design slope angles in open pit mining the first step is to detect a potential 

failure mode and then to use one of the slope stability methods to assess the stability. 

This requires judgment as to whether the slope'-is stable or not together with the 

decisions to be made as a consequence. There are several methods that can be used to 

evaluate stability or instability of a given slope. These are: stereographic projection, limit 

equilibrium methods, probabilistic methods and numerical methods. 

Pit slopes in the optimal pit design algorithm are considered as constraints and 

they are defined in term of blocks which must be removed in order to provide access to a 

particular block in the block model. There is no significant evidence of the incorporation 

of geotechnical information into the design of pit slopes in optimal pit design algorithms. 
The main reason is that they either use a pattern, or a set of blocks, to define the mining 

slopes or they use predefined pit slopes which are assumed to have already been 

designed. In this section a brief review of the available methods of slope design, types of 
failure and shear strength is given. 

2.3.2-Types of failure 

The first step in the -design of the slope in open pit mining, is' to identify the potential 
failure mode. The types of failure that may occur within a slope depend mainly on the 

presence or absence of structural features such as faults, bedding planes and joints. They 
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depend also on their geometrical relationship with the slope face that will determine 

which parts of the rock mass are free to slide or fall. Many authors including Ross- 

Brown (1979), Hoek and Bray (1981), Walton (1988) and Giani (1992) discuss various 

types of failure. Instabilities in open pit mines may be classified using the criterion of 

whether or not they are controlled by well-defined structural discontinuities. They fall 

into two categories: structural instability and non-structural instability. 

The first comprises slopes in which the failure is controlled by geological features 

such as bedding planes, faults and joints. These failures depend on the orientations of the 

discontinuities and their relationship to the orientation of the cut slope. Some of these 

instabilities are: 

Figure 2.13- Planar failure 

Plane failure- Planar instability involves the sliding of a block of rock mass along 

a simple planar surface inclined towards the slope face. This failure is likely to occur 

when a geological discontinuity, such as a bedding plane, has a strike parallel, or nearly 

parallel (within about 20°), to the strike of the slope face, a dip lower than the slope 

angle and intersects the slope face (Figure 2.13). Variations on this type of failure mode 

can occur when a tension crack forms either in the upper surface or in the slope face. 
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Wedge failure- This failure occurs when two planar, or nearly planar, geological 

structures intersect to form a wedge of material in such way that the line of intersection 

daylights into the slope face (Figure 2.14). 

Figure 2.14- Wedge failure 

Toppling failure- This type of failure involves rotation of one or more blocks. 

This may occur in slopes having near vertical joints. Toppling failure and rock falls are 

excluded from this study since there is no general way of dealing with these failures. 

The second category comprises slopes in which well-defined discontinuities do 

not exist and the failure surface is free to occur along the line of least resistance through 

the slope. These are failures, which can occur in soil slopes or in rock slopes, when one 

or more of the following conditions exist: 

a- The rock mass is highly fractured throughout or exhibits random jointing. 

b- The rock mass is very weak so that its properties approach those of a soil. 

c- Very high angle slopes exist in closely jointed rock. 

d- A bench or haul road cuts into soil. 

These failures are classed as circular or non-circular failures. 
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Circular failure- This type of failure is common in soil masses where it is 

generally assumed that the cross-sectional form of the failure surface is a circular arc. 
This is usually referred to as a slip circle as illustrated in Figure 2.15. The position of the 

critical slip (i. e. where it is most likely to occur) is determined by analytical methods, 

which are a function of slope geometry, material strength, unit weights, and pore 

pressure. 

Figure 2.15- Circular failure 

Non circular failure- This type of failure occurs under similar circumstances to 

the circular failure. The failure surface, which tends to occur parallel to a set of weakness 

planes, consists of a mixture of curved and linear segments. 

2.3.3- Shear strength 

One of the most important factors in analysing the stability of a rock slope is the shear 

strength. A small change in shear strength causes significant change in the stability of a 

slope. Determination of the shear strength is, therefore, a criticalr part of any stability 

analysis. It is clear that in order to obtain shear strength parameters for engineering 
design some form of testing is necessary. Depending on the nature of the problem being 

investigated; testing may take the form of a very sophisticated laboratory test or a simple 

in situ test. The classical analysis of shear strength involves both cohesion and angle of 
friction and can be stated by the Mohr-Coulomb criterion. This criterion can be 

49 



Chapter 2: Literature review 

expressed by the following equation: 

z=c+cs. Tano 

Where 

z is the shear strength 

c is the cohesion 

0 is the angle of friction 

07 is the normal stress 

Both cohesion and angle of friction can be found from laboratory or field, tests. 

The above equation for shear strength indicates a linear failure criterion as illustrated in 

Figure 2.16. However, it has been recognised that in reality the failure criterion is non- 

linear. A variety of non-linear criteria have been proposed in the past and a summary of 

these can be found in Hoek and Bray (1981). 

T 

Normal stress 

- Figure 2.16- Mohr-Coulomb linear failure criterion- 

It is difficult to measure rock strength by the direct shear test if the failure is likely 

to 'occur through the rock mass and the rock mass is heavily fractured. For this situation 

Hoek and Brown ' (1980) developed a criterion, based on their wide empirical and 

theoretical experience, ' for estimating the rock mass strength. The general criterion is 
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given by the following equation (Hoek, Kaiser, and Bawden, 1995): 

Where 

Q, = Q3 +Cic 
(Mb 

63 
+S 

60 

is the axial effective principal stress 

63 is the confining effective principal stress 

6c is the uniaxial compressive strength of intact rock pieces 

mb is the value of constant m for the rock mass 

s and a are constants that depend on the characteristics of the rock mass 

These authors introduced a procedure for estimating the material constant from a 

rock mass classification system, for example RMR (Rock Mass Rating system). Many of 

the analyses used to calculate the safety factor are based on the Mohr-Coulomb criterion. 
They also presented a method for determining the equivalent values of the Mohr- 

Coulomb criterion, the friction angle (0) and the cohesive strength (c) from the tangent 

to the envelope to the principal stress defined by the Hoek-Brown failure criterion. 

2.3.4- Stereographic projection 

Stereographic projection is a powerful graphical method used to present'and analyse the 

three-dimensional orientation of planes and linear geological structures in two 
dimensions. These methods are widely used in rock mechanics and geological studies for 

analysing planar discontinuities such as fractures, faults, joints and bedding planes that 

occur at various orientations within rock masses. Two types of stereographic projection 

are in common use: equal angle and equal area. Although there are some differences 

between these two methods; the representation of features within both methods is the 

same. The principle of the techniques and their use in structural geology and geotechnical 

studies have been described in more detail by Phillips (1971), Priest (1985), Goodman 

(1980) and Hoek and Bray (1981). 

, ýa 
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a. Circular. fai urT in overburden 
soil, waste rock or heavily 
fractured rock with no identifiable 
structural pattern. 

b. Plane failure in rock with highly 
ordered structure such as slate. 

c. Wedge failure on two intersectinc. 
discontinuities- 

Great circle representing 
plane corresponding to 
centre of pole concentration 

N 

crest of scope 

Great circle representing / 
slope face 

Direction of sliding 

Great circles representing 
planes corresponding to 
centres of pole concentrations 

Great circle representing 
d. Toppling failure in hand rock which planes corresponding to centre 

can form columnar structure of pole concentration. 
separated by steeply dipping 
discontinuities. 

Figure 2.17-, Stereographic projection of geological features and corresponding 
likely mode of failure (After, Hoek and Bray, 1981) 

Stereographic projection is a useful method to use in the early stages of slope 

I 
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design to identify likely modes of failure and critical areas that : require more rigorous 

analysis. As an example consider Figure 2.17 which shows the data from four 

discontinuity sets together _ with , the mean plane. of the slope face on an. equal area 

projection with the corresponding likely mode of failure on the left. These techniques 

ignore several important parameters such as the effect of ground water, slope height and 

cohesion, all of which are closely related to the stability of a slope. 

Stereographic projection is also a useful method for carrying out kinematic 

analyses. These analyses refer to the motion of bodies without taking into account the 

forces causing them to move. They are used either to assess the stability of a given slope 

when its orientation is known (Hoek and Bray, 1981), or to determine the steepest safe 

angle (Goodman 1980). 

2.3.5- Limit equilibrium 

Limit equilibrium is the most common method for evaluating slope stability. The method 

is based on the calculation of a factor of safety defined as the ratio of total forces tending 

to resist failure, to the total forces tending to cause instability. For a given failure mode, 

a factor of safety in excess of 1indicates that the slope is unlikely to fail. By contrast, a 

factor of safety less than 1 indicates that failure is likely to occur. Hoek and Bray (1981) 

pointed, out, that a factor of safety' of 1.3, is the minimum acceptable value for a 

temporary slope =in open pit mines, 
_ while for a permanent slope, such as those carrying 

the haul road, a factor of safety value should exceed 1.5. Walton (1991) divided limit 

equilibrium methods into two groups: 

Those that consider the material above the slip surface. -These methods of 

analysis, developed in rock engineering, calculate a factor of safety for 

structural instability such as plane and wedge failures. 

Those that divide the sliding mass into a number of vertical slices. These 

methods, developed in soil mechanics, are known collectively as the method 
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of slices, and can be used to analyse non-structural instability such as circular 

and non-circular failures. 

or 

ý 
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Total weight of slice 
Total normal force on the base of slice 
The shear force on the base of slice 
Total normal forces on the side of slice 
The shear forces on the side of slice 

l 

Figure 2.18- Circular failure and forces on a typical slice 

In the first method, the slope is usually considered in two dimensions on a cross- 

section of unit thickness. The forces acting on the sliding mass are found and resolved to 

obtain the factor of safety. Several reference books, "Rock Slope Engineering" (Hoek 

and Bray, 1981) and "Pit Slope Manual" (Major, Kim, and Ross-Brown, 1977), provide 

reviews and detailed descriptions of the various analytical techniques used to calculate 

the factor of safety. A variety of design charts are also given by Hoek and Bray to make 

a rapid assessment of the stability of a slope. 

In the second method, the slope is considered on a cross-section of unit thickness 

and the mass above the failure surface is divided by vertical planes into a series of slices 

Center of rotation 
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as shown in Figure 2.18. The factor of safety is determined as the ratio of the available 

shear strength to the shear strength required for stability. 

There are a number of different methods that have been developed over the years 
in soil mechanics using the method of slices. Nash (1987) gives, a comparative review of 

these= methods. The, most common methods of slices, are, those developed by, Fellenius 

(1936), known as, the Ordinary or Swedish 
, method, Bishop (1955), Janbu (1973), 

Morgenstern and Price (1965), Spencer (1967) and Sarma (1973). The first two methods 

of analysis, Ordinary or Swedish method and Bishop's simplified, method are used for 

circular failure and, the others. are used to analyse non-circular failures. 
, 
The, general 

problem with these methods is that there are more unknowns than equations. For a slope 

divided into n slices there are, in general, 5n-2 unknowns while there are only 3n 

equations for the static variables, The problem, therefore, is statically indeterminate and 

in order to obtain a solution assumptions must be made regarding the interslice forces E 

and X (Figure 2.18). 

Different methods of analysis make different assumptions about the position and 
inclination of the interslice forces. Since all methods of analysis involve assumptions, 

none will yield the correct value for the factor of safety. Apart from the Ordinary or 

Swedish method, which ignores the interslice forces and assumes that for each slice the 

resultant of the interslice forces is zero, most of the methods yield an acceptable result. 

Bishop's simplified method 'is the most widely used and accepted procedure in the 

analysis of circular failure. In this method, it is assumed that the side forces are 

horizontal and the forces are resolved vertically to determine the stress acting on the'base 

of each slice. A number of trial and error attempts are required to determine the least 

factor of safety and a computer is therefore necessary to obtain a solution. 

2.3.6- Probabilistic methods 

In the conventional deterministic methods, the values of variables such as rock or joint 

properties, density, groundwater condition and orientation of discontinuities are assumed 
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to be unique and fixed. These parameters are estimated either from field sampling and 
laboratory results , or from in situ tests. There are, significant uncertainties in the 

estimation and measurement of the values of these variables. These uncertainties arise 

from natural, variability and/or lack of data used to estimate or to measure the input 

parameters. - The uncertainties associated with the input variables used in deterministic 

methods may have a significant effect on the stability of a slope. Probabilistic approaches 

have been developed to assess the effects of the uncertainties on the stability of 

excavated slopes, see, for example, Major, Kim, and Ross-Brown (1977), Priest and 

Brown (1983) and Pine (1992). The advantage of these methods over conventional 

deterministic methods is that they examine the complete range of relevant parameters 

rather than unique values. 

The classical approach of safety measurement in engineering design involves the 

determination of the factor of safety, F, which is defined as the ratio between capacity, 

C, or the resisting force, and the demand, D, or disturbing forces, (F _ C/D ). In the 

deterministic method the mean value of C and D are used to calculate the mean value of 

the factor of safety; failure is assumed to occur, when F is less than 1. An alternative to 

the factor of safety is the safety margin, SM, which is defined as capacity minus demand 

(SM =C- D) and failure is indicated when SM is less than zero. 

In general, both capacity and demand result from many uncertain variables. They 

are, therefore, random variables, and hence their ratio (factor of safety) and their 

difference (safety margin) are themselves random variables and the probability of failure 

can then be described either: 

" by the probability of the factor of safety, F, being less than one [p(F < 1)] as 

illustrated in Figure 2.19 (shaded area), on the assumption that the factor of 

safety follows a normal distribution. 

or 

" by the probability of the safety margin, SM, being less than zero 

56 



Chapter 2: Literature review 

[p(SM < 0)] on the assumption that the safety margin follows a normal 

distribution. This is the shaded area shown in Figure 2.20 

The complement of the probability of failure is called the reliability, R, which is 

defined as the probability of success. Hence: R =1- p 
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Figure 2.19- Factor of safety probability distribution 
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Due to the inherent -uncertainties associated with the input variables, it is 

necessary to incorporate the use of probability in the design of slopes. To determine the 

probability of failure, it is first necessary to define the probability distribution of the input 

parameters, and then to choose an appropriate method of probabilistic analysis. 

There are several methods for conducting probabilistic analyses of slope stability 

problems, including: 

" First order, second moment method 

" General point estimate method, 

" Latin hypercube sampling technique 

" Monte Carlo simulation ', 

Harr (1987) has described all these methods, except the Latin hypercube sampling 

technique. 

The first order, second moment method is based on truncating the Taylor series 
expansion of the output which must be expressed as a function of input variables. Both 

output and input variables are characterised by their mean and standard deviation. The 

advantage of the method is that only the mean and standard deviation of input variables 

are required. On the other hand it gives the output as mean and standard deviation rather 

than a complete description of the probability distribution (unless of course a normal 
distribution is assumed). The method also requires the evaluation of derivatives that may 

range from being simple to cumbersome or impossible. 

The general point estimate method was developed by Rosenblueth (1981) and 

was described in detail by Harr (1987). Pine (1992) applied this method to the analysis of 

slope stability 'and other mining problems. The general point estimate method ' involves 

the use of only two sample values at one standard deviation ön either side of the mean 

for each input variable. The factor of safety or safety margin is calculated for every 
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possible combination of these two selected values. There are 2" combinations where n is 

the number of input variables. Hence the output comprises 2" factors of safety or safety 

margins from which the mean and standard deviation can be calculated. Although the 

method is very simple, it does not provide a full distribution of the output variable. 

The Latin hypercube sampling technique is a relatively recent development in 

mathematics and numerical analysis. It is based on 'a form of stratified sampling that gives 

comparable results to those of Monte Carlo simulation, but with fewer samples. The 

method was developed by Startzman and Watterbarger (1985) and an example of its use 

in both surface and underground excavation was given by Pine (1992). 

Monte Carlo simulation is a completely general technique which can be used for 

any input and output distribution. The technique uses random or pseudo-random 

numbers to sample from the distribution. It has been applied to, a wide variety of 

problems including slope stability analysis (Major, Kim, and Ross-Brown, 1977 and 

Priest and Brown, 1983) and mining finance (Dowd and Xu 1995, Dowd 1997). The 

Monte Carlo method for probabilistic risk analysis for slopes, as illustrated in Figure 

2.21, is implemented via the following steps: 

Step 1- Define a probability distribution function for the input variables from the 

histogram of experimental data. 

Step 2- Select a value at random from the probability distribution of each input variable 

by using a random number sampling technique. 

Step 3- Use the selected values as input parameters and determine the safety factor or 

safety margin. 

Step 4- Repeat steps 2 and 3 until a stable histogram of the factor of safety or safety 

margin is obtained. This histogram is interpreted as the estimated probability 

distribution of the factor of safety or safety margin., 
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Figure 2.21- Flow chart of Monte Carlo simulation 
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Step 5- Calculate the probability of failure, mean and standard deviation from the 

estimated probability distribution of the factor of safety or the safety margin. 

A large number of iterations should be performed in the Monte Carlo approach 

and a computer is, therefore, essential. 

Category, Consequence of Examples Acceptable criteria 
Failure = Maximum values (%) Minimum value 

p(F<1.0) p(F<1.5) - Mean F 

1 Not serious Non-critical 10 20 1.3 

benches 10, 80/75. 1.3 

2 Moderately serious Semi-permanent 1.0 10 1.6 

slopes 2.0 36/39 1.6 

3 Very serious High/permanent 0.3 5.0 2.0 

slopes 0.3 8/12 2.0 

Table 2.1- Acceptable criteria to define the level of risk as proposed 
by Priest and Brown and modified by Pine 

When risk analysis or probabilistic approaches are applied to the design of slope 

angles, the acceptable risk of failure must be considered in the design. Priest and Brown 

(1983) suggested some criteria for this based on their experience and that of others. The 

modified versions of these criteria given by Pine (1992), are shown in Table 2.1. The 

values in this Table should only be-used as guides. The first value in each category is 

based on the original criteria and the second value shown in bold is based on the 

modified criteria. For the modified criteria there are two values for p(F<1.5) 

corresponding to the normal and the lognormal distributions, respectively, of the factor 

of safety. 

There is no doubt that probabilistic approaches have advantages over the 

deterministic methods since they consider the complete range of input variables rather 
than a unique value. However these methods have not been accepted to any great extent 
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largely due to the difficulty of determining the appropriate probability distribution for the 
input variables and the mathematics involved. 

2.3.7- Numerical methods 

Where the geology is complex and potential failure modes may involve a combination of 

several mechanisms, the analysis of rock slope stability is more complicated 'and perhaps 
impossible by limit equilibrium methods. Examples of this complexity include cases in 

which failure involves sliding along discontinuities, rotation of blocks (toppling) and 
failure through intact rock. In these cases numerical methods may provide a useful tool, 

particularly to study rock mass behaviour or to investigate progressive failure. With high- 

speed computers these methods are capable of effective analysis of complex geometrical 

problems. 

Numerical methods have been used to study 'stress-strain behaviour ' of rock 

masses ' to determine the stability of both underground excavations and slopes, cf. 
Cöggan and Pine (1996) Hencher, Liao and Monaghan (1996). There are several 
different types of numerical methods that have been coded into computer programs. Two 

of the most widely used programs in rock mechanics are FLAC and UDEC (Universal 

Distinct-Element Code). The first code is a continuum program in which the rock mass is 

considered as'a continuous material. The distinct-element method (UDEC) is perhaps the 
most widely used of the discontinuum methods for the modelling of rock masses. Cundall 

(1971) originally described this method. In this method the rock mass iss treated as a 

collection of individual blocks and the method is capable of dealing with complex 

masses. 

Numerical methods have not been used in this work, as they are more suitable for 

studying the stability, of complex slopes using information that is only. be available once 

production starts. 
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CHAPTER 3 

The Lerchs-Grossmann algorithm with 

variable slope angles 

3.1- Introduction 

The development of an open pit mine involves the-determination. of the size and final 

shape of the pit. Determination of. this ultimate pit limit is one of the most important 

design requirements in open pit mining. Different methods may be employed . to do this 

but all, implicitly or explicitly, use some form of optimising criterion. The most widely 

accepted criteria are the maximisation of total profit and the maximisation of net present 

value. Although the latter is the better measure of profitability-, there is an inherent 

difficulty in using it for optimal open pit design. The net present value of a block can not 
be determined until it is known when the block is to be mined. The time at which the 

block is to be mined, however, cannot be known until the optimal pit is determined. This 

circularity prevents, the use of standard approaches to optimal pit design when 

maximisation of net present present value is the criterion. and for, this 
- reason maximisation of 

total profit is the most widely used criterion. 

Many algorithms for optimal open pit design have been developed over the past 
30 years. Of these only the Lerchs-Grossmann algorithm, (1965) - can be shown 

mathematically always to yield the pit that generates the maximum total profit. The 

original algorithm, which uses graph theory, was based on a single, fixed slope angle and 
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many attempts have been made to incorporate variable slope angles. In this chapter a 

general method is introduced to accommodate variable slope angles. First, relevant 

aspects of graph theory are outlined and details of the original algorithm are given.. Then 

the general method for dealing with variable slope angles is discussed. This chapter also 
introduces programming techniques to overcome memory limitations so that the 

algorithm can be implemented on PC computers. There is also an account of the 

calculation of the revenue block model as the input for the optimal pit design algorithm 

together with a method of smoothing the pit bottom layout. 

3.2- Graph theory 

Graph and directed-graph methods are used as models in many fields of . 
study such as 

electrical and civil engineering, communication networks, industrial management, 

operational research and computer science. In their simplest form they comprise a 
diagram consisting of a set of nodes and connecting lines used to indicate the 

relationships between the nodes. The following definitions of terms and concepts are 

required for the application of graph theory to the optimal open pit problem: 

A graph G= (X, E) consists of a set of elements called vertices or nodes, X, and 

a set of connecting lines, E, called edges such that each edge connects two vertices. 

A directed graph is a graph in which the edges have directions. Directed edges 

are called arcs. The directed graph represented by G° (X, A) where X is the set of 

vertices and A is the set of arcs. As an example, the directed graph illustrated in Figure 

3.1 may be described by the following sets: 

Vertices: {xl, x2, X3i Xg, X52 X6 } 

Arcs: {( x2, xl), (x2, x3), (x3) xa), (X4, xs), (xs, x6), (x6, xa) ), (4 X3) } 

In a directed graph, each arc is used to connect two vertices. For an arc, 
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a; = (x, y), the vertex x is called its initial point and the vertex y its terminal point. The 

vertex y is said to be the successor of vertex x if there exists an arc between them which 

is pointed towards the vertex y. The set of all successors of x is denoted by rx. For 

example, in Figure 3.1 vertices xl and x3 are the successors of vertex x2 and 

rx2 = {x,, x3}. 

Figure 3.1- An example of a directed graph 

A sequence of arcs is called a path such that the terminal vertex of each are 

corresponds to the initial vertex of the succeeding arc. The arcs a2, a3, a4 and a5 in Figure 

3.1 constitute a path. 

A circuit is a closed path. In other words it is a path in which the initial vertex 

coincides with the terminal vertex. For example, the arcs a4, a5 and a6 in Figure 3.1 

constitute a circuit. Note that the arcs a3, a6 and a7 do not constitute a circuit. 

A chain is a sequence of edges in which each edge has a common vertex with an 

adjacent edge and no vertex in common with more than two edges. 

A cycle is a chain in which the first and the last edge having a common vertex. 

The edges (x3, x4), (x4, x6) and (x6, x3) in Figure 3.1 constitute a cycle. 
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A directed subgraph G(Y) is a subset of a directed graph G(X, A). It comprises 

a set of vertices of Y belonging to X together with the arcs that connect the vertices of 

G(Y). 

A closure of a directed graph G(X, A) is a subgraph G(Y) such that if xEY then 

Fx E Y. Closure from the view-point of pit design is a subgraph of a directed graph, 

representing the block model of a deposit, which indicates a feasible pit. For example, in 

the directed graph illustrated in Figure 3.2, representing a simple two-dimensional block 

model, the vertices 4,5,6 and 12 form a closure. 

Figure 3.2- A two-dimensional directed graph 

In this graph, each vertex is assigned the value of the block that it represents. 

This value is called a mass. The value of a closure is the sum of the masses of all vertices 

that comprise the closure. Each vertex is also assigned an identification or sequence 

number which indicates its location within the block model. The vertices are connected 

by arcs that define access or mining constraints; in the simple example shown in Figure 
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3.2 it is assumed that the blocks are squares and the pit slopes are 45° in all directions. 

For example, to mine vertex 12 requires the prior removal of vertices 4,5 and 6 and 

these four vertices define a possible pit (closure). This closure has a cumulative value of 

+2 that is obtained by summing the values of the vertices within it. 

The closure G(Y), of the directed graph G(X, A), with the maximum value is 

called a maximum closure of G(X, A) and represents the optimum pit limit. 

A tree is a connected and directed graph that contains no cycles. It is represented 

as T= (X, A). For example in Figure 3.1 X= {x1, x2, x3}, A= {a,, a2) is a tree. 

Figure 3.3- An example of a rooted tree 

A rooted tree is a tree that contains one unique vertex called a root. Any vertex 

can be designated as a root for any specified purpose. Figure 3.3 shows an example of a 

67 



Chapter 3: The Lerchs-Grossmann algorithm 

rooted tree which contains a vertex xo as its root. 

If a rooted tree T is separated into two parts by the elimination of one arc a;, the 

part of tree which does not contain the root is called a branch, denoted by Ti = (X;, A). 

The root of the branch is the vertex of the branch adjacent to the arc a;. For example, if 

the arc (xl, x6) is eliminated from the rooted tree illustrated in Figure 3.3, then the branch 

shown in Figure 3.4 is obtained. The root of this branch is vertex x6. 

Branch 

ý .................................................................................... 
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Figure 3.4- Rooted tree and branch obtained by the elimination of arc (x1, x6) 

Each arc a; of a tree T defines a branch, denoted by Ti = (Xi, A). If numerical 

values are assigned to the vertices, mass M; of branch Ti can be obtained by summing the 

masses of all of vertices of Ti, The arc a; is said to support the tree Ti and the mass M;. 

68 



Chapter 3: The Lerchs-Grossmann algorithm 

For example, the mass of the branch obtained by the elimination of the arc (xi, x6) in 

Figure 3.5 is +3+5-2-1-1-1 = +3. 

Figure 3.5- A rooted tree in which numerical values are assigned to the vertices 

In a rooted tree any arc or branch can be characterised by its orientation with 

respect to the root. If an arc a; points toward the branch, it is called a p-edge (plus-edge) 

- in other words a p-edge is one for which the terminal vertex of its associated arc, a;, is 

part of the branch Ti. T, is then called a p-branch. As an example, consider the arc 
(x1, x6) in Figure 3.3. If this arc is eliminated the branch shown in Figure 3.4 is obtained. 

The terminal vertex of the arc (xi, x6) is part of the branch. Therefore this arc is a p-edge 

and the branch obtained by the elimination of this arc is a p-branch. 

If an arc a; points away from the branch, then a; is called an m-edge (minus-edge) 
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and T; is an m-branch. For example, consider the arc (x3, x2) in Figure 3.5. If this arc is 

eliminated the branch shown in Figure 3.6 is obtained. The terminal vertex of the arc 

(x3, x2) is not part of the branch. Therefore this arc is an m-edge and the branch obtained 

by the elimination of this arc is an m-branch. 

Figure 3.6- Branch obtained by the elimination of arc (x3, x2) in Figure 3.5 

Any arc or branch can also be classified as strong or weak. A p-edge or p-branch 

is strong if it supports a mass that is strictly positive. An m-edge or m-branch is strong if 

it supports a mass that is negative or null. Arcs or branches that are not strong are said to 

be weak. This is summarised in Table 3.1. 

The branch obtained by the elimination of arc (xi, x6) in Figure 3.5, is a p-branch 

and it supports a mass of +3. Therefore both branch and arc (xi, x6) are strong. 

The branch shown in Figure 3.6, is an m-branch and it supports a mass of -3. 
Thus both branch and arc (x3, x2) are strong. 

The result of classifying the arcs of the tree in Figure 3.5 as strong or weak is 
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illustrated in Figure 3.7. 

Case Direction Support Label 

1 Plus Positive Strong 

2 Plus Null or negative Weak 

3 Minus Positive Weak 

4 Minus Null or negative Strong 

Table 3.1- Labelling guide for arcs and branches 

Figure 3.7- Arcs are classified as strong (S) or weak (W) 

A vertex x; is labelled strong if there exists at least one strong edge on the chain 

of T joining it to the root xo. Vertices that are not strong are labelled as weak. For 
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example, in Figure 3.7 vertex x6 is a strong vertex and vertex x2 is a weak vertex. 

A tree is normalised if the root is common to all strong edges. Any tree T of a 

graph G can be normalised by changing it such that all strong edges have the root as one 

of the vertices. This is achieved by selecting a strong arc (xi, xj) not connected to the 

root, and replacing it with a new arc from the root xa to either vertex x; if the arc (xi, x; ) 

is a p-edge or to the vertex x; if the arc (x;, x; ) is an m-edge. 

Figure 3.8- The result of normalisation of the tree in Figure 3.7 

For example, the tree shown in Figure 3.7 is not normalised because the strong 

arcs (x1, x6) and (x3, x2) do not have the root as one of their vertices. To normalise the 

tree these two arcs must be changed. The arc (x,, x6) of the strong p-edge is replaced by 

the dummy arc (xo, x6) and the arc (x3, x2) of the strong m-edge is replaced by the 
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dummy are (xo, x3) to give the normalised tree shown in Figure 3.8: 

In graph theory terms the optimal pit problem becomes that of finding a maximal 

closure, Y, of the directed graph G= (X, A) representing the orebody block model in 

which vertex x; is assigned a mass m; equal to the corresponding block value. In other 

words, the problem is to find a set of vertices Y belonging to X such that if x; EY then 

T'x eY and Im, is maximum. " The optimum pit (maximum closure Y -of a graph) 
xicY 

comprises all vertices in the branches of a normalised tree connected to the root by a 

strong edge provided that this normalised tree satisfies all pit slope constraints. The 

mathematical proof of this conclusion is due to Lerchs and Grossmann (1965). 

3.3- The Lerchs-Grossmann algorithm 

The Lerchs-Grossmann algorithm (1965) takes the orebody revenue block model as the 

input and determines which blocks should be mined to obtain maximum net profit. The 

algorithm involves the construction of a normalised tree for each successive level of the 

pit. It 
, starts with the construction of a normalised tree- To in, a directed graph G 

representing the, revenue block model of the deposit. This tree is then iteratively 

transformed into successive trees T1, T2, 
.. -., T,,, until no, further, transformation is 

possible. Iteration i+1 transforms a normalised tree T; into a new normalised tree T; +1. 
Each tree T; = (X, A; ) is characterised by its set of arcs AI and its set of strong vertices 

Y. The maximum closure Y is found by summing the vertices of the branches connected 

to the root by strong edges. The algorithm formulated by Lerchs and Grossmann (1965) 

11 and described by Lipkewich and Borgman (1969) may be summarised in the following 

steps: 

Step 1 Consider level i. Add arcs from the root, vertex xo, to all vertices on level i. 

Step 2 Classify arcs as weak or strong. 
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Step 3 Check for negative mass (i. e. the sum of all blocks connected beyond the 

terminal point of an arc) overlying a' strong vertex. If none go to step 5. If a 

weak vertex j : overlies a strong vertex k add the arc (k, j) to the, tree Ti. 

Replace the arc (xo, Ti ), i. e. the are connecting the tree T; to the root 
(vertex xo) by the arc (xo, j). 

Step 4 If the tree T; contains any strong arcs not connected to the root, vertex xo, 

normalise the tree. Go to step 3. 

Step 5 Remove all strong vertices; these form part of the maximum closure. Go to 

the next level i+1 and start again from step 1. 

3.3.1- A two-dimensional example 

The algorithm can best be explained by a simple two-dimensional example illustrated in 

Figure 3.9. There are two numbers in each block: the upper is the block number and the 

lower is the value of the block. For the sake of simplicity 'slope angles are assumed to be 

45° and the blocks are squares. The corresponding directed graph representing this 

example is shown in Figure 3.2 in which each block has ' three successors (three arcs 

pointing away., from the block). The successor vertices must be removed before a 

particular block is mined. 

1 2 3 4 5 6 7 

-1 -1 +1 +1 -1 1 

8 9 10 11 12 13 14 

-2 +2 +1 -2 +3 -2 -2 

15 16 17 18 19 20 21 

-3 -3 +3 -3 +1 -3 -3 

Figure 3.9- Block revenue value 

74 



Chapter 3: The Lerchs-Grossmann algorithm 

The procedure starts from the first level. The initial tree is constructed by adding 

arcs from the dummy root, vertex xo, to the all the vertices representing the blocks on 

this level (step 1). These arcs are classified as weak (V) or strong (S) as illustrated in 

Figure 3.10 (step 2). 

Figure 3.10- Data for the first level 

In the tree, there is no weak vertex overlying a strong arc or vertex since only the 

first level is involved (step 3). This tree is consolidated by deleting strong vertices 3 and 

4 as shown in Figure 3.11. The blocks on the second level are then added (step 5). 

Figure 3.11 
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Again, arcs are added from the root, vertex x0, to the all vertices on the second 
level (step 1). They are also classified as strong or weak as shown in Figure 3.12 (step 

2). There are three strong vertices and two weak vertices on this level. 

Figure 3.12- Data for the second level 

Now consider step 3 of the algorithm to check for negative masses overlying a 

strong vertex. The weak vertex 1 overlays strong vertex 9 so one arc is added from 

vertex 9 to vertex 1. The arc from the root to vertex 9 is replaced by the arc from the 

root to vertex 1. The result is illustrated in Figure 3.13. 

Now consider the tree which is connected to the root by the arc from vertex xo to 

vertex 1. If this arc is eliminated from the tree, its terminal vertex will be part of the 

branch. So it is a p-edge and it supports a total mass of 2+ (-1) _ +1. Therefore this arc 

is classified as a strong arc. 

The weak vertex 2 overlays the strong vertex 9 so it is connected to vertex 9 by 

adding an arc from vertex 9 to vertex 2. The tree is connected to the root by the arc from 

vertex xa to vertex 1. This arc is removed and replaced by the arc from vertex xo to 

vertex 2 as shown in Figure 3.14. 
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Figure 3.13 

The arc from vertex xo to vertex 2 has its terminal vertex in the tree and is thus a 

p-edge. It supports a total mass of (-1) +2 + (-1) =0 and thus this arc is classified as a 

weak arc (Figure 3.14). 

Figure 3.14 

The weak vertex 2 overlays strong vertex 10. Therefore the arc from vertex 10 to 
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vertex 2 is added to the tree and the arc from xo to vertex 10 is removed and replaced by 

the arc from xo to vertex 2 as shown in Figure 3.15. This arc (from xo to vertex 2) has its 

terminal vertex in the tree and supports a total mass of (-1) +2 + (-1) +1 = +1, thus it is 

classified as a strong arc. 

Figure 3.15 

The weak vertex 5 overlays strong vertex 12. The arc from vertex 12 to vertex 5 

is added to the tree and the arc from xo to vertex 12 is replaced by the arc from xo to 

vertex 5 as shown in Figure 3.16. This arc (from xo to vertex 5) is a p-edge and supports 

a total mass of (-1) +3 = +2, thus it is strong. 

Similarly, weak vertex 6 overlays strong vertex 12. Therefore vertex 6 is 

connected to the tree by drawing an arc from vertex 12 to vertex 6 and the arc from xo to 

vertex 5 is replaced by the arc from xo to the vertex 6 as shown in Figure 3.17. This arc 

(from xo to vertex 6) has its terminal vertex in the tree and supports a total mass of 

(-1) +3 + (-1) = +1, thus it is classified as a strong arc. 

There are now no negative masses overlying strong arcs or vertices so step 3 of 

the algorithm is completed. The tree is normalised since all strong arcs are connected to 
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the root (step 4). There are two strong arcs connected to the root. These strong nodes 

are removed and included as part of the ultimate optimum pit as illustrated in Figure 3.18 

(step 5). 

Figure 3.16 

Figure 3.17 

Finally, the blocks from the third level are added and joined to the root which 
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gives the graph shown in Figure 3.19 (step 1). The arcs from the root to these vertices of 

the third level are classified as indicated in Figure 3.19 (step 2). There are two strong 

arcs and one weak vertex on the third level. 

Figure 3.18 

Figure 3.19- Data for the third level 
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There is a weak vertex (vertex 11) overlaying strong vertex 17. Thus the are from 

vertex 17 to vertex 11 is added to the tree and the arc from xo to vertex 17 is replaced by 

the arc from xa to vertex 11 as shown in Figure 3.20. The arc from xo to vertex 11 is a 

p-edge and supports a total mass of (-2) +3 = +1, hence it is classified as strong. 

Figure 3.20 

The weak vertex 13 overlays strong vertex 19. The arc from vertex 19 to vertex 

13 is added to the tree and the arc from xo to vertex 19 is replaced by the arc from xo to 

vertex 13 to give the graph shown in Figure 3.21. The arc from xo to vertex 13 is a 

p-edge and supports a total mass of (-2) +1 = -1, hence it is classified as weak. 

There is now no negative mass overlying a strong vertex and the tree is 

normalised so step 3 and step 4 of the algorithm are completed. 

There is only one strong arc in the tree - that which joins vertices 11 and 17. 
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These vertices are removed and included in the ultimate optimum pit. The algorithm is 

completed and the optimal pit with a value of +5 is obtained (Figure 3.22). 

Figure 3.21 

Figure 3.22- The optimum pit limit 
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3.4- Mining and access constraints 

For a deposit represented as a grade or revenue block model, pit slopes are specified, in 

terms of blocks which must be removed in order to provide access to each block within 

the block model. In the Lerchs-Grossmann algorithm, these restrictions are imposed by 

directed arcs. They indicate which blocks should be removed before a particular block 

can be mined. For example, consider Figure 3.2 in which each block has three successors 

(the arcs pointing away from the block). The successor blocks (vertices) of any specified 
block (vertex) must be removed-before that block can be mined. Various procedures are 

used to specify mining and access constraints for block models. They may be classified 

into two categories: 

a- Non-cone-based methods 

b- Cone-based methods 

The first category, non-cone-based methods, involves the use of a pattern, or a 

set of blocks, to define mining slopes. For example: 

" 1: 5 block configuration 

1: 9 block configuration 

" 'Combination of both or 1: 5: 9 pattern 

In the original formulation of the Lerchs-Grossmann algorithm, the 1: 5 block 

pattern is used, to specify mining slopes. In this pattern, in order to gain access to one 

block, five over-lying blocks, one-up and one-over, as illustrated in Figure 3.23a, must 

first be removed. This pattern requires the use of five arcs pointing away from each 

vertex (block) to satisfy the mining constraints. If this support is carried up over several 

levels, as indicated by Lipkewich and Borgman (1969), an undesirable wall slope would 

be obtained. For example, consider a 45° slope in a cubic block model as shown in 

Figure 3.24 which illustrates the pit shape for mining a block on the fifth level in row 5 
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and column 5. The numbers indicate the levels from the surface down to and including 

this level that must be mined. As can be seen from Figure 3.24, only on cross-sections 

A-A and B-B is the average slope angle 45°. On cross-sections C-C and D-D the average 

slope angle would approximately 55°. 

a- 1: 5 block pattern in which five overlying blocks 

must be removed to mine one block 

Zz7.1 

b- 1: 9 block pattern in which nine overlying blocks 

must be removed to mine one block 

Figure 3.23- Non-cone-based pattern 
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Al 
1234567 

1 

2 

3 

4 

-f-- 5 

B6 
7 

8 

9 

0 0 0 0 1 0 0 0 0 

0 0 0 1 2 1 0 0 0 

0 0 1 2 3 2 1 0 0 

0 1 2 3 4 3 2 1 0 

1 2 3 4 5 4 3 2 1 

0 1 2 3 4 3 2 1 0 

0 0 1 2 3 2 1 0 0 

0 0 0 1 2 1 0 0 0 

0 0 0 0 1 0 0 0 0 

A- 

a- Plan 

Slope = ArcTan(4a) = 450 

b- Section A -A or B-B 

Slope= ArcTan(2a) = 55° 

c- Section C-C or D-D 

Figure 3.24- 1: 5 block pattern applied to a cubic revenue block model 
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1 

2 

3 

4 

-ý- 5 

g6 
7 

8 

9 

Cv 

Al c 

123456789ý 

1 1 1 1 1 1 1 1 1 

1 2 2 2 2 2 2 2 1 

1 2 3 3 3 3 3 2 1 

1 2 3 4 4 4 3 2 1 

1 2 3 4 5 4 3 2 1 

1 2 3 4 4 4 3 2 1 

1 2 3 3 3 3 3 2 1 

1 2 2 2 2 2 2 2 1 

1 1 1 1 1 1 1 1 1 

AA 

a- Plan 

Slope = ArcTan(4a) = 45° 

b- Section A-A or B-B 

I 

Slope = ArcTan(4 
a) 

= 350, 

-T 
B 

c- Section C-C or D-D 

Figure 3.25-1: 9 block pattern applied to a cubic revenue block model 
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1 

2 

3 

4 

-T- 5 

B6 
7 

9 

o 0 1 1 '1 1 1 0 0 

o 1 1 2 2 2 2 1 0 

1 1 2 3 3 3 2 1 1 

1 2 3 3 4 3 3 2 1 

1 -2 3 4 5 4 3 2 1, 

1 2 3 3- 4, 3 3 2 1 

1 1 2 3 3, 3 2 1 1 

0 1 2 2 1 1 0 

0 

E 

0 

l 

i 1 1 1 0' 0 

AA 

a- Plan 

Slope = ArcTan(4a) = 450 

b- Section A-A or B-B 

= 43° Slope = ArcTan 
3 3 

Ia), ' 

c- Section C-C or D-D 

Figure 3.26- 1: 5: 9 block pattern applied to a cubic revenue block model 
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The second configuration is a 1: 9 block pattern, in which nine overlying blocks 

must be removed to mine one block (Figure 3.23b)., As illustrated in Figure 3.25, this 

approximation to slopes produces a cone with slopes ranging from 35° (cross-sections 

C-C and D-D) to 45° (cross-sections A -A and B-B). 

A 'close approximation to a 45°"slope in the cubic block model is obtained by 

combining a 1: 5 block pattern for the first level above the base block with a 1: 9 pattern 

for the 'second level above the base block (Figure 1.26): An example of the use of this 

pattern in the Lerchs-Grossmann algorithm can be found in the program published' by 

Dowd (1994a). 

One of the main disadvantages of using ' the first category is the difficulty of 

establishing optimum pit outlines with variable slope angles. The slope angles are 

assumed to be defined by the dimensions of the blocks. For example, if a 1: 5: 9 pattern is 

used in the general rectangular revenue block model of an orebody, then for 10m x lOm 

x 5m blocks, the slope angles indifferent cross-sections would be: 

Section A-A or BB: 

Slope = ArcTan 
4 1QJ 

= 26 ° 

-ý Section C-C or DD: 

Slope = ArcTa 
4*5 

25 n(3-F2 
*10) 

Therefore, using this procedure, different slope ' angles would require different 

sizes for the ' blocks in the orebody, bblock ' model and these may not correspond to 

required bench heights. The 'grades of different block sizes estimated from a given 

configuration of data would have different estimation errors thus creating difficulties in 

assessing reliability and confidence levels associated with the final pit values (the optimal 
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pit is commonly used to define minable reserves-with stated levels of confidence). In 

addition, different parts of the, orebody may require different slope angles. It is 

impossible in this method to have different angles for different parts of the mine. 

The second category, cone-based methods,. involves the use of a cone to define 

the mining slope. For example, Lipkewich and Borgman (1969), Zhao and Kim (1992), 

Dowd and Onur (1993) have all used cones to define variable slopes. Lipkewich and 

Borgman (1969) proposed a knights move pattern to approximate a conical expansion to 

the surface. Zhao and Kim (1992) defined a method based on cone templates. Dowd and 

Onur (1993) used the idea of cone., templates to derive a technique, to establish the 

optimum pit with variable slope angles. These works rely on the use of only one slope 

angle in the design whereas a complex deposit may require the use of different slope 

angles for each direction and for different parts of the orebody. The method presented by 

Dowd and Onur (1993) has been adopted in the current work and has been modified to 

derive a general method for variable slope angles. This procedure is incorporated in the 

Lerchs-Grossmann algorithm given later in this chapter. 

3.5- The Lerchs-Grossmann algorithm with variable-slope angles 

One of the main disadvantages of the original Lerchs-Grossmann algorithm'is that it was 

based on a fixed' slope angle. Although solutions were reported to overcome this 

limitation, none of them were adequate for variable slopes controlled by complex 

structures and geology. -When dealing-with a deposit represented as a block model, a 

method must be found to define mining slopes and to take into account variable slope 

angles. The method adopted here is based. on . the cone ' method to approximate the 

conical shape of the pit. The cone is defined with four slope angles in four principal 
directions. It is assumed that the orebody has been divided into regions 'or' domains based 

on geotechnical information. It is further assumed that within each region or domain the 

rock characteristics are the same and can be characterised by a set of slopes. Depending 

on the number of regions; the problem is treated in two different ways: 
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" Variable slope angles in which only one region or domain sector is 

specified to define the pit slopes. 

" Multiple variable slope angles in which more than one region or domain 

sector is specified to define the pit slopes. 

For each region or domain sector, pit slopes are assumed to be defined by four 

principal slope angles in four principal directions which in the current study are termed 

as: 

North face slope or Northing slope: 

East face slope or Easting slope: 

South face slope or Southing slope: 

West face slope or Westing slope: 

Level 

3 

J 

Figure 3.27- Block model of deposit and co-ordinate systems 

Two types of co-ordinate system, as illustrated in Figure 3.27, are used 

Slope face to the North. 

Slope face to the East. 

Slope face to the South. 

Slope face to the West. 
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throughout this study for pit optimisation for orebodies represented by block models. 

The first is the X, Y, Z system in which the X axis runs East-West, the Y axis runs 

South-North and the Z axis vertically. The origin of the system is located in the 

Southwest of the upper most level, the shaded block shown in Figure 3.27. The second 

system, an i, j, k co-ordinate index system, is also used. The i, j, k co-ordinate increases 

along the line of increasing X, Y, Z co-ordinate respectively. In addition, the following 

parameters are used to define the block model for the deposit: 

xdim Dimension of block in x direction (West-East) 

ydim Dimension of block in y direction (South-North) 

zdim Dimension of block in z direction (Elevation) 

numx 

numy 

numz 

Number of blocks in x direction (West-East) 

Number of blocks in y direction (South-North) 

Number of blocks in z direction or number of levels 

Figure 3.28- Constructing a cone from the base block 
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3.5.1- Variable slope angles 

Pit slopes can be approximated by constructing a cone representing an extraction 

volume. This can be done by creating rings, or envelopes, from the mid-point of the base 

block and extending them to the surface (Figure 3.28) in such waythat the side angles of 

the cone are equal to the-four principal slope angles: North face angle, East face angle, 
South face angle and West face angle. 

If the pit wall ' slopes in the four principal directions ' are not the ' same the upper 

area of the cone on each level (intersection of the cone with level), will . consist of four 

quadrants of different ellipses. If the pit wall angles are the same the upper area of the 

cone will be a circle. Figure 3.29 shows the extraction cone and the blocks within it on 

the first level and bn the two cross-sections. On each level the value of two semi-major 

axes and two semi-minor axes depend on the four principal slope angles and the vertical 
distance of the mid-point of the base block from 'the overlying blocks. These parameters 

can be found by using trigonometric functions. The number of blocks in the principal 

directions on any level above the base block can be 'calculated by dividing these 

parameters by _the corresponding block dimensions. Consider a block X;, j, k on level k, 

these parameters and the number of blocks in the principal directions, as illustrated in 

Figure 3.29, can be calculated from the following equations: 

�ý, _. 
(k - t) *z dim 

7j7 

Tan(Westface angle) 

(k-t)*zdim 
Tan(South face angle) 

�1. _ 
(k - t) *z dim 

Tan(East face angle 

(k - t) * zdim 
Tan(North face angle 

(3.1) 

(3.2) 

(3.3) 

(3.4) 
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r N 

f 
A 

B- 
. . . . . . . . 

. . . . . . . 

. . . . dv, . . . 

. . . . . . . 

. 
dx, dx, 

. . 

. . . . dYz . . . 

. . . . . . . 

. . . . . . . . 

. . . . . . . . 

B- 
a- The upper area of the cone on the first level 

dx2 dx, 

East fa e angle West face angle 

b- Northing section A-A 

Figure 3.29- Extraction cone and blocks within it of a base block 

(continued ........ ) 

ý 

A 
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dy, dy2 

So uth face glc North ace ang le 

c- Easting section B-B 

Figure 3.29- (........ continued) 

dx, 
m= 

x dim 
(3.5) 

dy, 

y dim 

C&: 

m7 = 

x dim 

ý, 

ns = 
y dim 

where 

(3.6) 

(3.7) 

(3.8) 

I is the level above the base block and varies from 1 to k-1 

MI is the number of blocks from the base block to the East 

n, is the number of blocks from the base block to the North 

m, is the number of blocks from the base block to the West 

n2 is the number of blocks from the base block to the South 

When the numbers of blocks within the upper area of the cone on any level, say 

the t`h level above the base block, are calculated in the four principal directions, all the 
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blocks X,,,, n, k_L , where m= i-m2, i+m, and n= j-n2, j+n,, must be examined to determine 

whether they are within the extraction volume. This can be done by using the ellipse 

equation as follows: 

t N 
Mid point of block under consideration 

dy, 

K a t 

b 

ý 

Mid point of base block 

dx, 
ý 

Figure 3.30- The value of parameters a and b 

a= x dim* (i -m) (3.9) 

b= y dim* ( j- n) (3.10) 

a2 b2 
If m? i and n >_ j then Value = ýdx)2 + iýY )2 

(3.11) 
, 

a2 If m_iandn_<j then Value 2+()2 
(3.12) 

ß&x, ) 

If m <_ i and nj then Value= 
(a Uý)2 

+iz 
ii2 2 

(3.13) 
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If m <_ i and n >_ j then Value = (a )Z + (Z)2 
(3.14) 

Where a and b are the horizontal distances from the mid-point of the block under 

consideration to the base block measured in the East-West and South-North directions 

respectively, as illustrated in Figure 3.30. If the `Value' is less than or equal to 1, it is 

assumed that the block is within the extraction cone and it must be removed before the 

base block. Otherwise it is assumed that the block is outside the extraction cone. Blocks 

that lie within the extraction cone are submitted to the graph algorithm. The program 

was written in such a way that extraction cones are established only for ore blocks. This 

prevents unnecessary increases in computing time and prevents waste blocks being 

considered many times. 

Figure 3.31- Directed graph representing a north-south cross-section in a cubic 

block model with East face angle of 60° and 

West face angle of 45° 

Using this procedure, pit slopes are no longer fixed and are not limited to one-up 
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and one-over patterns. They can vary in principal directions and are independent of block 

dimensions. Figure 3.31 illustrates a directed graph representing a Northing section in 

cubic block model in which East face angle and West face angle are assumed to be 60° 

and 45° respectively. In this graph, Vertices 4; 5,6,7,14 and 15 are in the extraction 

cone of block 23. 

3.5.1.1- An example 

This procedure has been incorporated into the Lerchs-Grossmann algorithm to determine 

optimum pit limits with variable slope angles. To show how the program works, a simple 

example is used in which the block dimensions and wall slopes are as follows: 

Block dimensions: 

East - West 15 m 

North -South IOM 

Vertical 10 m 

Pit slope angles: 

North face angle 60° 

East face angle 501 

South face angle 30° 

West face angle 45° 

The graphical results of the optimum pit limit are illustrated in Figures 3.32,3.33 

and 3.34. Figure 3.32 shows the optimum pit in plan in which the location of the pit is 

shown with coloured rectangles representing the number of levels from the surface that 

must be mined. Figures 3.33 and 3.34 illustrate the pit limits on Easting and Northing 

sections respectively in which the pit limit is shown with a thick line indicating that the 

blocks above this line are part of the optimum pit. It should be noted that the program 

also works with rectangular blocks. Slope angles are independent of the block 

dimensions and can vary in all four principal directions. 
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Chapter 3: The Lerchs-Grossmann algorithm 

3.5.2- Multiple variable slope angles 

In complex cases in which the pit slopes vary in different parts of the orebody due to 

slope stability requirements, it is necessary to divide the orebody into regions or domain 

sectors, within which the rock characteristics are the same, and to use different slope 

angles for each region. In these cases, slope angles are assigned to each block in four 

principal directions within each region - this is discussed later in this chapter. 

1 

1 

2 

3 

4 

5 

Figure 3.35- Extraction cone of a block for a two-dimensional 

example with three different regions 

In the case of multiple variable slopes, an extraction volume is constructed level 

by level by creating rings or envelopes from the base block and extending them to the 

surface having regard for pit slopes which have already been assigned to blocks. The 

extraction volume is constructed from the base block to the next overlying block and 

then is constructed from the point of intersection of the cone with this level to the second 
level above the base block. This procedure is continued to the surface. 

2 3 4 5 6 7 8 9 

A4 A4 

dx1. dxý . 

dxz dx ' ; 

dx ' 
/dx 

' 
, j 

ast E ace angle West face angle 

Region I Region 2 Region 3 
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This procedure can best be explained by means of the ; two-dimensional example 

shown in Figure 3.35 in which the orebody: is divided into three different parts. Let us 

assume that this is the Northing section and two slope angles -the West face angle and 

the East face angle - have already been assigned to each block: Consider a block in level 

k (row) and column j, for instance block (5,5) on which the cone will be constructed. To 

determine the blocks within the extraction cone of this block the following procedure is 

used. 

With reference to Figure 3.35, an extraction cone is constructed from the base 

block to the next overlying level using the slope angle of this block. In the two- 

dimensional case, two lines are drawn from the mid-point of the base block to the left and 

right with regard to the East and West face angle of the base block respectively and they 

are extended to the level above. The values of parameters dx; 
, 

dxZ and the number of 

blocks to the East, m; , and to the West, m2 , on the first level above the base block are 

determined by the following equations: 

. J-j - 
zdim' (3.15) 

Tan[West face angle of block(k, j)] 

-L. 1 
- 

z dim - 
2 Tan[East face angle of block (k. i)ý 

m'_ 
ý1 

' xdim 

I 

m! _2 
2x dim 

(3.16) 

(3.17) 

(3.18) 

Where zdim and xdim are the block dimensions in the vertical and horizontal 

directions respectively. On the first level above, the blocks Xk. 1, m, where m= j-m2 
, 

j+m;, are considered as part of the extraction cone. 
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There are two intersection points of the extraction cone with the level above the 

base block (lines drawn from the mid-point of the base block to the next overlying level). 

The extraction cone is extended from these two points to the next overlying block 

(second level above the base block) by using. the slope angles of the blocks containing the 

points of intersection. In order to determine the slope of the. block to be used (in other 

words, to find the block in which the intersection lies) the values of parameters dx, and 

dxv are divided by the block dimension and the result is rounded up. This means that a 

value of 0.5 is added to the result of division and then the integer part is taken. That is: 

+0.5 
xdim 

l 

+ 0.5 mll _x dim 

(3.19) 

(3.20) 

Then the values of parameters dx, 
, 

dx2 and the number of blocks in both directions m, 

and m2 on the second level above the base block are determined as: 

4hCz _ dxl +z 
dim 

'-' Tan[West face angle of block(k -1, j+ mll )] 

. x. 2 
- 4_1 I z dim 

C" NJI T 22 Tan[East face angle of block (k 
-1, j- m12ýý 

2 

m2= 
dx' 

x dim 

dxa 
2 

x dim 

(3.21) 

(3.22) 

(3.23) 

(3.24) 

Again, the blocks Xk. 2, m, where m= J-mm j+ ml , are considered as part of the 
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extraction cone on the second level above the base block. This' procedure is continued to 

the surface. 

In general, for the nu' level above the base block, The values of parameters dx; 
, 

dc, " and the number of blocks to the East, m, ", and to the West, m, ", are determined by 

the following equations: 

n-1 
f 

ýn 
ý1 

mi; ý' = im+0.5= xdim 
+0.5 

xd 

n-1 
rr i 

ýn-1 Lýý2 

m12-1= 
xdim+0'5 

= xdim 
+0.5 

_I , zdim dx, 
; _, 

dx' + 
Tan[West face angle of block(k -n+1, j 

n-1 
.. z. n - 'C'' .. L. i , z dim 

Z1t Tan East face angle of block (k 
-n+1, j- m12'1) 

Cl 

x dim 

n_ 
"'Zýxdim 

(3.25) 

(3.26) 

(3.27) 

(3: 28) 

(3.29) 

(3.30) 

On the no' level above the base block, the blocks Xk.,,, m, where m= j-m2 
, 
j+m; , 

are considered as part of the extraction cone. 

As an example, the extraction cone of the-block in level 5 (row) and column 5 in 

Figure 3.35 with the slope angles shown in Table 3.2 is determined as follows: 
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Region East face angle West face angle 

1 58° 40° 

2 45° 55° 

3 42° 30° 

Table 3.2- Slope angles for two-dimensional example 

The first level above the base block (level 4): 

1_ zdim 
_ 

10.0 
_ Tan[Westface angle of block(5,5)] Tan55 

7.0 (3.31) 

äz 
dim 10.0 

_ 10 ckc Tan[East face angle of block (5,5)1 Tan45 -. 
0 (3.32) 

7.0 1_ 
m' 10.0 

0 

n11 10.0 
a 10.0 

Thus, the blocks (4,4) and (4,5) are in the extraction of block 

The second level above the base block (level 3): 

dm1 
+0.5=100+0.5=1 

x x 

dx2 
+0.5-10.05 =1 

xdim , 10.0 
+ 0. 

(3.33) 

(3.34) 

(3: 35) 

(3.36) 

z dim 10.0 
(3.37) dc, 2= dx; + 7.0 + 14.0 

Tan[West face angle of block-(4,6)] 
/ .VT 

Tan55 

5,5 
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dx2 
+z dim 

=10.0 + 
10.0 

_ 20.0 (3.38) 
Tan[East face angle of block (4,4)] Tan45 

mz_ 
de2 14.0_1 

' xdim 10.0 
(3.39) 

2_ 
dx2 

_20.0_2 2x dim 10.0 
(3.40) 

On level 3 blocks (3,3), (3,4), (3,5) and (3,6) are in the extraction cone of block (5,5). 

The third level above the base block (level 2): 

z 14.0 
mll =xdm+0.5=10.0+0.5=1 (3.41) 

z 
mlz = 

dm+0.5= 
120.0 0.0+0.5=2 

(3.42) 

&C 
, 

3, =&C2 + 
zdim 

ý14.0+ 
10.0 

= 21.0 (3.43) 

. 
Tan[West face angle of block(3,6)] Tan55 

dx2 d2. + 
zdim 

= 20.0. + 
10.0 

=, 26.2 (3.44) 
Tan[East face angle of block (3,3)] Tan58 

3 dx1 21.0 
m, ý xdim 10.0 

(3.45) 

M2 
dxä _26: 2_2 

ý xdim. 10.0 

On level 2, the blocks (2; 3), (2, A), (2,5); (2,6 

in the extraction cone of block (5,5). 

The'fourth level above the base block (level 1): 

(3.46) 

and (2,7), as shown in Figure 3.35, are 
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3 21.0 
ml, = 

dtn+0.5=10.0+0.5=2 

3 

ml" =' 
dm+0.5= 

10, 
Q+0.5=3 

(3.47) 

(3.48) 

4_ dcl + zdim 
= 21.0 + 

10.0 
dxc = 38.3 (3.49) 

Tan[West face angle of block(2,7)] Tan30 

dx2 = dxz + 
zdim 

= 26.2 + 
10.0 

= 32.4 (3.50) 
Tan[Eastface angle of block (2,2)] Tan58 

m4 
dx4 38.3 

'x dim 10.0 
3 

4 32.4 
mz __ xdim 10.0 

3 

(3.51) 

(3.52) 

In the first level, the blocks (1,2),, (1,3), (1,4), (1,5), (1,6), (1,7) and (1,8) are in the 

extraction of block (5,5) (Figure 3.35). 

The procedure presented for multiple variable slopes in two dimensions can be 

applied to the three-dimensional case. In the same way as the procedure used for variable 

slope angles, the pit shape is assumed to be defined by an irregular, elliptical outline on 

each, level. The outline on each level consists of four quadrants of different ellipses 
defined by the pit slope angles in the four directions. The value of two semi-major axes, 

two semi-minor axes and the number of blocks in the principal directions on any level 

above the base block should be calculated in both sections in the same way as presented 

above for one section. When these parameters are determined, again by using the ellipse 

formula, any block whose mid-point lies inside the ellipse is considered to be part of the 

cone. The value of four axes and number of blocks in four directions for t`h level above 

the base block ( block Xij, k) can be found from the following equations: 
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r-i 
ý dx' 1 

ml ' -' _ '-' +0.5 
x dim 

r-t 

nl'-' - 
ydim 

+0.5 

tr-I 

2 L.. ý 
ýý 

m12' = f-' +0.5 
xdim. 

t-1 

nlt-' +0.5 ay dim 

r-1 

i dy2 

ý uaua 

c«dx`+ 
i=l 

1 Tan[West face angle of block(i +mlj'1, j, k-t+ 1ý] 

r-1 

z dim 

z dim 

r=i Tan South face angle of block ýi, j+ n1; "', k= t+ 1A 

r-1' 
rlv, - 

N"ilv{ ,z 
dim 

i=, Tan[East face angle of block (i - ml2', j, k-t+ 1)] 

r-1 

(3.53) 

(3.54) 

(3.55) 

(3.56) 

(3.57) 

(3.58) 

(3.59) 

dyz dyz +ýu.. (3.60) ý 
Tan[North face angle of block (i, j- nl2', k-t+ i)l 

n1r _ ýt 

x dim 

t_ 
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ýr 

z 
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,,,, I1. ý,, t 

nr _ 
'"72 

2 ydim, 
(3.64) 

In general, for the three-dimensional case the following steps can be used to 

construct an extraction cone for block X;,;, k on level k. 

1- 

2- 

3- 

4- 

Start from the base block X;, J, k 

Assign zero to dxl, dyl, dx2 and dye 

Assign 1 to t 

Calculate: 

ml, =dxi /x dim+ 0.5 

nh = dyi / ydim+ 0.5 

m12= dxz /x dim+ 0.5 

n12=dy2/xdim+0.5 

5- Read slope angle from the block model of the ' deposit: 

dip0 = North face angle of block (i, j- n12, k- t+ 1) 

490 = East face angle of block (i - m12, j, k-t+ 1) 

dip180 = South face angle of block (i, j+ nh, k-t+ 1) 

P270 = West face angle of block (i + mli, j, k-t+ 1) di, 

6- Calculate dxl, dye, dx2 and dye from:, 

dx, = dxi: + z dim/ tan dip270 

dy, = dy, +zdim/ tandip180 
dx2 = dx2 +z dim/ tandip90 

dye = dy2+zdim/ tandip0 

7- Calculate the number of blocks for the four principal directions: 

., mi = dxi / xdim 
ni=dyi /ydim 
ma=dxz/xdim 

n2= dyz / ydim 
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8- Examine all the blocks X, n, k_t, where M i-m2, i+m, and n= j-n2, j+nl, to 

determine whether they are within the cone; 

ci-=xdim* (i-m) 

b=y dim* (j - n) 

Tf m> i and n> i then Vnlvo --.. t_ 
b2 

ý. ... _,..,...., ýý ý...,. . ,. (ýI)2 ýµY1f 

ä2 b2 
If m >_ i and n: 5 j then Value 

)2 + 4y2)2 a'x, 

22 

If, ms iand n5j then Value=( 
)2. +( 

=)Z 

-- a2 b2 
If m<_ iand na j then; Value =jý2 +ýdy 

, )2 dxs 

If the `Value' is less than or equal to 1 the block X., n, k .t is part of the 

extraction cone of. block X;, j, k and is submitted to' the graph algorithm 

otherwise the next block is examined. 

9- Add 1 to t 

10- If t is less than k go to step 4 

Again, when the shape of the cone has been established all blocks within the cone 

are submitted to the graph algorithm. 

3.5.2.1- An example 

This procedure has also been incorporated into the Lerchs-Grossmann algorithm to 

determine optimum pit limits for complex deposits in which the pit 
- slopes vary 

throughout'the orebody. ' In order to show how the algorithm works for multiple regions, 

refer to the simple example illustrated in Figure 3.36 in which the deposit is divided into 
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four different regions with the slope angles shown in Table 3.3. 

Region North face angle East face angle South face angle West face angle 

1 300 40° 42° 38° 

2 41° 37° 50° 46° 

3 350 350 35° 350 

4 390 39° 46° 46° 

Table 3.3- Slope angles applied to example shown in Figure 3.36 

190 

170 

ISO 
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100 160 130 

4 

190 

Easting (m) 

220 

Region 3 

250 

Figure 3.36- Dividing a deposit into four different regions 

280 310 

The block dimensions are, 15m x 10m x 10m in the East, North and vertical 

directions respectively. The graphical results of the optimisation are shown in Figures 

3.37,3,38 and 3.39. As can be seen from the graphical presentation the algorithm works 

well and slope angles can vary throughout the deposit without changing the block 

dimensions. 
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3.5.3- Programming 

Optimal pit design algorithms require _ an amount of memory to be allocated in the 

computer. This is. required to store the block model either in the form of block revenue 

values or in the form of block grades. For instance the Lerchs-Grossmann algorithm 

programmed in FORTRAN 77, by Dowd (1994a) and based on the 1: 5: 9 pattern to 

define mining slopes, uses two three-dimensional arrays and six two-dimensional 

working arrays (matrices). The three-dimensional arrays include the revenue block values 

and a. logical variable that indicates whether each block-is inside or outside the pit. The 

numbers of elements in these arrays are equal to the number, of blocks used to define the 

orebody block model. The numbers of elements in 
. the working matrices depend on the 

complexity of the deposit and the number of blocks in the model. This is usually assumed 
to be one-twentieth of the number of blocks in the orebody block model. To implement 

the algorithm requires an amount of computer memory to store these arrays and, thus, 

imposes a storage limitation on the program, especially for personal computer (PC) 

implementations due to the limitations of DOS memory. This limitation has been 

overcome by the development of a Windows program and the use of dynamic memory 

allocation to take full advantage of hardware capability. 

To date, almost all the PC software for the mining industry has been written in 

FORTRAN running under the DOS operating system. There are some limitations which 

are imposed by both the language and the operating system. For instance, DOS is unable 

to use all the computer's memory. It uses conventional memory that is usually limited to 

640 kb. Not all this memory is available for DOS programs since DOS ' uses some 

memory to store memory resident -programs. FORTRAN programs also require 

definition of the dimensions or size of the arrays with constant values and these have to 

be large enough to store all potential elements. In other words, 'it does not use dynamic 

memory and cannot allocate space required during program 'implementation. On' the 

other hand the Lerchs-Grossmann algorithm requires an amount of memory which 

depends 'on the number. of blocks in the orebody 'model. Using PC computers running 

under DOS this algorithm can only be implemented for relatively small deposits. As an 
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example, the FORTRAN 77 code developed by Dowd (1994a) can only deal with 
deposits containing less than 50 x 50 x 10 blocks. Dowd and Onur (1993) overcame this 

limitation by using random 'access storage and. only retrieving blocks when they are 

required for processing. Whilst this approach can. handle any number of blocks 

computing time increases almost exponentially as the number of blocks increases 

primarily because of storage and retrieval times. In practice, this approach is limited to 

block models with up to 106 blocks depending on the complexity of the distribution of 

grade in the deposit; the maximum number will decrease as the complexity increases. 

One way to overcome the memory limitation and deal with larger deposits is to 

implement the algorithm on a work station. The primary disadvantage here is that 

workstations have limited availability especially on mine-sites. 

At first it was decided to modify Dowd's FORTRAN 77 code of the Lerchs- 

Grossmann algorithm, in order, to, take into account variable slope angles. After 

considering the limitations of DOS programs it was then decided to develop a Windows 

program to take full advantage of hardware capability. Windows applications can access 

all the computer memory and have many advantages over DOS programs. Some of these 

are better graphics, device independence and the use of 32-bit numbers rather than 

16-bit. In addition, Windows is rapidly becoming the standard environment for PC users. 

On the downside Windows requires a different style of programming which is slightly 

more difficult than that for DOS programs. 

Windows applications can be divided into two, categories: 16-bit Windows such 

as Windows 3.1, or standard, Windows, and 32-bit Windows such as, Windows 95 and 

Windows NT. These two forms of Windows manage memory in two different ways. The 

first divides memory into segments each of which up to 64 kb long. With the use of 

16-bit Windows, it is possible to allocate 16,000 elements for the working matrix which 

is sufficient to deal'with a deposit having around 320,000 blocks. In-32-bit Windows, 

memory is like an empty large box and it is not segmented. There is no limitation and any 

matrix with any dimension can be allocated. 
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A new computer program was developed in C++ code to determine optimum 

open pits. This program runs under the 32-bit-Windows operating, system and uses" 
dynamic memory allocation for the - storage' of block characteristics. and working 

matrices. For example, the following C++ code is used to allocate space required to store 

the block revenue value. 

float ***val; 

try{ 
vä1= new float ** [numx]; 

for (i _ 0; i< numx; i-t+) 

val[i] = new float * [numy]; 

for (i = 0; i< numx; i++) 

for (j = 0; j< numy; j++) 

val[i][j] =new float [numz 

catch (xalloc ){ 

cout << "Couldn't allocate memory. "; 

} 

ý 

' This program has been successfully, tested for a . real data set -having more than 

400,000 blocks in the model on a PC computer with 16 Mb of RAM memory. Due to 

the low price of computer memory and also with this new program, it is now possible to 

implement the Lerchs-Grossmann algorithm on a PC for an unlimited number blocks in 

the orebody block model. 

3.5.3.1- Memory requirements 

In order to -develop a computer, program using dynamic memory allocation, the 
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FORTRAN 77 code developed by Dowd (1994a) was adopted and converted to C++ 

code. It was then validated by comparing the results of both programs -from a number of 

trial data sets. After validation of the C++ code of the Lerchs-Grossmann algorithm, it 

was modified to deal with variable slope angles using the procedure described above. 

Two programs were developed to determine the optimum pit outline. The first program 
determines the optimum pit limit with variable slope angles in which only one' region is 

used to define the pit slopes. The second program determines the optimum pit limit for 

multiple regions in each of which the mining and access slopes are defined by four 

principal slope angles. This program can also be used for one slope angle for each region. 

Both programs require two input data files which are-previously created by the revenue 

calculation program explained later in this chapter. The first file is a text file that contains 

the block model characteristics - block dimensions, number of blocks in the model and 

the four principal slope angles if a single region is used to define the mining'slopes. The 

second file is a random access file and contains one record for each block including either 

the block value and logical value for the variable slope or, for a multiple slope pit, the 

block value, logical value and four principal slope angles. The programs read, the first file 

and allocate the memory required, to store the information from the second file; they then 

determine the optimum pit limit and write the results to an output file for, further use. 

The memory required to implement the algorithm on a PC computer is described in the 

next section. 

3.5.3.1.1- Memory required for the variable slope angles algorithm 

The program uses two three-dimensional arrays and six two-dimensional working 

matrices. The three-dimensional arrays are used to store block values and logical values 

that take a value of 0,1 or 2. A value of 0 indicates that block is ready to be considered, 

a value of 1 indicates that a block has been added to the optimum solution and a value of 
2 indicates that a block is still being considered. -The numbers of elements in these two 

arrays are equal to the number of blocks in the deposit. The number of elements in the 

working' matrices are set to one-twentieth of the number of blacks in the, model: Four 
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bytes are required to store the value of one block and for each block one byte is required 

for storage of the logical value. ,A total of 40 bytes is also required to store each of the 

elements of the working matrices. The memory required is therefore: 

n= numx * numy * numz, number of blocks in the model 

ml =5*n memory required for, three-dimensional arrays 

m2 = 40 *n120 memory required for working matrices 

m= m1 +M2'= 7* n total memory required 

For example, for a deposit having 400,000 blocks in the model, almost 2.8 Mb 

memory is ý required for PC implementation of the Lerchs-Grossmann algorithm with 

variable' slope angles. It should be noted that this program does not use- any array for 

storage of slope angles, as they are constant through the deposit and only four variables 

are required to store them.. 

3.5.3.1.2- Memory required for the multiple variable slope angles algorithm 

In addition to the arrays used in the program for variable slope angles, this program uses 

an extra four three-dimensional arrays for the storage of slope angles which have already 

been assigned to the blocks. Four bytes are also required to store the four principal slope 

angles for.. each block. Therefore the total memory required for storage of a block's 

characteristics and working matrices are: 

m=7, *n+4*n =11 *n total memory required 

For example, almost 4.4 Mb memory is required for PC implementation of the 

Lerchs-Grossmann algorithm with multiple variable slope angles for a deposit having 

400,000, blocks in the model. 

3.5.3.2- Computing time 

Computing time-to reach a solution depends on many factors including the number of 
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blocks in the orebody model, the complexity, of grade (and; hence, revenue) variation in 

the orebody and the pit slope angles. It is obvious that a deposit having a large number of 
blocks in the model requires longer computing time to reach a solution than a deposit 

containing less blocks. As the complexity of the deposit increases, the computing time 

required also increases. Flat slopes require more blocks to be removed to mine a 

particular block than steeper slopes which results in increased computing time. 

As mentioned before using random access files in the optimal pit design algorithm 

significantly increases the computing time to reach a solution. For instance, under the 

32-bit Windows operating system, a real data set, with 59 x 96 x 15 blocks, takes 45 

minutes with the use of random access files. It takes less than two minutes for the same 

data on the same computer if using computer memory for the storage of required arrays. 

In addition, the new program is faster than the similar code running under DOS, since it 

takes advantage of the 32-bit operating system rather than 16 bit. 

3.6- Revenue block model 

The Lerchs-Grossmann algorithm requires a revenue block model of the orebody ' as 

input and determines which blocks should be mined to achieve maximum net` profit. To 

create a revenue block model and determine the optimum pit limit the following 

information is required: 

1- Block grade model of deposit, 

2- Physical and economic parameters 

3- Pit slopes 

The orebody block grade model can be obtained by subdividing the orebody into 

a regular, rectangular array of blocks and assigning grade values to each block. Such a 

model can be achieved by using geostatistical or other estimation methods. In'the current 

study, it is assumed that the block grade model ̀of a depositýhas already been determined 
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and represented in a text file. This file must contain one record for each block and each 

record can be one of the two following types: 

Type I- Each block has single grade only 

" Co-ordinate of the mid-point of each block 

" Estimated grade (mean grade of the block) 

Type II- Each block has grade and recoverable tonnage 

" Co-ordinate of the mid-point of each block 

" Grade above cut-off grade 

" Recoverable tonnage 

The three-dimensional co-ordinates are the Easting, Northing and vertical of the 

mid-point of the blocks. The records can be in any order and the information can be 

recorded in free format. It is assumed that blocks whose co-ordinates are missing from 

the file (i. e. gaps in the rectangular array) define the surface topography. Any negative 

values for grade and tonnage denote missing values and are regarded as waste blocks 

when the revenue value of a block is calculated. These are blocks whose grades or 

tonnage have not been estimated because of lack of data. 

The physical and economic information includes block dimensions, specific 

gravity of ore and waste, cut-off grade if the block grade is of type I (each block contains 

only a grade) is used, cost of mining of ore and waste, processing cost, recovery factor 

and price of metal. The cost of mining of ore and waste can be fixed or can vary, as a 
function of depth. Recovery factor can also be fixed or can vary as a function of grade. 

The third type of information required for optimum pit design is the mining slopes 

which are considered as constraints on the pit design. Pit slope angles, which depend on 
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many factors such as rock strength, presence or absence of discontinuities, ground water 

conditions and other geotechnical factors, may vary through the deposit. To define 

mining slopes, the orebody must be sub-divided into the regions or domain sectors in 

which rock characteristics are the same and can be characterised by a single set of slopes. 

This can be done by the evaluation of geological and geotechnical information which is 

obtained during site investigation or at the exploration stage. It is assumed that the upper 

and lower area of the region is approximated by a polygon. Figure 3.36 illustrates a 

simple example in which the deposit is divided into four different regions. 

The information required to define 'mining slopes depends on the number of 

regions. If-only one region is specified only the four principal slope'angles are required. 

Otherwise, for each region the minimum and maximum depth, co-ordinates of the points 

defining the region and four principal slope angles are required. A maximum' of 20 

different regions can be specified and there is no limit on the number of co-ordinates 

defining each region. 

A revenue block model is constructed by applying : economic and physical factors 

to the block grade ' model of the deposit. Air blocks (blocks whose co-ordinates are 

missing from the grade block file) are assigned a value of zero, waste blocks are assigned 

negative values and the ore blocks have positive values. The profit value for each block 

is the net amount of income obtained by extracting the block and processing and selling 

its contents. For type I block grade models, in which each the entire block is assigned an 

average grade, the cut-off grade distinguishes ore blocks from waste blocks. All blocks 

with .a grade below the cut-off grade are treated as waste. The, value of each block is 

determined from the following formulas for the two types of block model: 

volume = xdim * ydim * zdim Volume of block 

Type I- Each block has an average grade for the entire block: ' 

If the grade of the block is less than the, cut-off grade, or it- is negative,, then the 
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block is treated as waste and its value is determined by: 

Value= -volume, * specific gravity of waste * cost of mining of waste 

If the grade of the block is greater than the cut-off grade it is considered to be ore 

and its value is calculated as 

Value= volume * specific gravity of ore * grade *price. * recovery factor 

- volume * specific gravity of ore *(cost of mining ore + processing cost) 

Type II- Each block is assigned a recoverable, tonnage above a cut-off grade and the 

average grade of the proportion of the block above the cut-off grade: 

If the grade of the block is negative or its recoverable tonnage is negative, the 

entire block is regarded as waste and its value is determined as: 

Value = -volume * specific gravity of waste * cost of mining of waste 

If both, grade, and recoverable tonnage of the block are positive its value is 

determined as:, 

Value = tonnage of ore in the block * grade,, * price * recovery factor 

- tonnage, of waste in the block * cost of mining of waste 

- tonnage of ore in the block * (cost of mining ore + processing cost) 

When- the value of each block is calculated, the results are written to a random 

access file that is used as input for the optimal pit design programs. One record is used 

for each block. The number of fields in each record differs according to the number of 

regions specified. If only one region is specified each record will contain the block value 

and one logical variable. If multiple regions are specified each record will contain the 

block value, one logical variable and four principal slope angles:. 

Twö programs were written to create the revenue block' mödel. The first is used 
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to calculate the revenue block model for variable slope angles in which only one slope 

region is specified. For a single region the slope angles are not assigned to each block so 

as not to allocate unnecessary memory in the pit design program. . The ' second program 

calculates the revenue block `model values for multiple regions in' which pit slopes are 
assigned to each block. Both programs create three output files: the block file, the 

revenue block model and the grade block file. The first file is a text file that contains 
block model characteristics - block dimensions, number of blocks in the model and, for a 

single region of mining slopes, the four principal slope angles. The next two files are 

random access files that contain one record for each block. The revenue block model file 

is used in the optimal pit design program and the-block grade file is used to, determine the 

mean grade of the blocks within the pit. The basic steps involved in creating the revenue 

block model are: 

" Read data: block grade file, physical and economic factors and pit slopes. 

" Calculate the number of blocks in the east-west, north-south and vertical 
directions. 

Construct a random access working file and assign zero to each block. 

"- If. multiple slope regions are used assign slope angles to each block. 

" Calculate the profit value of each block and output to the working file. 

0 

Calculate the number of blocks to add at the borders. 

Construct a random access revenue file. 

Output the values in the working file to the revenue file. 

" Add waste block around the borders.. 

Note that,, in the revenue block model, an air block indicates surface topography 

and has a value of zero; ore and waste blocks have positive and negative values 

respectively. An air block takes a logical variable of 1, indicating that it is not added to 

the graph when determining the optimum pit. Waste and ore blocks take a logical 

variable of 0, denoting that they are considered during the optimisation. 
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3.6.1- Adding additional waste blocks to the model 

The orebody block grade model does not usually have sufficient peripheral blocks to 

allow the removal of the bottom-most edge blocks. Additional waste blocks must be 

added around the boundaries of the block grade model to ensure that all blocks are 

technically minable and to ensure the stability of the pit. For example, consider Figure 

3.40 in which additional waste blocks are added to the model in order to make minable 

the ore blocks at the bottom edge of the deposit. 

Missing blocks define surface topography 

as°/f'\ 111111111 1/ k 60 

Block added 
to the West 

Original block model Blocks added 
to the East 

Figure 3.40- Blocks added to the West and East of Northing section 

The number of blocks that are added to the orebody model on the four horizontal, 

rectangular boundaries must satisfy the lowest slope angle of any area of the deposit. To 

determine the number of blocks to be added to the model, it is necessary to find the 

lowest slope on the boundaries of the model. The lowest slope angles for variable slopes 

in which only one slope region is specified are the four principal slope angles. For 

multiple regions the lowest slope angles must be found among the slopes of the blocks 

on the boundaries of the deposit, that is: 

For variable slope angles: 

di = North face angle 
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d2 = East face angle 

ds = South face angle 

d4 = West face angle 

For multiple variable slope angles: 

di = The lowest angle of the North face angle of blocks (i, 0, k) 

d2, = The lowest angle of the East face angle of blocks (0, j, k) 

d3 = The lowest angle of the South face angle of blocks (i, numy -1, k) 

, d4= The lowest angle of the West face angle of blocks (numx -1, j, k) 

When the lowest angles are found, the number of blocks to add to the deposit in 

the four principal directions can be determined from the following' equations: 

rrum N- zdim*(numz-1) +D. S 
- ydim*tan(d3) 

num E= zdim*(numz-1) +0.5 
- xdim*tan(da) 

zdim * (numz -1) num_ S=y 
dim * tan(d, ) 

+ 0.5 

num W=z 
dim * (numz -1 ) +0.5 

- xdim*tan(da) 

(3.65) 
. 

(3.66) 

(3.67) 

(3.68) 

Where 

num-N is the number of blocks added to the northern boundarynum 

E is the number of blocks added to . the eastern boundary 

num-S is the number of blocks added to the southern boundary 

num-W is the number of blocks added to the western boundary 

It should be noted that the optimal openpit program is written in a such way that, 
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when a search is made to find ore blocks in the revenue block model, the waste blocks 

that are added at the borders are excluded from the search. These blocks are only added 

to the graph when it is necessary to consider ore blocks at the bottom edge of the 

orebody. 

3.6.2- Assigning slope angles to the blocks 

If more than one region, or domain sectors, are specified to define mining slopes, it is 

necessary to assign slope angles to each block. To assign slope angles to the blocks, the 

first step is to determine which blocks are inside the particular region. A block is deemed 

to be inside a region if its mid-point lies within that region. Blocks deemed to be within a 

given region have the slopes of that region assigned to them. Two different methods 

have been used to determine whether a point is inside, outside or on the boundary of a 

polygon. They are the ray-crossing and angle sum methods. 

9 

11 

12 

Figure 3.41- Ray-crossing method 

Ray-crossing method- Consider the polygon and point A shown in Figure 3.41. 

Choose any point outside the polygon and draw a line, or ray, from this point to point A. 

Count the intersections of this line with the edges of the polygon. If the number of 
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intersections is odd then the point is inside the polygon, otherwise it is outside the 

polygon. This procedure is simple but care must be taken to account for lines that pass 

through one of the vertices and lines that are collinear with an edge. For an example see 

point B in Figure 3.41, if a horizontal line is drawn from this point it will be collinear 

with the edge 3-4 and pass through vertex 6. 

Figure 3.42- Angle sum method 
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Angle sum method- Consider any polygon defined by lines joining a set of 
vertices and any point A that may be inside, outside or on the boundary of the polygon 
(e. g. Figure 3.42a). Draw lines from A to_ each of the vertices defining the boundary of 
the polygon. Measure the angle between each successive pair of lines defining clockwise 

as positive and anticlockwise as negative. The point is inside the polygon if the sum of 
the angles is 2n radians and is outside if the sum is zero as illustrated in Figure 3.42. 

The basic requirement for this method is the signed angle between pairs of lines 

from the point to successive pairs of vertices defining the boundary of the polygon. 
These angles can be determined either by using the dot product oftwo vectors or using 

the equation of a triangle. The sign of angles can also be determined from the cross- 

product of two vectors as, follows: 
_. ý. II 

a2 = b2 + c2 - 2bcCose triangle equation 

v,. v2 w, Iw2ICosO dot product of two vectors 

VJxvz =Iv, 4)v2I SinO cross-product of two vectors 

The. angle sum method, has been employed in this work and is: based on coding 

originally written by Dowd (1973). 

A block whose mid-point lies within a slope region is assigned, the slopes of that 

region. The method is implemented by first imposing a bounding box around the region 7- 
this is the smallest rectangle that contains the region or polygon, (Figure 3.43). Then the 

mid-points, of all the blocks in the first level of the region that are inside the bounding 

box are examined to see whether or not they are inside the region.; If the mid-point of any 
block lies inside the region, slope angles are assigned to all blocks at this . location from 

the minimum to the maximum depth of the region. 

Other methods, such as the scan line method, could be used to assign slope angles 

to the blocks. This, is also used in computer graphics to, fill polygons. 
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Xlna, 
( 

X. in 

Xm 

Figure 3.43- Bounding box of region 4 in Figure 3.36 

3.7- Pit bottom smoothing 

The Lerchs-Grossmann algorithm takes the revenue orebody block model and determines 

those blocks that should be mined to obtain the maximum profit value from the pit. This, 

or any other, optimal pit design algorithm is likely to produce a very irregular outline on 

the floor of the pit which may not be practical due to the presence of isolated blocks or 

the lack of adequate space for mining equipment. As an example, consider the pits shown 

in Figures 3.32-3.34 and 3.37-3.39. Although these pits generated by the Lerchs- 

Grossmann algorithm are economic optima, they may not be practically feasible because 

of minimum space requirements for mining equipment to operate freely. It is also 

possible to incorporate minimum space requirements in the algorithm but this 

significantly increases the computing time to reach a solution. Another approach is to 

design the pit without any minimum access constraints and then to smooth the pit bottom 

in order to allow sufficient space for mining equipment. 

A modified version of the pit smoothing approach presented by Onur and Dowd 

(1993) has been adopted in this work. The user is asked to specify the required minimum 
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space in which the mining equipment can operate freely. The minimum space can be 

defined in terms of the number of blocks to be mined together at any one time which is a 
function of the horizontal block dimensions and the minimum space required. For 

example, for an orebody model comprising 10m x 1Om x 10m blocks with a minimum 

space requirement of 20m, four blocks must be mined together to gain the required 

space. Six blocks must be mined together for the minimum space of 30m for a block 

model comprising 15m x 10m x 10m blocks. There are usually several combinations of 

blocks that will provide the required space. As illustrated in Figure 3.44, there are four 

possible alternatives in a 10m x 10m x 10m block model, to gain a minimum space of 

20m x 20m (Figure 3.44a) and six possible combinations of blocks to provide a 30m x 

3 0m space in a 15m x lOm x lOm block model (Figure 3.44b) 
. 
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b- Rectangular block (15m x 10m) and minimum space 30m 

Figure 3.44- Possible combinations of blocks around a specific block (shaded) 
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Chapter 3: The Lerchs-Grossmann algorithm 

The pit-bottom smoothing algorithm starts with a search for all blocks within the 

pit. Each of these blocks is then examined in turn to ' determine whether minimum space 

requirements are met. For each block all combinations of_ surrounding blocks- are 

examined. If any combination satisfies the minimum space requirement no smoothing is 

done. Otherwise the net value of each of the combinations that would be obtained by 

mining the additional block and corresponding overlying blocks is calculated. Among 

these, the combination chosen is the one with the highest value and the least effect on the 

overall profit., This value is added to the value of the block under consideration. If the 

result is still positive then all blocks in this combination are included as part of the pit. 

Otherwise the block under' consideration is removed from the pit. 

Two programs were written to implement pit bottom smoothing. The first 

involved the smoothing of the pit bottom for variable slope angles in which only one 

region is specified: The second program is for pit bottom smoothing for the case of 

multiple slope" angles in which more than one region is specified. These programs use 

files containing records that have different 'fields and use different procedures to 

construct an extraction cone. As an example of the result of pit bottom smoothing, 

consider Figures 3.45,. 3.46 and 3.47, in which the algorithm has been applied in the case 

of multiple regions with. a minimum space of 30m x 30m, introduced in section 3.5.2.1. 

3.8- Conclusion 

The Lerchs-Grossmann algorithm is well-known for being the only method that can be 

proved, rigorously, always to yield the true optimum pit. However, when the algorithm 

was first introduced it was based on a fixed slope angle governed by the block 

dimensions. The methods presented in this chapter have been incorporated into the 

algorithm to overcome this limitation and to take account of variable slope angles. As 

demonstrated by simple examples, the algorithm is able to generate an optimal ultimate 

limit with variable slopes. It works well and can be used for both cubic and rectangular, 
block models. Slope angles can vary in different parts of the orebody without changing 
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the block dimensions and the block dimensions are independent of the slope angles. 

The Lerchs-Grossmann algorithm uses a three-dimensional fixed block model to 
determine the optimum pit limit. Implementation of the algorithm on a PC requires an 

amount of memory for storage of the block characteristics. Due to the limitations of DOS 

memory it is not possible to use the algorithm for large block models. This limitation has 

been overcome by developing a new computer program in C++ code that can be 

implemented under the 32-bit Windows operating system. This program is able to use all 

the computer memory and can be used for large deposits on PC computers providing that 

the computer used has sufficient memory. 

The first step for determination of the optimal pit outline, is to create a revenue 
block model of the deposit. This has been done by, applying physical and economic 
factors to the orebody, block grade model previously created by geostatistical or other 

methods. Furthermore, slope angles have been assigned to the blocks with, the use of the 

angle sum method if multiple regions are specified to define mining slopes. 

The optimum pit limit generated by the Lerchs-Grossmann algorithm may have a 

very irregular bottom that may not be feasible in practice because of the minimum space 

required for mining equipment to operate freely. The method presented in this, chapter 

smoothes the pit bottom to obtain the minimum space required. 
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CHAPTER 4 

Slope design procedure 

4.1- Introduction 

The objective of a mining operation by open pit mining is to extract ore at a profit. The 

profitability of this operation depends on the ability of the pit slopes to be as steep as 

possible without resulting in a large scale failure-Pit slopes of an open pit, which are 

considered as constraints in the determination of the optimum pit limit, affect the size and 

shape of the final pit. The effect of steeper slopes at the pit limit is to decrease the 

stripping ratio and therefore reduce the amount of waste to be removed. On the other 

hand, pit wall needs, to remain stable during the life of the mine. The determination of this 

slope angle is very important. The steeper the final slope that can be designed safely, the 

lower the amount of waste that has to be removed. However, as the slope becomes 

steeper, the probability of slope failure increases. Therefore an optimum mine plane 

should have the steepest "final pit limit remaining stable as long as mining activity is 

continued in that area. 

To determine the optimum pit limit with variable slope angles, an estimate of a set 

of average and safe slope angles is required. Various procedures may be used to 

determine pit slope angles which may vary throughout the deposit to follow the rock 

characteristics. If little geotechnical information is available they may be found from 

other mines of similar size and geological conditions. If the mine is in operation, 

predefined or existing pit slopes can be used to obtain the optimum pit limit. This chapter 
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also presents two approaches and associated computer programs for estimation of a set 

of safe and average pit slopes to use in the optimal pit design program. The first is to 

determine the steepest safe angle with kinematic analysis. The second includes methods 

to design slopes with limit equilibrium analysis in terms of the calculation of the factor of 

safety or the probability of failure using the Monte Carlo simulation technique. 

4.2- General information 

4.2.1- Orientation of a plane 

The orientation and inclination of any structural plane can be described as either dip and 

dip direction or strike and dip. Dip and dip direction are more useful for engineering 

purposes, while strike and dip are usually used in geological studies. The definitions of 

these terms follow and are illustrated in Figure 4.1. 

Figure 4.1- Definition of geometrical terms 
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Strike- The strike of a plane is the direction of a horizontal line contained within 
the plane. 

Dip- Dip is the maximum inclination of the structural plane to the horizontal 

which is measured in a vertical plane perpendicular to its strike. 

Dip direction- Dip direction is the direction of the horizontal projection of the 

line of maximum inclination measuring clockwise from the North. It varies-between 0° 

and 3600. 

The relation between strike and dip direction is: Strike = Dip direction ± 90° 

4.2.2- Orientation of a line 

The orientation of any line in space ' can be described in ' terms ' of its trend and plunge; 

which are defined as: 

Trend The trend of a line is the direction of the horizontal projection of the line 

which is measured clockwise from the North. 

Plunge-'Plunge, which is the dip of line, is the angle made between the line and 

the horizontal which is measured in a vertical plane. 

4.2.3- Four principal, slope angles 

The dip direction of the four principal slope angles used in the current study tö ' develop 

the optimal pit design with variable slope angles are: 

North face slope or Northing slope: the slope with dip direction of 0°. 

East face slope or Easting slope: the slope with dip direction of 90°. 
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South face slope or Southing slope: the slope with dip direction ' of 180°. 

West face slope or Westing slope: the slope with dip direction of 270°. 

4.3- Design procedure 

The optimal pit design algorithm with variable slope angles presented in the previous 

chapter requires an estimate of a set of average and safe slope angles to determine the 

optimum pit limit. For this purpose, it is necessary to divide the orebody into domain 

sectors or regions based on the, geotechnical data gathered during the exploration stage 

and the results of the field investigation in which the rock characteristics are the same 

and can be characterised by a single set of slopes. These domains require separate 

stability analyses and design procedures. 

The first step of slope design is to identify the likely mode of failure. The second 

step is to use one of the slope stability methods to determine whether the slope is stable 

or not. To ensure stability, it may be required to reduce the slope angle. A review of the 

available methods and associated software for slope stability are given by Coggan, Stead 

and Eyre (1998). Traditionally the stability of the slope has been determined in vertical 

section' in which the location of the slope and ' its geometrical relationship with 

discontinuities within it are known or assumed. Whereas in the optimal pit design, the 

location and position of the pit wall is not known until the pit limit is determined. On the 

other hand, to determine optimum pit limit an estimate of pit slope angles is required. 

To overcome this limitation, two different approaches and associated computer 

programs were developed to determine the slope angles: the steepest safe angle from 

kinematic analysis and limit equilibrium analysis in terms of factor of safety or the 

probability; of failure. Both methods determine slope angles for the slopes with dip 

directions from 0° to, 360° in 15° increments. Then these angles, are modified to find the 

four principal slope angles , 
for each region. In the design of pit slopes, the analysis 

applies to major discontinuities occurring in the pit wall and kinematic analysis is used, to 

140 



Chapter 4: Slope design procedure 

detect potential failure modes. Toppling and other types of failure are excluded from this 

study. The following sections describe these methods which have been developed to 
determine the four principal slope angles for use as input in the optimal pit algorithm. 

4.3.1- Steepest safe angle with kinematic analysis 

Kinematic analysis, which refers to the study of movement without taking into account 

the forces causing them to move, can be used to identify structural instabilities (Hoek 

and Bray 
, 1981) or to determine steepest safe angle (Goodman 

, 
1980). This method, 

which is a quite simple and useful technique as the first stage of slope stability planning, 

is usually carried out with the use of stereographical projection techniques. The approach 

is used in this study to determine the steepest safe angle is based on the analytical 

solution. This analysis is carried out with regard to the structural instabilities such as 

plane and wedge failure for each region and for various slopes with dip directions from 

0° to 360° in 15° steps. - For each slope, the program investigates all the discontinuities to 

find the steepest safe angle due to plane failure for each discontinuity and also determines 

the line of intersection for all pairs of discontinuities to find the steepest safe angle due to 

wedge failure. Then among these angles the minimum angle is chosen as the steepest safe 

angle for that direction. Figure 4.2 shows the flow chart to determine the steepest safe 

angle together with the potential failure mode in which it is assumed that input data for 

the algorithm includes dip and dip direction of all the discontinuities and also the dip 

direction of the slope. When the steepest safe angle is determined for all directions they 

are modified to find the four principal slope angles which will be explained later in this 

chapter. 

4.3.1.1- Steepest safe angle with regard to plane failure 

This failure is likely to occur when a geological discontinuity such as bedding plane has a 

strike parallel to or nearly parallel to the strike of the slope face and daylights into the 

slope face. To consider the kinematic analysis of plane failure, the following three 

criterion are examined: 
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Figure 4.2- Flow chart to determine steepest safe angle and failure mode 

142 



Chapter 4: Slope design procedure 

(a) The dip direction of the sliding plane should lie within approximately ±200 of 

the dip direction of the slope. 

(b) The sliding plane must daylight in the slope face. This means that its dip must 
be less than the angle of slope face. 

(c) The dip of the sliding plane must be greater than its angle of friction. 

The program investigates all structures within the region. Then the above criteria 

are considered for each discontinuity. If these conditions are satisfied the steepest safe 

angle is determined from the following equation. "Otherwise the steepest safe angle is 

considered as 90 degrees for this discontinuity. 

6. = ArcTan 
Tanq)1 
Cosa/ 

where 

(4. I) 

9 is the steepest safe angle 

v is the dip of the sliding plane 

a is the difference between the dip direction of the sliding plane and 

the slope, 

4.3.1.2- Steepest safe angle with regard to wedge failure 

This failure can be considered as a variation of plane instability. It is likely to occur when 

the line of intersection of two discontinuities daylights into the slope face. To consider 

the kinematic analysis of wedge failure, the following two criterion are examined: 

(a) The line of intersection, of two planes must daylight in the slope face. This 

means that its plunge must be less than the angle of slope face which is 

measured in the direction of the line of intersection. 

(b) The plunge of the line of intersection of two planes must be greater than the 

angle of friction of the planes. 
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To determine the, steepest safe angle with regard to the wedge instability, the 

trend and plunge of the line of intersection of all pairs of discontinuities within the region 

are determined and the above criteria are considered if these conditions are satisfied the 

steepest safe angle is determined from equation 4.1 except that plunge and trend of the 

line of intersection is used instead of the dip and dip direction of the discontinuity 

respectively. Otherwise. the steepest safe angle is set to 90°. 

Trend and plunge of the line of intersection of two plane A and B when their dip 

and dip direction are known can be determined from the equations 4.2 and 4.3 

respectively. These equations are given by Hoek, Bray and Boyd (1973). 

a; =ArcTan 
TanrpA. CosaA -TanpB. CosaB 
TanrpB. SinaB - TanSpA. SinaA 

, 

ý, = ArcTän[TanrpA`: Co4aA - a, )] 

where 

aA 
aB 

97A 

is the trend of the line of intersection 

is the plunge of the line of intersection 

is the dip direction of plane A 

is the dip direction of plane B 

is the dip of plane A 

is the dip of plane B 

4.3.2- Design with the limit equilibrium method 

(4.2) 

(4.3) 

The steepest safe angle with kinematic analysis determines the slope angles with'regard 

to the structural instability without taking into account the non structural instability and 
groundwater conditions. This method can be used when little information is available. 
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For example during the feasibility study and preliminary design stages of a project when 

very detailed information is not available and an estimate of the safe angle is required to 

determine the pit outline and stripping ratio, the steepest safe angle method can be 'a 

useful approach. 

The limit equilibrium method is the most widely accepted and commonly 

preferred design tools in slope design. The first step of analysis is to detect potential 

failure mode and then determine the factor, of safety. Then a decision must be made 

whether the slope is stable or not. In the case of instability, the slope angle must be 

reduced or the slope height must be decreased to obtain the minimum acceptable factor 

of safety. 

In general after establishing boundaries for the design sectors or regions, the 

following steps are carried out for each region to determine the four principal slope 

angles as input parameters for use in the optimal pit design program. For each region, the 

analysis is carried out for the slopes with dip directions from 0° to ' 360° in 15° 

increments and for each direction depending on the input data the factor of safety or 

probability of failure is determined versus slope angles from 20° to 80 in 5° steps. If the 

input data are fixed values the factor of safety is calculated, otherwise the probability of 

failure is obtained. The outputs are put in a text file from which the four principal slope 

angles are determined with regard to the minimum acceptable of factor of safety or 

maximum acceptable of risk of failure. The steps are as follow: 

(a) Performing kinematic analysis to identify potential failure mode and critical 

discontinuities. 

(b) Analysing all the failure modes with the limit equilibrium method in terms of 

the calculation of the factor of safety ' if the input data are deterministic 

values or in terms of probability of failure if the input data are random 

variables. 
(c) Drawing the factor of safety or the probability of failure versus slope angle. 

145. 



<' 

Chapter 4: Slope design procedure 

(d) Determination of slope angles with regard to the minimum acceptable factor 

of safety or the maximum acceptable risk of failure. 

(e) Modifying slope angles to the four principal angles in the four principal 

directions to use as input in the optimal pit design program. 

Is 
Plane failure ? 

Is 
Wedge failure '? 

Call circular failure function 

Figure 4.3- Flow chart to determine potential failure mode 
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Figure 4.4- Flow chart to determine probability of failure 
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4.3.2.1- Identification of potential failure mode 

The first - step in slope stability analysis with the limit equilibrium method is to detect 

which type of failure is likely to occur. To do this, kinematic analysis is used to find the 

possible failure mode. By assuming a circular'excavation for each region, 'as can be seen 
from the flow charts illustrated in Figure 4'. 2'and 4.3 the program investigates the likely 

mode of failure for all the slopes of dip direction from 0° to 360° in 15° steps. When the 

type of failure is detected the corresponding program is used to calculate the factor of 

safety or probability of failure versus slope angles from P20° to 80° in 5° increments. 

Figure 4.4 shows the algorithm which was developed to determine the probability of 

failure versus slope angle for circular failure. '' 

The program is also capable of displaying the results of kinematic analysis 
graphically, for which some examples will be given later in this chapter. It should be 

noted that the kinematic analysis can identify only structural instability. In the case of 

non-detection of structural instability, circular failure is used to design the slope. To 

identify potential failure mode the mean dip and dip direction of discontinuities are used 

when the input data are specified as variable values. 

4.3.2.2- Calculation of factor of safety 

In order to design safe slope angles with the limit equilibrium method, this involves the 

determination of the factor of safety for each type of failure mode. The factor of safety is 

defined as the ratio of total-forces available to resist failure to the total forces tending to 

cause instability. The following gives a brief description of the required formulas used to 

calculate the factor of safety for each type of failure mode. To calculate the factor of 

safety the influence of any external forces due to bolts, cables or seismic acceleration are 

not taken into account, since it would only be necessary to consider these influences 

when the critical slopes are being considered. 
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4.3.2.2.1- Factor of safety for plane failure 

As mentioned before this type of failure is likely to occur when a geological discontinuity 

daylights in the slope face. Three types of plane-'failure are considered and for each a 
factor of safety is determined from the following equations. These are slopes without 
tension cracks under both dry' and wet conditions and slopes with' a critical tension crack 

under wet conditions (Figure 4.5). The factor of safety of plane failure for the general 

case of model III in Figure 4.5c, can be determined by the following equation given by 

Hoek and Bray (1981) in which the shear strength of the sliding surface is assumed to be 

defined by the Mohr-Coulomb criterion. The program also includes a kinematic check to 

test whether the plane failure is possible or not. This is needed in probabilistic analysis 

where the distribution of discontinuity orientation may result in some cases where the 

plane of weakness does not daylight into the slope face. This case is regarded as a factor 

of safety being greater than 1. 

Notation 

F Factor of safety 
C 

ý 

I e 
7 

rw 

a. 

Z 
Zw 

Hw 
A 

Cohesion 

Angle of friction 

Angle of failure plane 

Slope angle 

Rock density (unit weight) 
Water density (unit weight) 
Depth of water table 

Slope height 

Height of tension crack 
Height of water in tension crack 

Height of water table 

Surface area. of sliding block 
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a- Model I- Dry slope without tension crack 

b- Model II- Wet slope without tension crack 

c- Model III Wet slope with tension crack 

Figure 4.5- Types of plane failure 
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U- 

F= 

where 

W. Sina+V. Cosa 

Weight of sliding mass 

Uplift force due to water pressure on the sliding surface 
Horizontal force due to water pressure in the tension crack 

c. A+(W. Cosa - U- V. Sina). Tano 

A= (H- Z). 
Sina 

1 H-Z 
U=2Yw"Zwý 

Sina 

V=2yw. Zw 

(4.4) 

(4.5) 

(4.6) 

(4.7) 

1- 
. Cola-Coto (4.8) 

Model I- Slope without tension crack under dry conditions- This model as 

shown in Figure 4.5a is the simplest case in which the slope is assumed to be' dry and no 

tension crack to be formed. The factor of safety for this type can be obtained from the 

general case in which the uplift water force, horizontal water force and height of tension 

crack are zero. Thus: 

C. F, = 
c 

-+ 
Cota. Tano 

W. Sina 

where 

A=H. 
Sina 

W=2 y. H2. (Cota-CötB) ' 

(4.9) 

(4.10) 

(4.11) 
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Model II- Slope without tension crack under wet conditions- This model=is 

shown in Figure 4.5b and is the same as the previous model except that it is assumed that 

water is present along the failure surface. The factor of safety for this type can be 

obtained from the general case except that the value of V and Z are zero. Thus: 

F- c. A+ (W. Cosa - U). Tano 
W. Sin a 

(4.12) 

where 

U-5iyw Hw"Sinla (4.13) 

Model III- Slope with tension crack under wet conditions- This is the general 

case in which it is assumed that tension crack is formed at the rear of the slope and water 

presents both on the sliding surface and in the tension crack. The height of the tension 

crack is determined from the following equation given by Hoek and Bray (1981): 

Z=H. (1- CotB. Tana) (4.14) 

4.3.2.2.2- Factor of safety for wedge failure 

Wedge failure is likely to occur when, the line of intersection of two discontinuities 

daylights to the slope face and can not be directly approximated in two dimensions. This 

failure is rarely involved at large scale unless steeply dipping discontinuities are present in 

the slope. Various methods have been developed to deal with wedge failure such as the 

use of stereographical projection, utilising engineering graphics, design chart and 

analytical ' approach (Hoek and Bray, 1981). Disturbing and resisting forces involved in 

wedge failure are more complex than other failure modes. The method adopted here is 

based on the analytical method using vector analysis developed by Hoek, Bray and Boyd 

-(1973). This method calculates the factor of safety and assumed that sliding of the wedge 
is kinematically possible along the line of intersection of two planes which daylights on 
the slope face. This solution deals with wedge failure in terms of dip and dip direction of 
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the planes and slope face and involves the determination of the geometry of the wedge, 

area of the'potential sliding planes and the forces due to water pressure. 

Upper slope surface 

a- Geometry of wedge 

b- Assumed water pressure in wedge failure 

Figure 4.6- Geometry of the wedge and, assumed water 

pressure distribution used in the analysis 

Figure 4.6 shows the geometry of the wedge and also the numbering of the lines 

of intersection of the various planes involved in this problem together with the assumed 
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water pressure used in the analysis. The following gives the factor of safety for this 

failure which is derived from the analytical method develop by Hoek, Bray and Boyd 

(1973) on the assumption that the shear strength of the sliding surfaces is defined by the 

Mohr-Coulomb criterion. 

Input data: 

PA 

97B 

aB 

dip of plane A 

dip direction of plane A 

dip of plane B 

dip direction of plane B 

cg and c$ cohesive strength of planes A and B 

04 and Q$B angle of friction on planes A and B 

(Pf dip of slope face 

of dip' direction of slope face 

H height of wedge 

y rock density, (unit weight) 

yw water-density (unit weight) 
dw water table depth 

77 - W. Sinq)s 
cA. AA+ca. Ba+(g. W-UA). Tan0A+(x. W-Ua). TanOa 

Where" 

, UAandUa 

w 

q and x 

(4.15) 

are the uplift force due to the water pressure on planes A and B 

is the weight of the wedge 

is the plunge or dip of the line of intersection of planes A and B 

are the dimension-less factors which depend on the geometry of 

the wedge and can be determined from the equations 4.16-4.20 

mnanb, = Sin9A, SinýpB. Cos(aA - aB) +CosrpA. CosVB (4.16) 
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mw.,, a = -CosrpA 

mw. na = -CosPB 

mna. n6'mW. n6 - 
mW. 

na 
4 1=m a. 

n6- 

mna. nb'"'W. 
na -mw. nb 
2 1- rnna. 

nb 

In order to use equation 4.15 to find the factor of safety for wedge failure, it is 

necessary to calculate weight of the wedge and uplift forces acting on both planes A and 
B when groundwater exists in the slope. The weight of the wedge and the area of the 

sliding planes are determined from the following equations: 

AC=H. 
Sinýp1. Sin9js 

AA 

, 
AB 

-1 AC2 
Sin913. Sin93s 

- 2' Sin6,, s 

' A/ýZ SIn2613. SIn02S. S1nQ4S 

-- . 
11V . SIn18IS* Sin 024 

(4.17) 

(4.18) 

(4.19) 

(4.20) 

(4.21) 

(4.22) 

(4.23) 

- 3-COS28K= ICOS2e34 -COS28s gs + 2COS834. COS835. COSBgs (4.24) 

3 SinZB13. Sin2BZs 
W= 6 y. K. AC . Sin26, s. Sin2BZg 

(4.25) 

Where AA and Ag are the areas of the sliding planes A and B respectively. B,, " is the 

angle made by the line of intersection i with j (line 1-5 in Figure 4.6a). It can be 

determined from the equation 4.26 in which ar and q, ' are the trend and plunge of line i 

respectively. 

B, f = ArcCos[Cosp,. Cospi. Cos(a, -af)+Sinrp,. Sing)fJ- 
, 

(4.26) 

The trend and plunge . of the line of intersection of two planes can be found from 

equations 4.2 and 4.3 respectively. 

Sin 6S 
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The water pressure distribution is shown in the Figure 4.6b in which it is assumed 
that the wedge is impermeable and water in the slope will be transmitted along both 

discontinuities A and B. The forces due to water pressure are calculated assuming of a 
tetrahedral distribution of pressure in which it is assumed that the maximum pressure 

occurs along the line of intersection 5 and the pressure being zero along lines 1,2,3 and 
4. The uplift forces UA and UB are determined as: 

Hw =2 

ý' =Yw"Hw 

UA =I. P. Sg 

I 
UB = 3. P. SB 

(4.27) 

(4.28) 

(4.29) 

(4.30) 

Where SA and SB' are the area over which the water pressure acts. For the case- of 

a: saturated slope SA and SB are equal to the area of sliding-planes A and B and Hw is 

equal to the half of the wedge height. SA and SB can be determined form the-following 

equations: 

dH,. Sin615: SinBJ3 
t 1- 

AC. Sin2B35 

S,; = t. AA 
4=t. AB 

(4.31) 

(4.32) 

(4.33) 

The program also contains a kinematic check to examine whether wedge failure is 

possible or not. This test is necessary in the probabilistic approach where the distribution 

of joint orientations may "result in some cases where the ' line of intersection of two 

discontinuities does not daylight into the slope face. It is' considered in this case that the 

factor of safety is greater than 1. Two models of wedge failure including the slope under 

both dry and wet condition are considered in the program. 
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Model I- Slope without tension crack under dry conditions- In this model, it 

is assumed that the slope is dry and no tension crack is formed. The factor of safety for 

this type can be obtained from the equation 4.15 in which the uplift water forces UA and 
UB are zero. Thus: 

F= cA. AA+cB. Ba+g. W. TanoA+x. W. TanOa 
W. Sinrps 

(4.34) 

Model II- Slope without tension crack under wet conditions- In this model, it 

is assumed that water is present along the sliding surfaces. The factor of safety for this 

type can be obtained from the equation 4.15. 

4.3.2.2.3- Factor of safety for circular failure 

In the absence of structural instability and where the rock is very weak or heavily 

fractured, the failure is assumed to occur by sliding of a block of ground on a circular 

slip surface. A number of methods have been devised to assess this type of failure. 

Almost all of these techniques use the method of slices in which the mass above the 

failure surface is divided into a number of vertical slices and the factor of safety is 

determined by resolving forces acting on each slice and examining the overall moment of 

equilibrium. The method used for circular failure in which failure can occur through 

intact rocks or rock masses, corresponds to the Bishop simplified method (Bishop, 1955) 

as illustrated in Figure 4.7. As can be seen from Figure 4.7 the factor of safety, F,, 

appears on both sides of the equation, therefore it requires iterative analysis. The trial 

and error approach is used to calculate the factor of safety which involves assuming F on 

the right side of the' equation, then solving for F on the left. If the difference between the 

assumed F and the computed F is significant, the computed F is used on the right side 

and the procedure repeated until a satisfactory F is determined. The ordinary method of 

slices (Fellenius, 1936) is used to estimate an initial value, ofF (equation 4.35). The rock 

mass above the failure surface is divided into between 5 and 20 slices. 
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Tension crack 

Water table 

1ýc. b, +(W, -U,. b, ). Taný, 
F= 

" Tana,. Tan0 
I: W,. Sina, +Q '`'(]+ ---- F-). Cosa, 

Where 
bý 

ý 

i=/ 

W, =Y. h 

Y= 2"Y,. "Z2 

Q-Y. 
R 

U, ° Y,. "h. 

n is the total number of slices 

c and 0 are the cohesion and friction angle of material 

rand y�, are the rock and water density 

Figure 4.7- Bishop's simplified method of slices for circular failure 

(After Hock and Bray, 1981) 
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a- Model I- Dry slope without tension crack 

b- Model II- Wet slope without tension crack 

c- Model III Wet slope with tension crack 

Figure 4.8- Types of circular failure 
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±[c. 
4 + (W,. Cosa, - U, . 

Z). Tan ýiý 
Ff=1 =- 

W. Sina; +Q 
i=l'- 

(4.35) 

Three models are used in the analysis. As can be seen from the Figure 4.8 these 

include the dry slope without tension crack, wet slope without tension crack and wet 

slope with tension crack. In all these models, it is assumed that the failure surface is 

occurring through the toe of the slope: This is a valid assumption since failure is likely to 

occur under the toe of the slope if the angle 'of friction becomes less than 5°. Such a 

condition is unlikely to occur in mining slopes (Hoek and Bray, 1981). 

Model I- Slope without tension crack under dry conditions- This model as 

shown in Figure 4.8a is the simplest case in which the slope is assumed to be dry and no 

tension'crack is formed. The factor of safety for this type can be obtained from the 

general case by substituting zero instead of Q and U. 

F_ 
"1Znc. 

b, +W,. Tan0 (4.36) 
Tana Taný ýW,. Sina, ''' 

(1 
+ F, 

). 
Cosa, 

i=1 

Model II- Slope without tension crack under wet conditions- This model as 

shown in Figure 4.8b is the same as the previous model in which the effect of ground 

water is taken into account. The factor of safety for this type can be obtained from the 

general case except that the value of Q is zero. 

Model 
. 
III- Slope with tension crack under wet conditions- This is the general 

case 'as shown in Figure 4.8c in which it is -assumed the tension crack is formed to the 

rear of the crest of the slope and is filled with water below the ground water table. The 

height of the tension crack is determined by the following formula: 

160 



Chapter 4: Slope design procedure 

hý = 2. c. Tan 45 + 
Y 

2) 

Where h, is the critical depth of the tension crack. 

(4.37) 

The location of the most critical slip surface usually can be found through a 

rigorous search by a variation of the centre of rotation. For this purpose, the factor of 

safety is calculated for several points and contours of F value are drawn. These contours 

are roughly elliptical so that their centre indicates where the centre of the critical circle 

will be located. In this study a systematic search is used to find the location of the critical 

circle. 

Figure 4.9- Procedure to rind the location of the critical circle 
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In order to find rapidly the location of the most critical circle, as illustrated in 

Figure 4.9, the area over which the centre of rotation is likely to be found is divided into 

the 4*4 grid and the factor of safety is determined for each grid point. The distance 

between each point of the grid is d units. Then, among these 25 F values, the point 

containing the minimum factor of safety is selected. Let us assume that point 0 in Figure 

4.9 is the centre of the circle which has the minimum factor of safety. Next, the four 

squares around this point (square ABCD) is divided into the 4*4 grid for which the 

factor of safety is calculated for each point (Figure 4.10). The distance between each 

point of this grid is d/2 units. Again the point containing the minimum factor of safety is 

chosen, let suppose point 0' in Figure 4.10. The method is applied to square A'B'C'D' 

and this process is continued until the distance between points in the grid become a 

satisfactory value. After a few trials the location of the most critical circle is obtained. 

Figure 4.10- Procedure to find the location of the critical circle 

Both failure criteria including the Mohr-Coulomb and Hoek-Brown criterion are 

used to analyse circular failure. If the first criterion is used only the cohesion and friction 
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angle of the material is required., If . the Hoek-Brown criterion is used the material 

constant of intact rock, the geological strength index. and uniaxial compressive strength 

of intact rock are required. In the case of using the Hoek-Brown=criterion, the program 

finds the equivalent values of the Mohr-Coulomb criterion, the friction angle (q) and the 

cohesive strength (c) from the tangent to the envelope to the principal stress defined by 

the Hoek-Brown failure criterion (Hoek, Kaiser, and Bawden, 1995). - 

4.3.3- Probabilistic approach 

Some parameters such as cohesion, friction angle and orientation of discontinuities 

within the rock mass are subject to variation and do not have a single value, but may 

assume any number of values. These variables are known as random variables. 

Conventional deterministic methods of limit equilibrium use fixed values to calculate the 

factor of safety. This approach does not take account of the uncertainty associated with 

the parameters used in the calculation. Since the input data used to design the slope angle 

are subject to variation, it is necessary to take account of these uncertainties in the design 

by using a probabilistic approach. The Monte Carlo simulation is adopted to determine 

the probability of failure, pf, which can be defined as the probability of the factor of 

safety being less than one. 

pf =P(F<1) (4.38) 

To carry out this analysis, when the potential failure mode is determined for the 

slopes with dip directions from 0° to 360° in 15° steps, for each failure mode the 

probability of failure is determined versus slope angles from 20° to 80° in 5° increments. 

Values are selected at random from the predefined probability distribution of the input 

data and used to calculate the factor of safety. This process is repeated a number of times 

and the probability of failure is' calculated as: 

number of factors of safety being less than 1 
pf total number used in simulation 

(4.39) 
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Figure 4.4 shows the flow chart for calculation of the probability of failure versus 

slope angles for circular failure in which it is assumed that the shear strength is 

determined by the use of the Mohr-Coulomb criterion. The probability of failure is 

determined from a direct count. This method has been adopted as in some cases when 

analysing wedge failure where the factor of safety obtained has no physical significance. 

This is the case when values are sampled for which sliding is kinematically impossible. 

This case is regarded as having a factor of safety greater than one and is theoretically 

stable. 

4.3.3.1- Random number generators 

The simulation involved the selection of variables from probability distribution functions 

of input parameters at random. For this purpose a random number, r, generated in the 

range (0,1) and then from the cumulative probability distribution, F(x), variable x is 

selected by the inverse transformation such that r'= F(x) as illustrated in Figure 4.11. 

F(X) 

1T- 

r= F(x) 

0 
x= F'' (r) 

X 

Figure 4.11- To sample a value from the cumulative 

probability distribution 

The most common way to generate a random number is by using the following 

equation: 

R� _ (a. R, -, -{ -c) mod m (4.40) 
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Where 

R, a and c >-= 0 

m>Ro m>a m>c 

This means that the value of a. 'R,, 
_J 

+c is divided by m and the remainder is taken 

as the value of Rn 
. 

The initial value of R is called the seed, Ra 
, and a, c and m are 

integer and constant values. The value of m should be chosen to be a large prime number 

that can be fitted to the computer word size to generate it large sequence of random 

numbers. 

Equation 4.40 generates a sequence of integer numbers in the range 0 to m-1 and 

the quantity of 
R/ 

which is in the range of (0,1) is taken to sample from the 

probability distribution function. This equation with the value of Ro = 1000 * seed, 

a= 125, c=0 and m= 2796203 is used to generate random numbers in which it is 

assumed that the seed value is given by the user. 

4.3.3.2- Probability distribution 

The program uses the five most common probability ' distributions to define random 

variables. These are: normal, uniform, triangle, lognormal, reverse lognormal 

distributions. The following describes the types of probability functions and their inverse 

transformation functions. 

The normal distribution- The normal or Gaussian distribution is one of the most 

commonly used probability distributions in engineering applications (Figure 4.12). Many 

random variables conform to this distribution. It can be defined by its mean and standard 

deviation. The probability density function for the normal distribution with a mean, p, 

and standard deviation, a, is given by: 

1- 
x-µ 7 

f(x) e ýý' for -oo5 x :! g oo", 
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f(X) 

Figure 4.12- A normal distribution 

and its cumulative distribution function is: 

x 
F(x) =fe , C, 2 dt 

_ýa 
27t 

(4.42) 

Equation 4.42 can not be integrated but it can be found by numerical methods. In 

the Monte Carlo simulation, which involves the inverse transförmation, the problem is to 
find the value of variable x for the random number r, such that: 

x- t-µ Z 

e aa' dt r= F(x) = 
jcrý27C 

(4.43) 

This can be found from the following equations (Schmidt and Taylor, 1970): 

ifr: 0.5 

v-2 n(r) (4.44) 

1 2.515517 + 0.802853v + 0.010328v2 
x=m-a v-1+1.432788v+0.189269v2 

+0.001308v3 
(4.45) ' 
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if r. >0.5 

v=2 ln(1- r) (4.46) 

2.515517 + 0.802853v + 0.010328v2 
x= m+ Q v-1 + 1.432788v + 0.189269v2 + 0.001308vj 

(4.47) 

The uniform distribution- This distribution describes a random variable which 

can take any value between a specified minimum and maximum value with equal 

probability. The distribution function of this type (Figure 4.13) by the minimum and 

maximum a and b is: 

f(X) 

ab 
X * 

Figure 4.13- A uniform distribution 

11 
f(x)= b=a 

0 

a<x<b 

otherwise 

the mean, , u, and standard deviation, o, of this distribution are: 

b+a 
2 
(b - a)2 
7'12 

(4.48) 

(4.49) 
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The inverse, transformation for the uniform distribution can be obtained as: 

r=F(x)= b1adt 
A 

ýx=a+ r(b - a) (4.50) 

The triangular distribution- This distribution is illustrated 'in Figure 4.14 and 

requires three parameters to be defined. These are: lower bound (a), upper bound (b) 

and most likely value (c). Its probability density function can be defined as: 

f(X) 

C h 

Figure 4.14- A triangular distribution 

rx-al 

f (x) 
b-aý, c-aJ 

2 
al T-c) 

aSx5c 

c<x<_b 

and its mean, ; u, and standard deviation, v, are: 

µ=I (a+b, +c) 

a= 18(a2+b2+c2- -ac-bcý 

(4.51) 

(4.52) 
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The inverse transformation for the triangle distribution . can be obtained from the 
following equation:, 

,_., . c-a +Vr(b-a)(c-a) 0 Sr<_ h-n 
(4.53) 

-V(1-r)(b-a)(b-c) b-a 5r<_1 

The lognormal distribution- A lognormal distribution (Figure 4.15) is one for 

which the logarithm of the variable is normally distributed. This distribution which is 

positively skewed can be defined by its mean and standard deviation. Sampling from a 
lognormal distribution with the mean, , u, and standard deviation, 6, is the logarithm of a 

corresponding sample from a normal distribution N(m, s) whose parameters are related 
by the following equation: 

m+ls2 

, u. -e 2 

,. 
62 = , u2 

(eS2 

-1) 

f(x) 

Figure 4.15- A lognormal distribution 

(4.54) 

The-reverse lognormal distribution- This distribution as illustrated in Figure 

4.16 is negatively skewed and it can be converted to a, lognormal distribution. by 
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subtracting variables from a large number. Sampling from this distribution is carried out 
in the same way as for the lognormal distribution. 

f(X) 

Figure 4.16- A reverse lognormal distribution 

4.3.4- Factor of safety or probability of failure versus slope angle 

Depending on the input data,, the program calculates the factor of safety . or the 

probability of failure versus slope angles from 201 to 80° in 5° steps using the procedures 

mentioned before for the slope, of dip direction from 0°.. to 
. 
360°, in '15° increments and 

puts the result in a text file. A, program also, has been developed to provide a graphical 

display of the factor of safety or the probability of failure versus slope angle for each 

region and for all directions from which slope angles can' be obtained by specifying a 

minimum value for the factor of safety or maximum 'acceptable of risk of failure. Some 

examples of the graphical display for the factor of safety or the probability of failure 

versus slope angle will be given later in this chapter. 

4.3.5-'Determination of slope angles 

Once the fäctbr of safety or the probability'öf failure have been determined versus slope 

angle; -a decision must be made to select the slope angles for each direction. For this 

purpose, depending on the method applied to design slopes, a minimum value for the 
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factor of safety or maximum acceptable risk of failure is required. Hoek and Bray (1981) 

pointed out that a factor of safety of 1.3, is the minimum acceptable value for a 

temporary slope in open pit mines, while for a permanent slope such as those carrying 

the haul road, the factor of safety value should exceed 1.5. In the case of using the 

deterministic limit equilibrium method, the minimum factor of safety of 1.5 should be 

used. When probabilistic methods are used . 
to design slopes, Table 2.1 in chapter 2 and 

Table 4.1, which was suggested by McCracken. (1983) can be used as guidelines to 

choose the maximum acceptable risk of failure. 

Operation Stand-up time Probability of failure (%) 

Permanent civil works Very long < 0.5 

civil works Long 0.5-1.5 

Small open pit / quarry final slopes Medium long 1.5 -5 

Large open pit final slopes Medium 5-15 

Small open pit / quarry final slopes Medium 5-15 

Large open pit final slopes Short 15 -30 

Temporary benches Very Short 30 - 50 

Table 4.1- Maximum acceptable risk of failure for use in mining 

and civil works (McCracken, 1983) 

When the minimum acceptable value fore the factor of 'safety or maximum 

acceptable value for the risk of failure and type of slopes have been specified, the 

program determines the slope angles for all directions by using linear interpolation as 

illustrated in Figure 4.17. Therefore för each direction one slope angle is obtained. These 

slopes must be smoothed and four principal slopes must be determined for use in the 

optimal-pit design program. 
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Figure 4.17- To determine slope angles by specifying the minimum acceptable 

factor of safety or maximum acceptable risk of failure 
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4.3.6- Modification of slope angles to four principal angles 

When the slope angles with dip directions of 0°, 15°, 30°, 
... and 345° are determined 

for each region either by kinematic analysis or by the limit equilibrium method , the next 

step is to modify them to four principal slope angles for the use in the optimal pit design 

program. Consider Figure 4.18 which shows a plan of how the crest of a pit with a 

circular floor would appear. Is this acceptable or is modification of the slope required? It 

is obvious that these slopes have to be modified for use in the optimal pit algorithm. 

Figure 4.18- An example of a circular floored excavation 

173 



Chapter 4: Slope design procedure 

One possible way is to select the minimum slope and use it for all directions in 

order to ensure stability. As an example, for the case shown in Figure 4.18, it is possible 

to use a 35° slope for all directions. It is obvious that this solution increases the stripping 

ratio, in other words, it increases the amount of waste to be removed. The other 

alternative is to use an elliptical excavation. For this purpose, the excavation is divided 

into four different quadrants each of which contains six slope angles. Each quadrant is 

considered separately and two alternatives are examined. In the first alternative the 

minimum slope angle is chosen for all directions in the quadrant as illustrated in Figure 

4.19a for which the 35° slope is used. In the second alternative, an elliptical excavation is 

assumed for each quadrant and the value of the two semi-major and semi-minor axes are 

found by simple geometry from which two principal slopes are determined. 

Figure 4.19- To modify slope angles in the first quadrant 

To find slopes for the second alternative, the first two minimum slope angles are 

selected as illustrated in Figure 4.19b. Then by using the ellipse formula passing through 

the co-ordinates of these slopes for any assumed slope height, two of the four principal 

slopes are obtained. Consider the first quadrant shown in Figure 4.19b, the co-ordinates 
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of the two points corresponding to the least slopes can be calculated from the following 

equations: 

d= h 
Tan(a) 

x=d. Sin(B) 

y=d. Cos(B) 

where 

h is the slope height 

x and y are the co-ordinates 

0- is the dip direction 

(4.55) 

If it is assumed that the co-ordinates of the two mentioned points are x,, y, and x2, y2, by 

using the ellipse formula we have: 

Ax +By2 =1 
Az2+By2 =1. 

where 

1 
a 

b= 1 

a and b are the semi-major and semi-minor axes respectively 

By solving the above equation A and B can be obtained as: 

vz Z -. v 
777 xiyi - xzY, 

22 
, xý - x, 
2222 x2. y1 '' xl. y2 

(4.56) 

(4.57) 

(4.58) 
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Figure 4.20- To modify slope angles to the four principal slopes 

Then the two principal slopes for the first quadrant are: 

dip]= ArcTa4d. %IB--) 

dip2 = ArcTan(d. V-A) 
(4.59) 

Between these two alternatives the one with least area is selected which decreases 

the stripping ratio. The above procedure is carried out for all the quadrants. 

Consequently, two slope angles are obtained for each principal direction from which the 

lower one is selected as the principal slope. Figure 4.20 shows the result of modification 

of the slopes for the example illustrated in Figure 4.18. 

4.4- Data required 

The required input data depends on the method applied to design slopes. If the steepest 

safe angle is used, only the orientation and properties of the major discontinuities within 

each region or domain sector including dip, dip direction and angle of friction are 
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required. In the case of using the limit equilibrium method either- deterministic or 

probabilistic, for each region the orientation and properties of major discontinuities (dip, 

dip direction, cohesion and friction angle), rock mass properties including either cohesion 

and friction angle or geological strength index, uniaxial compressive strength and 

material constant of intact rock, rock mass density and water table depth are required. 

All these values can be specified in terms of either fixed value or as a random variable 

with corresponding density function. 

One of. the most important variables in slope design is the slope height. This is 

calculated by the program and is set , to the maximum depth of the region or the 

maximum depth of the pit in that region. If the optimum pit outline has already been 

determined the maximum depth of the pit is selected, otherwise the maximum depth of 

the region is used. When the optimum pit outline ' is obtained, the program shows the 

maximum depth of the pit in each region together with the slope height used in the 

calculation. If the difference between these is significant, the user can change the slope 

height and design slopes until it becomes a satisfactory value. 

4.5- Example 1 

In order, to show how the algorithm works, two examples are examined. The first 

example is- applied to the example of variable slope angles introduced in section 3.5.1.1 

(chapter 3) in which it is assumed that only one region is specified to define the mining 

slopes. It is also assumed that there are three major discontinuity sets in the region. The 

-geotechnical information required for the design of slopes is given in Table 4.2. Both 

methods are used to determine four principal slopes for this example. Figure 4.21. shows 

the result of kinematic analysis which indicates that -the_ mode of failures for different 

directions includes circular, failure and plane failure along joint sets 1,2 and 3. 'Also the 

results of the limit equilibrium method in terms of calculation of the probability of failure 

versus slope angle are illustrated in Figure 4.22,4.23,4.24 and 4.25 for the slopes with 

dip directions of 00 to 360° in 15° steps under dry conditions and saturated slopes with 
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Chapter 4: Slope design procedure 

and without a tension crack. Slope angles can be found from these graphs with regard to 

the maximum acceptable value for the probability of failure. Table 4.3 shows the four 

principal 'slopes obtained by the steepest safe angle method together with the limit 

equilibrium approach for which the maximum of 10% probability of failure or 90% 

reliability is used to select slope angles. 

The four principal slope angles obtained by the probabilistic method under dry 

slope conditions is used to determine the optimum pit outline which is illustrated in 

Figure 4.26. After determination of this, the program shows the maximum depth of the 

pit in the region which is the same as the slope height used in the calculation. Therefore it 

is not necessary to design the slopes again. 

Probability 

distribution 

Mean Standard 

deviation 

Lower 

bound 

Upper 

bound 

Dip (degree) Normal 27 1.5 - - 
Joint set 1 Dip direction (degree) Normal 80 2.5 - - 

Cohesion (kPa) Normal 75 2.4 - - 
Friction angle (degree) Normal 23 1.2 - - 
Dip (degree) Normal 32 2.0 - - 

Joint set 2 Dip direction (degree) Normal 165 4.0 - - 
Cohesion (kPa) Normal 87 2.7 - - 
Friction angle (degree) Normal 25 1.5 - - 
Dip (degree) Normal 31 3.0 - - 

Joint set 3 Dip direction (degree) Normal 296 2.8 - - 
Cohesion (kPa) Normal 72 3.5 - - 
Friction angle (degree) Normal 22 1.0 - - 
Density (t/cubic m) Normal 2.7 0.5 - - 
Geological index, GSI Normal 30 3.2 - - 

Rock mass Compressive strength (MPa) Normal 32 4.1 

Material constant, mi Normal 9 2.5 - - 
Water table depth (m) Uniform - - 0 20 

Table 4.2- The geotechnical information for example 1 
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Chapter 4: Slope design procedure 

Principal'slope Steepest' Limit equilibrium 

angles safe angle Dryslope Wet slope with tension crack Wet slope without tension crack 

North face angle 27° 41°- 23° 390 

East face angle 27° 490 -23° 47° 

South face angle 32° 49° 27° 450 

West face angle 31° 41° 25° 39° 

Table 4.3- The four principal slope angles for example 1 

4.6- Example 2 

The second example is applied to the example of multiple variable slope angles 

introduced in section 3.5.2.1 (chapter 3) in which the deposit is divided into. four domain 

sectors or regions as illustrated in Figure 3.36. It is assumed that region 1,2 and 3 

contain 2,1 and 3 set of discontinuities respectively. Region 4 does not have any through 

going discontinuities and it is assumed that the slopes, are . 
determined by use of circular 

failure analysis. The geotechnical information for each region is given in tables 4.4 to 4.7. 

Again the results of kinematic analysis and some-of the output from the program for the 

probability of failure ' or factor of safety versus slope angle are illustrated in Figures 4.27 

to 4.31. The four principal slope angles obtained for the minimum factor of safety 1.5 

and maximum probability of failure 10% are given in Table 4.8. 

Again the four principal slope angles obtained by the program under dry 

conditions are used to determine the optimum pit outline which is illustrated in Figure 

4.32. After, determining, this, the program shows the maximum depth of the pit in each 

region which is the same as the slope height used in the calculation for that region. 

Therefore it is not'necessary to design the slopes again. 

185 



Chapter 4: Slope design procedure 

Probability 

distribution 

Mean Standard 

deviation 

Lower 

bound 

Upper 

bound 

Dip (degree) Normal 35 
Joint set 1 Dip direction (degree) Normal 302 - - - 

Cohesion (kPa) Normal 108 - - -" 

Friction angle (degree) Normal 20 - - - 

Dip (degree) Normal 29 " - -" -" 
Joint set 2 Dip direction (degree) Normal 90 - - - 

Cohesion (kPa) Normal 108 ° - - - 

Friction angle (degree) Normal " 20' - - - 

Density (t/cubic m) Normal 2.6 - - - 
Rock mass Cohesion (kPa) Normal 180 6.5 " - - 

Friction angle ̀ (degree) Normal 30 3.2 -" -' 

Water table depth (m) Normal 20 - - - 

Table 4.4-', The"geotechnical information for'example 2- region 1 

Probability 

distribution 

Mean Standard 

deviation 

Lower 

bound 

Upper 

bound 

Dip (degree) Normal 27 2.6 - - 
Joint set 1 Dip direction (degree) Normal 35 3.4 - - 

Cohesion (kPa) Normal 95 4.5. 

Friction angle (degree) Normal 18 1.5, 

Density (t/cubic m) Normal 2.7 - - 
Rock mass Cohesion (kPa) Normal ' 180 - - 

Friction angle (degree) Normal 35 - - - 

Water table depth (m) ' Normal 20' - - - 

Table 4.5- The geotechnical information for example 2- region 2 
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Chapter 4: Slope design procedure 

Probability 

distribution 

Mean Standard 

deviation 

Lower 

bound 

Upper 

bound 

Dip (degree) Normal 34 - - - 

Joint set 1 Dip direction (degree) Normal 60 - - - 
Cohesion (kPa) Normale 78 - - - 

Friction angle (degree) Normal 25 - - - 

Dip (degree) Normal 50 - - - 

Joint set 2 Dip direction (degree) Normal 130 - - - 

Cohesion (kPa) Normal 78 - - - 
Friction angle (degree) Normal 25 - - - 

Dip (degree) Normal 47 - - - 

Joint set 3 Dip direction (degree) Normal 250 - - - 

Cohesion (kPa) Normal 78 - - - 

Friction angle (degree) Normal 25 - - - 

Density (t/cubic m) Normal 2.9 - - - 

Rock mass Cohesion (kPa) Normal 210 - - - 

Friction angle (degree) Normal 33 - - - 

Water table depth (m) Normal 20 - - - 

Table 4.6- The geotechnical information for example 2- region 3 

Probability 

distribution 

Mean Standard 

deviation 

Lower 

bound 

Upper 

bound 

Density (t/cubic m) Normal 2.8 0.7 - - 

Rock mass Cohesion (kPa) Normal 182 6.2 - - 
Friction angle (degree) Normal 35 3.5 - - 

Water table depth (m) Normal 20 - - - 

Table 4.7- The geotechnical. information for example 2 region 4 
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Chapter 4: Slope design'procedure 

Region Principal slope Limit equilibrium 

angles Dry slope Wet slope with tension crack Wet slope without tension crack 

North face angle 36° 32° 35° 

1 East face angle 36° 32° 35° 

South face angle 36° 32° 3511 

West face angle 400 36° 390 

North face angle 41° 31° 35° 

2 East face angle 41° 31° 350 

South face angle 46° 35° 35° 

West face angle 46° 35° 35° 

North face angle 39° 350 350 

3 East face angle 390 38° 38° 

South face angle 55° 44° 440 

West face angle 450 359- .. 35°, 

North face angle 58° 46° 46°, , 

4, East face angle 58° 46° 46° 

South face angle 580 46° 46° 

West face angle 58° 46° 46° 

Table 4.8- The four principal slope angles for example 2 

4.7- Conclusion 

The optimal pit design program with variable slope angles requires an estimate of the 

safe slope angles to determine the optimum pit outline. Two methods, the steepest safe 

angle and the limit equilibrium method in terms of the calculation of either the factor of 

safety or the probability of failure were incorporated into the optimal pit design software 
to determine the slope angles. To perform both methods, first the orebody must be 

divided into domain sectors or regions based on the results of the field investigation each 

of which is considered separately. The first approach determines the steepest safe angle 
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Chapter 4: Slope design procedure 

with regard to structural instability including plane and wedge failures without taking 

into account cohesion, density, ground water conditions and non structural failure. This 

approach can be used when only 'a little. information is available during design such as at 

the feasibility stage. If enough information is available the second approach can be used. 

The program calculates the factor of safety or the probability of failure depending on the 

input data. If they are defined as fixed values the factor of safety is calculated otherwise 

the probability of failure is determined. The probabilistic approach has the advantage 

over the deterministic method as it takes into account the uncertainty inherent in the 

input data. Both approaches require engineering judgment to select the slope angles from 

the graph provided by the program. As demonstrated by the two examples with 

corresponding outputs, the program works well and is able to generate true optimum 

ultimate-pit limits with variable slopes. 

It should be noted that the program'analyses potential failure modes which can be 

determined kinematically: If the geology is complex such that the potential failure modes 

may involve a combination of several mechanisms and when the geometry'of the slopes 

are well known, slope'angles must be determined by other sophisticated method such as 

numerical modelling. '- This is considered to be an area for further study. 
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CHAPTER 5 

The Software 

5.1- Introduction 

All the methods described in the previous chapters -, the algorithm for optimal open pit 

design with variable slope angles, the procedure for creating an orebody revenue block 

model, pit bottom smoothing and the method of designing four principal slope angles - 
have been coded into an interactive Windows software package "PITWIN32". This can 

be, 
-implemented under a 32-bit Windows operating system such as Windows 95, 

Windows NT or Windows 98. The software was written entirely in C++ code using 

Borland Object Window Library (OWL) which consists of a number of classes for use in 

Windows programming. The software, has been tested on trial data and real, data sets. 

This, chapter describes the structure and operation of the software. There is also a brief 

description of the programs for numerical and graphical displays of the input data and the 

results of optimisation. 

5.2- System requirements 

The software is a 32-bit Windows program that requires the following minimum 

configuration for implementation: 

An IBM compatible personal computer with an 80486, or higher, processor 

(Pentium is recommend). __, 
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16 megabytes of random access memory (32 megabytes is recommend for a 
deposit with a large number of blocks). 

A hard disk with sufficient free space. 

SVGA, or compatible, colour display. 

A Microsoft Mouse or other compatible pointing device. 

0 Microsoft Windows 95, Windows NT or Windows 98 operating system. 

5.3- Structure of the software 

The software is written entirely in C++ using the Borland Object Window Library 

(OWL) that consists of a group of classes used to represent the Windows structure. It is 

a 32-bit Windows application and comprises the following programs for each of which a 
brief description is given below: 

5.3.1- Program PITWIN32. CPP 

This is the main program and it contains two main classes: a class to manage the window 

and a class to manage the application. The second class provides both graphical and 

numerical presentations from which other programs can be executed. This class also 

contains the two following functions for determination of the optimum pit limit. 

5.3.1.1- Function variable _ pit 

This function finds the optimum open pit using the Lerchs-Grossmann algorithm with 

variable slope angles when the definition of mining slopes is limited to one domain sector 

or region. 

5.3.1.2- Function multiple' pit 

This function determines the optimum open pit using-the Lerchs-Grossmann algorithm 
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Chapter 5: The software 

with multiple variable slope angles when mining slopes are defined for more than one 
domain sector or region. 

Both functions use block and revenue files created by the revenue programs as 
input and allocate space required for storage of the block model and working matrices. 
They both then determine the optimum pit and store the results in two files for further 

use. 

5.3.2--Program PITWIN32. RC 

This is a resource script file used by the main program to construct the program's menu, 
dialogue boxes and related functions. 

5.3.3- Program PITWIN32. R4 

This is a resource header file that contains command constants for the' menu items 

together with various controls such as edit and list boxes of the dialogue boxes. 

5.3.4- Program PITWIN32. DEF 

This is the module definition file that specifies various attributes of the executable 

program-running under the Windows operating system such as the program's heap and 
stack size. 

5.3.5- Program PITCLASS. CPP 

This program includes a number of classes designed to construct various dialogue boxes 

for data entry and user interaction. 

5.3.6- Program PITCLASS. H 

This is the main header file that contains function 'prototypes and the declaration of 
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Chapter 5: The software 

constants, data types and classes used to construct dialogue boxes. 

5.3.7- Program PITTOOL. CPP 

This program contains a number of functions, each of which performs a specific task. 

These functions are, called from other programs and include the conversion of random 

access files to text files, provision of summaries of the orebody, grade block model, or 

revenue block model and changing the direction of the vertical co-ordinates in the 

orebody, grade model.. 

5.3.8- Program PITSLOPE. CPP 

This program contains a number of functions used in the, calculation of the four principal 

slope angles. These functions include determination of potential failure mode, random 

sampling from a probability distribution, determination of the safety factor or the 

probability, of failure versus slope angles and calculation of the four principal slope 

angles. 

5.3.9- Program PITFUNCT. CPP. 

This program includes the following functions for creating an orebody revenue block 

model and for smoothing of the pit bottom for both variable and multiple slope angles. 

5.3.9.1- Function variable revenue 

This function creates a revenue block model from a -block grade model 'of a, deposit by 

applying costs, prices and slope angles when slopes are defined for a single domain 

sector or region. 

5.3.9.2- Function multiple revenue 

This function creates a revenue block model from a block grade model of the deposit by 
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applying costs, prices, and multiple-domain variable slope angles. The program also 

assigns slope angles to the blocks using the angle sum method described in Chapter 3. 

Both functions, variable_ revenue and multiple_ revenue use two text files as 
input and create a revenue block model, in the form of three files, as Output. The input 

data comprise a block grade file (previously created by means external to the software) 

and a file containing the physical and economic factors and pit slopes. The latter file can 

either be created by the software or supplied from an external source. The output files 

comprise one text file containing the block model characteristics (block dimensions, 

number of blocks in the model and four principal slope angles if a single region is used), 

a random access revenue model file and a random access grade block file: The random 

access files contain one record for each block. The revenue block model file is used in 

the optimal pit design program and the block grade file is used to determine the mean 

grade of the blocks within the optimal pit. 

5.3.9.3- Function variable _ 
pitbot 

This function smoothes the bottom of an economically optimum open pit with variable 

slope angles. It is assumed that the minimum space required for mining equipment to 

operate freely is given by the user. 

5.3.9.4- Function multiple_pitbot 

This function performs pit bottom smoothing on an economically optimum pit for the 

case in which slopes are specified for more than one domain sector or region. It is 

assumed that the user gives the'required minimum space. 

Both smoothing functions use as input the revenue'block model file and the pit 

generated by the optimum pit programs. Both functions generate two output files for 

further use. 
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5.4- An overview of the program 

The program is initiated by double clicking the icon in Windows Program Manager. As 

shown in Figure 5.1, the program comprises the following components: 

" The frame window with the title, menu, minimise and maximise icons. The 

system menu contains numerous commands, each of which performs a specific 

task. 

" The client area used to display dialogue boxes, error messages and graphical 

and numerical outputs. 

" The status line, located at the bottom of the program window, displays a brief 

explanation of the various commands in the menus. 
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Figure 5.1- The components of the software 
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In addition to the main components of the Windows program it is useful to define 

the following key terms used in Windows programming. 

Dialogue box- Dialogue boxes are special pop-up windows that contain controls 

such as radio buttons, edit boxes and list boxes serving either to display or to input data. 

Windows applications usually use a dialogue box to exchange information with the user. 

Radio button- A radio button control is a circular button with a title that is 

usually used to select an option from two or more options. When a radio button is 

selected a tiny, filled circle appears inside the circular button. 

Edit box- An edit control box is an editing tool in the'dialogue box that can be 

used to enter and edit information. 

List box- List box controls are input tools in a dialogue box and display a list of 

items. The user can browse the list and choose one or more items. 

Scroll bar- Scroll bars are visual components of a window that assist in scrolling 

through the window's contents. - A' window can have a vertical scroll bar, a horizontal 

scroll bar or both. A scroll bar has an arrow box at each end and a scroll thumb. The 

arrow boxes are used to scroll the window's contents to either end or to either side. 

All menus are accessed using a mouse or by pressing the <Alt> key plus the 

underlined letter. Commands from the menu are activated either by pressing the 

underlined letter 'or by using the mouse or the cursor keys to select from the menu. The 

main menu is displayed, in Figure 5.1 and shows the available options which can be used 

to activate operations. These options are File, Slope, Run, Graphical Display, Numerical 

Display, Tools and Help. A brief summary of the menus and the commands in each menu 
is given below. 
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Figure 5.2- The File menu 

5.4.1- The File Menu 

The File menu, shown in Figure 5.2, contains commands to create, load, edit and close 

the control file which contains information required to create a revenue block model and 

to determine the optimum pit. This menu also includes commands to select and set up a 

printer and to generate hard copy of the numerical or graphical presentation displayed in 

the client area of the program. Table 5.1 summarises the available commands in this 

menu. 

5.4.1.1- The New command 

The first step of the optimum open pit design is to create or load a file called the control 

file that contains information required for the design of the optimum pit. This information 

includes the name of the mine, grade file name, block dimensions, specific gravity of the 

ore and waste, cut-off grade, costs of mining ore and waste, the processing cost, 
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recovery factor, mineral/metal price and pit slopes. The New command can be used to 

enter these data and store them in a text file for further use. The default extension of the 

control file is " CFL". It is, however, also possible to use a 'different extension. ' This 

command invokes different dialogue boxes for entering information and storing it in a 
file. When a control file is successfully created, the name of the mine is added to the title 
bar. 

Command Function 

New Create a new control file 

Open Load an existing control, 'file 

Edit Open an existing control file for editing 
Close Close the control file and update the client area 

Print Print the contents of the client area 
Print Setup Select and set up the printer 
Exit Exit the program 

Table 5.1- Summary of the commands in the File menu' 

5.4.1.2- The Open command 

The Open command can be used to load an existing control file. This option invokes the 

Open dialogue box that contains several list boxes that can be used to locate a control 
file and then select it. When a control file is successfully loaded, the name of the mine is 

added to the title bar.,, 

5.4.1.3- TheIEdit command 

The, Edit command can be used to edit, or to view the contents of an existing control file. 

This option. invokes various dialogue boxes to edit the contents of a control file. The 

Edit command is only available if a control file has already been loaded. Otherwise this 

command is not available. 
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5.4.1.4- The Close command 

The Close command can be used to remove the active control file. This option also 

updates the client area of the program and removes the name of the mine from title bar. 

5.4.1.5- The Print command 

The Print command can be used to generate a hard copy of any numerical or graphical 

presentation displayed in the client area of the program. This command is only available 

when any result has already been displayed in the client area. Before using the Print 

command, it is necessary to select and setup the printer. 

5.4.1.6- The Print Setup command 

Before generating any hard copy of the' output displayed in the client area, it is necessary 

to select and set up the printer as well as to chose the appropriate paper size and its 

orientation. The Print Setup command can be used to select and setup the printer. 

5.4.1.7- The Exit command 

The Exit command can be used to quit the program. 

5.4.2- The Slope Menu 

The Slope menu, shown in Figure 5.3, contains commands for entering geotechnical 

information and for'designing slope angles by two methods: steepest safe angle and the 

limit equilibrium method in terms of the calculation of the factor of safety or the 

probability of failure. It also, includes options for, determining the four principal slope 

angles together, with the graphical display of the: factor of safety or the probability of 

failure versus slope angles. Table 5.2 summarises the available commands in this menu. 

205 



Chapter 5: The software 

AI! r1'rJ 
Eia 2 eun Qraphicd Dispfay 

fieotechrucd Data 
gunaicd Dupley Iool EM 

S, Seepest Säe Angle 

Eindnetic Ans 
.. _. 

ßesyn d Slope 

BecW d Sbpe Decgn 

$vicpel Sbpe Arglec 

Help 

CYeeae or eddthe dam required to design elope 

CJAISlM MMcmeofl Difia Sha1eW 8eý jZ Dgwd Open PR De... 

Figure 5.3- The Slope menu 

-x 

Command Function 

Geotechnical Data Create or edit data required to design slope angles 

Steepest Safe Angle Determine steepest safe angles for each region 

Kinematic Analysis Display the result of kinematic analysis graphically 

Design of slope Determine the factor of safety or the probability of failure versus slope angle 

Result of slope design Display the factor of safety or the probability of failure versus slope angle 

Principal slope angles Determine four principal slope angles 

Table 5.2- Summary of the commands in the Slope menu 

5.4.2.1- The Geotechnical Data command 

The Geotechnical Data command is only available if a control file has already been 

created or loaded from the File menu and can be used to enter or edit the information 

required for calculating the slope angles. This includes the orientation and strength of 
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discontinuities, strength of rock mass and ground water conditions. It invokes various 
dialogue boxes for entering data and storing them in a text file for further use. The name 

of this file is the same as that of the control file but with the extension "SLD". 

5.4.2.2- The Steepest Safe Angle command 

The Steepest Safe Angle command is only available if the geotechnical data have already 

been entered and stored in a text file. This command can be used to determine the 

steepest safe angle with regard to plane and wedge failure. This is a simple method and is 

useful when only a little information is available. If this command is selected four 

principal slope angles for each region are determined. 

5.4.2.3- The Kinematic Analysis"command 

The Kinematic Analysis command is only available if the geotechnical data have already 

been entered and stored in a text file. This command provides a graphical display. of the 

kinematic analysis results superimposed on a plan view of the orebody. 

5.4.2.4- The Design of Slope command 

The -Design of Slope command is only available if the geotechnical data have already 
been entered and stored in a text file. This command can be used to determine the factor 

of safety or the probability of failure versus slope angles. If all the input data are defined 

as deterministic values, the factor of safety is obtained otherwise the probability of failure 

is calculated for various slope angles from 200 to 80° in 5° steps with different dip 

directions from 0° to 360° in 15° increments. The results are stored in a text file with the 

same name as control file name but with the extension of "PRO". 

5.4.2.5- The Result of Slope Design Option 

The Result of Slope Design command is only available if the ' factor of: safety or the 
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probability of failure has already been determined and stored in a text file by the Design 

of Slope command. This command displays the factor of, safety, or the probability of 
failure versus slope angles, for slopes with dip direction . from 0° to 360° in 15° 

increments. There are four figures for each domain sector or region for slopes with a dip 

direction from 0° to 90° (quadrant I), 90° to 180° (quadrant II), 180 to 270° (quadrant 

]III) and 270° to 360° (quadrant IV); each figure contains six graphs. The number of the 

quadrant and the number of the region must be specified by the user. 

5.4.2.6- The Principal Slope Angles command 

The Principal Slope Angles command is only available if the factor of safety or 

probability of failure has already been determined and stored in a text file by the Design 

of Slope command. This option can be used to determine the four principal slope angles 

provided that the required data - minimum acceptable factor of safety and maximum 

acceptable risk of failure together with the type of slope including slope under dry 

conditions, wet slope without tension crack and wet slope with tension crack - are given 

by the user. The user can edit, abandon or use these principal slopes to determine the 

optimum pit. If they are accepted these slopes replace those defined in the control file. 

5.4.3- The Run Menu 

The Run menu, illustrated in Figure 5.4, includes commands to create an orebody 

revenue block model, to determine the optimum pit and to execute pit bottom 

smoothing. Table 5.3 summarises the available commands in this menu. 

5.4.3.1- The Revenue Block Model option 

The optimal pit design algorithm requires a revenue block model of the deposit in which 

a profit or revenue value is assigned to each block. This option can be used to create an 

orebody revenue block model by applying the information stored in the control file. It is 

208 



Chapter 5: The software 

only available when a control file has already been created or loaded from the File menu. 

If a revenue block model has already been created an indicative message will be 

displayed. Depending on the number of regions stored in the control file, this option uses 

either the variable -revenue 
function or the multiple- revenue function to create the 

orebody revenue block model. If a single region is specified variable revenue is used 

otherwise the multiple-revenue function is executed. 
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Figure 5.4- The Run menu 

5.4.3.2- The Optimum Pit Limit option 

The Optimum Pit Limit option can be used to determine the optimum pit from a revenue 

block model of the deposit. This option is only available if an orebody revenue block 

model has already been created. Depending on the number of regions stored in the 

control file, this option uses either the variable-pit or the multiple-pit function to 

determine the optimum pit limit with variable slope angles. If a single region is specified 

variable- pit is used otherwise the multiple-pit function is executed. 
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Command Function 

Revenue Block Model Create a revenue block model of deposit 

Optimum it Limit Determine the optimum pit limit ,., 
Pit Bottom Smoothing Carry out pit bottom smoothing 

Table 5.3- Summary of the available options in the Run menu 

5.4.3.3- it Bottom Smoothing option . 

The optimum pit limit generated by the algorithm may have a very irregular bottom that 

may not be feasible in practice because of the minimum space required for mining 

equipment to operate freely. The Pit Bottom Smoothing option can be used to smooth 

the pit bottom by specifying a required minimum space in order to obtain a technically 

optimum pit. This option is only available if the optimum pit limit has already been 

obtained. Depending on the number of regions stored in the control file, this command 

uses either the variable_pitbot function or the multiple_pitbot function to smooth the 

pit bottom and determine the technically optimum . pit. If a single . region is specified 

variable_pitbot is used otherwise the multiple_pitbot function is executed. 

5.4.4= The Graphical Display Menu 

The Graphical Display menu, shown in Figure ' 5.1, ' provides options for displaying 

graphical presentations of the 'optimum pit in plan and sections for pits with and without 

pit bottom smoothing. It also includes options for the display of block plots of the 

surface topography and block plots of grade values for any level and interval. Table 5.4 

summarises the options available in this menu. 

5.4.4.1- The Block Plot of Surface Topography command 

The Block Plot ' of Surface "Topography command is 'only available if a 'revenue block 

model of the deposit has already been created. This option can be used to display a block 
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plot of the surface topography. 

Command Function 
Block Plot of Surface Topography Plot the surface topography 

Block Plot of Grade Value Plot the grade value for any level 

Pit Limit With Smoothing, Plot the pit limit in plan without pit bottom smoothing 

Fasting Section Without Smoothing Plot the pit limit in Fasting section without pit bottom 

Northing Section Without Smoothing Plot the pit limit in Northing section without pit bottom 

Pit Limit With Smoothing Plot the pit limit in plan with pit bottom smoothing 

Easting Section With Smoothing Plot the pit limit in Fasting section with pit bottom 

Northing Section With Smoothing- Plot the pit limit in Northing section with pit bottom 

Table 5.4- Summary of the commands in the Graphical Display menu 

5.4.4.2-. The Block Plot of Grade Value command 

This command is only available if an orebody revenue block model of the deposit has 

already been created. It can be used to display a block plot of the grade values provided 
that the user gives the level number and required interval. 

5.4.4.3- The it Limit Without Smoothing command 

The Pit Limit Without Smoothing command is only available if the' optimum pit limit has 

already been determined. This option generates a graphical display of the pit limit 
without pit bottom smoothing. 

5.4.4.4- The Fasting Section Without Smoothing command 

The Easting Section Without Smoothing command is only available-if the optimum pit 
limit has already been determined. This option generates a graphical display of an east-, 

west cross-section of the pit without pit bottom smoothing provided that the' user first 

specifies the Easting'of the cross-section. 
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5.4.4.5- The Northing Section Without Smoothing command 

The Northing Section Without Smoothing command is only available if the optimum pit 
limit has already been determined. This option generates a graphical display of a north- 

south cross-section of the pit without pit bottom smoothing. To do so the user must first 

specify the Northing of the cross-section. 

5.4.4.6- The Pit Limit With Smoothing command 

This command is only available if the technical optimum pit has already been obtained. It 

generates a graphical display of the pit with pit bottom smoothing. 

5.4.4.7- The Easting Section With Smoothing command 

The Easting Section With Smoothing command is only available if the optimum pit limit 

has already been smoothed by the Pit Bottom Smoothing command. This option 

generates a graphical display of an east-west cross-section of the pit with pit bottom 

smoothing provided that the user first specifies the Easting of the required cross-section. 

5.4.4.8- The Northing Section With Smoothing command 

This command ' is only available if the technical optimum pit limit has already been 

obtained. It generates a graphical display of a north-south cross-section of the pit with 

pit. bottom smoothing. To do,, so, the user must first specify the Northing of the required 

cross-section. 

5.4.5- The Numerical Display Menu 

The Numerical Display, shown in Figure 5.5, provides options for displaying numerical 

presentations of output including optimisation results with and without pit bottom 

smoothing. Table 5.5 summarises the options available in this menu. 
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Figure 5.5- The Numerical Display menu 

5.4.5.1- The Pit Limit Without Smoothing command 

The Pit Limit Without Smoothing command is only available if the optimum pit has 

already been determined. This option generates numerical displays of the pit without pit 

bottom smoothing. 

5.4.5.2- The Result Without Smoothing command 

The Result Without Smoothing command is only available if the optimum pit has already 

been determined. This option generates numerical displays of the results of pit 

optimisation without pit bottom smoothing. These results include level-by-level 

summaries of the number of blocks in the pit, the tonnage of ore and waste, the monetary 

values of ore and waste and the mean grade of ore. 
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5.4.5.3- The Pit Limit With Smoothing command 

The Pit Limit With Smoothing command is only available if the economically optimum 

pit has already been smoothed by using the Pit Bottom Smoothing command. This 

option generates a numerical display of the smoothed pit., , 

Command Function 

Pit Limit Without Smoothing Display the plan view of the pit limit without pit bottom smoothing 

Result Without Smoothing Display the results of optimisation without pit bottom smoothing 

Pit Limit With Smoothing Display the plan view of the pit limit with pit bottom smoothing 

Result With Smoothing Display the results of optimisation with pit bottom smoothing 

Table 5.5- Summary of the commands in the Numerical Display menu 

, 
5.4.5.4- The Result With Smoothing command 

The Result With Smoothing command is only available if the economically optimum pit 

has already been smoothed by using the Pit Bottom Smoothing command. This option 

generates summaries of the smoothed pit optimisation results. These results, include 

level-by-level summaries of the number of blocks in the pit, the tonnage of ore and 

waste, the monetary value of ore and waste and the mean grade of ore. 

5.4.6- The Tools Menu 

The Tools menu, illustrated in Figure 5.6, contains commands for: 

0 displaying summaries of the orebody grade and revenue block models 

changing the graphical display options 

converting a random access file to a text file 

creating a file, containing the co-ordinates, grade and monetary value of all 

blocks 
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" creating a file of ore and waste blocks inside either the economical or 

technical optimum pit limit 

" creating an equivalent orebody block model for a multi-mineral deposit 

" changing the direction of the vertical co-ordinates of the orebody block 

model. 

Table 5.6 summarises the commands available in this menu. 
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Figure 5.6- The Tools menu 

5.4.6.1- The Summary of Block Model command 

This command contains two options: Grade Block Model and Revenue Block Model. 

The former is only available if the control file has already been loaded. It displays the 

number of blocks in the East-West, North-South and vertical directions together with the 

minimum and maximum co-ordinates of blocks in the orebody block grade model. The 

latter is accessible when the orebody revenue block model is created. As illustrated in 
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Figure 5.7, this option displays the number of blocks in East-West, South-North and 

vertical directions, the number of ore, waste and air blocks, the number of blocks added 

to the borders together with the minimum and maximum co-ördinates of the blocks in the 

orebody revenue block model. 

Command Function 

Summary of Block Model 

Grade Block Model Display the number of blocks in the orebody grade block model 

Revenue Block Model Display the number of blocks in the orebody revenue block model 

Graphical Display Option Change scale and the X axis in the graphical display 

Random Access File to Text 

Revenue Block Model Convert the grade and revenue orebody block model to a text file 

Pit Limit Without Smoothing Convert the optimum pit limit without smoothing to a text file 

Pit Limit With Smoothing Convert the optimum pit limit with smoothing to a text file 

Blocks Inside the Pit Limit 

All Blocks in Optimum Pit Generate the 3 dimensional co-ordinates of the blocks inside the optimum pit limit 

Ore Blocks in Optimum Pit Generate the 3 dimensional co-ordinates of the ore blocks inside the optimum pit limit 

Waste Blocks in Optimum Pit Generate the 3 dimensional co-ordinates of the waste blocks inside the optimum pit limit 

All Blocks in Technical Pit Generate the 3 dimensional co-ordinates of the blocks inside the technical pit limit 

Ore Blocks in Technical Pit Generate the 3 dimensional co-ordinates of the ore blocks inside the technical pit limit 

Waste Blocks in Technical Pit Generate the 3 dimensional co-ordinates of the waste blocks inside the technical pit limit 

Multi Mineral Deposit to One Convert the multi-mineral orebody block model to one mineral 

Change Vertical Co-ordinate Change the vertical co-ordinate of the block model 

Table 5.6- Summary of the commands in the Tools menu 

5.4.6.2- The Graphical Display Option command 

This command displays the Graphical Display Option dialogue box which contains radio 

buttons for choosing whether the graphical outputs are displayed with or without scale. 

It also contains options for changing the orientation of the X-axis between east-west and 

north-south for plan view graphical displays. 
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Figure 5.7- Summary of orebody revenue block model 

5.4.6.3- The Random Access File to Text command 

r 
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The Random Access File to Text command is used to convert the random access files 

generated from the Run menu to text files. It contains three options: Revenue Block 

Model, Pit Limit Without Smoothing and Pit Limit With Smoothing. These options are 

only available after the corresponding files have been created. The first option, Revenue 

Block Model, converts the orebody revenue and block grade model generated by the 

Revenue Block Model command to a text file. The next two options, Pit Limit Without 

Smoothing and Pit Limit With Smoothing, convert, respectively, the economical and 

technical optimum pit, stored in the random access files, to text files. The user must 

specify the names of the text files before these options can be implemented. 

5.4.6.4- The Blocks Inside the Pit Limit command 

As shown in Table 5.6, this command contains six options that can be used to create text 
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files: 

" containing the three dimensional co-ordinates of the blocks, grade, tonnage 
(only for grade model type II) and the monetary value of all blocks 

containing ore and waste blocks inside either ' -economical or technical 

optimum pit provided that the name of output file is given by the user. 

It should be noted that these options are available only after the related 

commands have been executed. 

5.4.6.5- The Multi-Mineral Deposit to One command 

This command is used to create an equivalent orebody grade block model for a multi- 

mineral deposit. It, displays a dialogue box for entering the multi-mineral file name, 

output file name and the required coefficients for each mineral. It is assumed that the 

multi-mineral file contains two lines as a title and one record for each block. Each record 

must contain the Easting, Northing and vertical co-ordinates of the' block together with 

the grade of each mineral. 

5.4.6.6- The Change Vertical Co-ordinate command 

For the orebody block grade model, illustrated in Figure ' 3.27, it is assumed that the 

Z-axis (representing the vertical direction) increases from top to bottom. Block models 
for which the Z-axis decreases from top to bottom must be modified so that the vertical 

co-ordinate increases from top down. The Change Vertical Co-ordinate command can be 

used to do this by specifying the file names and block dimensions in a dialogue box. 

5.4.7- The Help Menu 

This option. displays the version number of the program. 
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5.5- Input requirements 
5.5.1- Data required to determine'the optimum pit 

The input. data required to design the optimum open pit are the block grade model of the 

deposit, physical and economic factors and pit slopes. The only predetermined input is 

the orebody block grade model; all other information can be entered during program 

execution. Two'types'of block model can be used for open pit design. The brebody block 

grade model must be represented in a text file. This file must contain one record for each 

block and each record can be one of the two following types: 

Type I- Each block has a single grade only 

- Fasting (X) 

- Northing (Y) 

- Vertical (Z) co-ordinate of mid-point of the block 

- Estimated grade (mean grade of the entire block) 

Type II- Each block' has grade and recoverable tonnage of that portion of the 

block that is'above a specified 'cut-off grade 

- Easting (X) 

- Northing (Y) 

- Vertical (Z) co-ordinate of mid-point of the block 

- Grade above cut-off grade 

- Recoverable tonnage above cut-Off grade. 

The records of the file can be in any order and information can be recorded in free 

format. Blocks without co-ordinates, describe surface topography. Any negative values of 

grade or tonnage denote missing values and the corresponding block is considered to be 

waste. Missing values generally denote blocks for which there are too few data to 

provide an estimate. The following data are specified-by the user and are used, to create a 

control file in text format: 
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- Block dimensions (metres) 

- Specific gravity of ore 'and waste ' (tonnes/cubic metre) 

- Cut-off grade (grams/tonne) 

- Cost, of mining of ore and waste (monetary. units per tonne) 

(This can be a fixed value or variable value depending on the depth) 

- Processing cost (monetary units per tonne) 

- Recovery factor. (%) 

(This can be a fixed value or variable value depending on the grade) 

- Price of metal (monetary units per gram) 

- Pit slopes characteristic 

The information required to define the mining slope depends on the number of 

regions. If one region is specified only four principal slope angles are required. 
Otherwise, for each region the user must specify minimum and maximum depth, 

co-ordinates of the points defining the region and the four principal slope angles. It 

should be noted that the co-ordinates of the points defining the region must. be in 

sequence either in a clockwise or anticlockwise direction. Up to a maximum of 20 

different regions can be specified and there is no limitation on the number of co-ordinates 
defining each region. 

5.5.2- Data required to design slope angles 

If the steepest safe angle is used, only the orientation and properties of the discontinuities 

(dip, dip direction and angle of friction) within each domain sector, are required to 

determine slope angles. When the deterministic or probabilistic limit equilibrium method 

is used the following data are required for each region to determine the four principal 

slope angles as input parameters for the optimal pit design: 

Orientation and properties of the discontinuities including dip, dip direction, 

cohesion and friction angle either as a fixed value or as a'random variable with 
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corresponding density function. 

2- Rock mass properties including either cohesion and friction angle or 

geological strength index (GSI), uniaxial compressive strength (o) and 

material constant of intact rock (m, ) either as a fixed value or as a random 

variable with corresponding density function. 

3- Rock mass density either as a fixed value or as a random variable with 

corresponding density function. 

4- Water table depth either as a fixed -value or as a random variable with 

corresponding density function. 

5.6- Outputs 

A number of programs were written to produce graphical and numerical presentations of 
the results of the optimisation. These programs generate various forms of output all 
designed to fit A4 paper size. Outputs are displayed in the client area of 'the program 

window and hard copy can be generated` as well. Vertical and horizontal scroll bars are 

provided to scroll the window content to view information not in the current viewing 

portion of the window. Examples of all outputs are given in Chapter 6. In general, 

program outputs can be categorised as graphical and numerical displays. 

5.6.1- Graphical display 

Various forms of graphical presentation were developed to display the input data and the 

output generated by the software. These are displayed in the client area''with an 

appropriate scale for which the X-axis is oriented east-west in plan. It is also possible to 

display these outputs without scale and to change' the orientation of the X-axis to 

north-south. The graphical presentation includes the following output: 

1- Block plot of surface topography. 

Block plot of grade value 
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3- Optimum pit limit in plan 

4- Optimum pit limit in cross-section 

5- Results of kinematic analysis 

Factor of safety or probability of failure versus slope angle 

5.6.1.1- Block plot of surface topography 

In the orebody revenue block model, air blocks, indicating the surface topography have a 

value of zero. When an orebody revenue block model has been created, the' software is 

able to represent the surface topography in two dimensions. An example of a surface 

topography block plot of real data is given in Chapter 6. In the surface topography block 

plot, each block is identified by its Basting and northing and is shown by a colour-filled 

rectangle corresponding to a level number, indicating that all blocks from the first level 

down to and including this level are air blocks. For example, the number 2 indicates that 

there are two air blocks in this location. These are blocks whose co-ordinates are missing 

from the orebody grade model and they are treated as air blocks when the orebody 

revenue block model is created. A value of zero indicates that blocks reach the surface at 

this location. 

5.6.1.2- Block plot of grade value 

Once an orebody revenue block model has been created and the block grade file is 

obtained, it is possible to plot the grade value for each level in two dimensions. For this 

purpose, the level number and the number of class intervals for displaying colour-coded, 

grade values are required., For, display purposes the block. grades are, colour-coded 

automatically by colours assigned to, each class interval.. 

Some examples of grade block plots are given in Chapter 6. It should be noted 

that -air blocks and blocks with zero, values are not displayed- on , block plots of grade 

values. 
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5.6.1.3- Optimum pit limit in plan 

When an optimum pit has been obtained, with or without pit bottom smoothing, the 

software can provide a graphical display of a two-dimensional plan view of the optimal 

pit. In this plan view the pit is shown as colour-filled rectangles corresponding to the 

level number down to which blocks must be mined. Some examples of graphical displays 

of the optimum pit are provided in Chapter 3 (Figure 3.32,3.37 and 3.45). For example, 

the number 6 in Figure 3.32 indicates that, at this horizontal location, all blocks from the 

surface down to -and including level 6 are part of the optimum pit. The number 0 

indicates that no blocks are mined at this horizontal location. 

5.6.1.4- Optimum pit limit in cross-section 

The program can create cross-sections in both directions (East-West, South-North) for 

both the economical and technical optimum pits. The Easting cross-section specifies a 

vertical cross-section as seen looking from south to north with the Fasting of the section 

constant. The Northing section specifies a vertical cross-section as seen looking from 

west to east with the Northing of the section constant. This is achieved by specifying the 

Easting or Northing of the section required. The program finds the group of blocks on 

the cross-section and shows the optimum pit limit with a thick red line indicating that all 

blocks above this line are part of the optimum pit. 

5.6.1.5- Results of kinematic analysis 

When the geotechnical data are entered, it is possible to display the results of kinematic 

analysis. The program determines the likely mode of failure and displays the results of 
kinematic analysis graphically and superimposed on the orebody.. Some examples of this 

plot are shown in Chapter 4 (Figures 4.21 and 4.27). 

5.6.1.6- Factor of safety or probability of failure versus slope angle 

Once the factor of safety or probability of failure has been determined the software can 
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generate graphical displays of the slope design results. There are four figures for each 
domain sector or region for slopes with a dip direction from 0° to 90° (quadrant I), 90° 

to 180° (quadrant II), 180° to 270° (quadrant III) and 270° to 360° (quadrant IV) each 

of which contains six graphs. When the number of the quadrant and the number of the 

region are specified, the program displays the factor of safety or the probability of failure 

versus slope angle using the information stored in the file with the same name as the 

control file name but with the extension "PRO". Some examples of this plot are shown 

in Chapter 4 (Figures 4.22-2.25 and 4.28-4.31). 

5.6.2- Numerical presentation 

Once the economically or technically'optimum open pit has been determined the software 

can generate numerical representations of the optimum pit with and without pit bottom 

smoothing. The numerical representations include: 

-, Plan view of the pit 

Results of the optimisation 

5.6.2.1- Plan view of the pit limit 

In the plan view of the pit each block is associated with a level number which indicates 

the number of blocks from the surface down that must be mined. For example, the 

number 5. indicates that all blocks down to and including level 5 must be mined or are 

above the topographical surface. The number 0 indicates that no blocks are, mined at this 

horizontal location. Figure 
- 
5.8 shows the plan view of the pit for the multiple regions 

example given in Chapter 3. In this example, there are ten levels (1 Om, 20m, '' ....., 1 OOm). 

The number 4 in Figure 5.8 indicates that at this location all blocks down to and 
including level 4 (10m, 20m, 30m and 40m) are part of the optimum pit or are above the 

topographical surface. 
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Chapter 5: The software 

5.6.2.2- Results of the optimisation 

When the optimum pit is obtained, with or without pit bottom smoothing, the software 

can generate level-by-level summaries of the optimisation results including the number of 
blocks in the pit, the tonnage of ore and waste, the monetary value of ore and waste and 
the mean grade of ore. An example of this is given in Chapter 6. 

5.6.3- Output written to files 

Apart from the control file with the default extension "CFL", a number of data files are 

created during program implementation to record the results -of each process. These files 

have the same name as the control file but have different extensions. Table 5.7 shows the 

types of data files and their extensions created by the program. 

Extension Type Contents 

. REV Binary Revenue block model 

. GRD Binary" Grade block model 

. 
BLK Text Deposit characteristic 

. SLD Text Geotechnical data 

. 
PRO Text Result of design of slope angles 

. 
PIT Binary Output of optimisation 

. RST Text Result of optimisation 

. BOT Binary Output of pit bottom smoothing 
RPB Text Result of pit bottom smoothing 

Table 5.7- Output, files generated by, the software 

The output files are created by revenue calculation programs (variable_revenue or 

multiple 
_revenue) 

have the extensions "BLK", "REV" and "GRD". They contain, 

respectively, block model characteristics, revenue block model and grade values. The 

programs for determining the optimum pit (variable_pit or multiple_pit) produce two 
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output files with extensions of "PIT" and "RST" that contain, respectively, the optimum 

pit limit and the overall results. Similarly, two output files, with extensions of "BOT" 

and "RPB", are created by the pit` bottom smoothing programs (variable _ pitbot or 

multiple ; pitbot) and contain, respectively, the technical optimum pit and the overall 

results: The geotechnicäl data and the results of the slope design are stored in files with 

extensions of "SLD" and "PRO" respectively. 

It should be noted that it is possible to convert random access files to text files or 

to create files containing three-dimensional co-ordinates of all blocks, ore and waste 
blocks in the pit together with their grades, tonnages (only for grade model type II) and 

monetary values. 

5.7- Program operations 

The operation of the program ` is straightforward. Any user-induced error during 

operation generates an error message that will be displayed in the dialogue message box. 

The software can be loaded by simply, clicking the PITWIN32 icon or by double clicking 

the PITWIN32. EXE from the file manager. When the program is-initiated, some 

commands are not immediately available. These are commands related to other options 

and are only available after the corresponding related commands have been executed. 

For example, the Optimum' pit limit 'command is operational only after the orebody 

revenue block has been created. Although the commands are related to each other, it is 

also possible to execute each of them at different times. 

Appendix A provides a detailed set of instructions for executing all functions of 
the software. 

5.8- Conclusion 

The objective of the present study was to develop general, PC-based software for 
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optimal open pit design with variable slope angles. The PITWIN32 software presented 

in this chapter is able to generate the true optimum pit with variable slope angles. The 

program has been validated on trial data sets and two case studies. The software can be 

used for both cubic and rectangular block models and slope angles can vary in different 

parts of the orebody without changing the block dimensions. It is also able, to generate 

output in the form of graphical and numerical displays or to write the results in text files. 

The different style of programming makes for much faster execution times than the 

similar FORTRAN code. 

The main features of the software are: 

" It is easy to use. 

The user can specify fixed or variable mining costs. The latter can vary with 
depth over an unlimited number of intervals. 

" The user can specify fixed or variable recovery. The latter can vary with grade 

over an unlimited number of intervals. 

0 Slope angles can vary in both vertical and horizontal directions. 

Up to 20 different regions can be specified for the definition of mining slopes. 

" An unlimited number of vertices can be used to define approximate regions., 

Graphical and numerical of outputs are provided. 

Hard copy can be generated.. 

The program can handle an unlimited number of blocks in the deposit. 
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CHAPTER 6 

Case studies 

6.1- Introduction 

Two case studies were employed to illustrate and test the application of the software for 

determination of optimum open pit limits. The "data for both cases come from real 
deposits in Europe. The first is a low grade gold deposit and the second is a zinc-silver- 

gold-lead deposit. The orebody block grade models for both cases were generated by 

geostatistical methods. This chapter presents the results obtained from applying the 

optimal open pit design software for both cases. 

6.2- Case study 1 

The data for the first case study come from the Björkdal. gold mine which is located 

approximately 35 kin, northwest of Skellefteä in. the north of Sweden. The mine, which 

started production in 1988, is operated by Terra Mining AB. 

Gold mineralisation in the Bjorkdal area occurs within a network of steeply 
dipping quartz veins in the contact, between granodiorite and limestone (chalk)/acid 

volcanic rocks. The gold is erratically distributed but is mainly concentrated in and 

around high grade quartz veins. It occurs as both fine and coarse grains and is free- 

milling (Dowd, 1995). 

The block grade model is type II in; which each block is assigned the estimated 
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(kriged) recoverable tonnage of ore above a cut-off grade and the estimated (kriged) 

average grade of this tonnage. The method of estimation is described in Dowd (1995). 

The deposit, is divided into 15m (east-west) x l0m (north-south) x 5m (vertical) blocks 

and the recoverable tonnage is based on a selective mining unit of 5m (east-west) x 4m 

(north-south) x: 5m (vertical). The numbers of blocks in the east-west, north-south and 

vertical directions are 101,82 and 36 respectively. Some blocks have not been estimated 
because of lack of data and their co-ordinates are 'omitted from the block grade model. In 

addition, some blocks, in, the surrounding waste have been omitted, but these do not affect 

the determination of the optimum pit. Other input data are: 

a- Economic and technical factors 

Specific gravity of ore and waste 

Cost of mining of ore and waste 

Processing cost 

Price of gold 
Recovery 

2.71 t. m 3 

(See Table 6.1) 

SEK52 ' t"i of ore 
SEK90 g'1 

91% 

Level (m) Cost of Mining (SEK / tonne) 

From To Waste Ore 
0 120 11.0 '11.0 

120 130 11.30 11.30 
130 140 11.60 11.60 

140 150 -11.90 11.90 
150 160. 

.. 12.20 12.20 

160 170 12.50 12.50 

170 180 12.80 12.80 

180- 200 13.20 ' 13.20 ̀ 

Table 6.1- Cost of mining of ore and waste 

b- Geotechnical information 

The main rock types in the Björkdal mining area are granodiörite, chalk and vulcanite 
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(greywacke). Generally within the mine area these rocks dip 25-30° to the north. 
Although there are no major discontinuities in the mine area there are numerous small 

scale discontinuities. The strength of the rock masses and their classification with the 

1989 version of the Rock Mass Rating (RMR) system have been estimated by Terra 

Mining AB from drill core samples and the results are shown in Table 6.2. 

Rock type RMR Strength 

(MPa) 

Density 

(t. m 3) 
Cohesion 

(KPa) 

Friction angle 
(degree) 

Granodiorite 78 221.2 2.73 5200 59.2 

Chalk 68 83.7 2.70 1700 35.5 

Vulcanite 72 111.6 2.75 2400 49.1 

Table 6.2- Geotechnical information for case study 1 

With regard to the RMR rating these rocks can be classified as good. Since there 

are no major discontinuities in the mine area, no structural instability is likely to occur 

and the slope angle is determined by the use of circular failure analysis. In order to 

ensure stability, chalk, which is the weakest among the rock types in the mine zone, is 

chosen to determine slope angles. Figure 6.1 shows the safety factor versus slope angles 

for this rock for which the slope is assumed to be saturated. Using acceptable safety 

factors of 2, and 2.5, slope angles of 67° and 54°, respectively, were obtained for 

saturated slopes in all directions. The mine is currently operating with an overall slope 

angle of 58° in all directions. A slope angle of 58° was used to design the optimum pit 

and it is assumed that this angle is the same for the entire area . 

The orebody revenue block model created by the software contains 115,104 and 
36 blocks in the east-west, north-south and vertical directions respectively, yielding a 

total of 43 8,048 blocks. Figure 6.2 shows a block-plot of the surface topography for this 

deposit. The block plot of grade value (distribution of the gold grades) on level 27 is 

illustrated in Figure 6.3. The optimum pit limits in plan and sections are shown in Figures 

6.4 to 6.6. Table 6.3 shows the overall results of this case study. 
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Level Number of blocks Tonnage (tonnes) Value (* 10000) Mean 

No. Pit Ore Waste Ore Waste Ore Waste 
grade 
(g 1) 

1 0 0 0 0.0 0.0 0.0 0.0 0.000 
2 7 0 7 0.0 14227.5 0.0 -15.7 0.000 

3 20 0 20 1261.2 39388.8 0.0 -44.2 0.689 

4 47 6 41 8321.0 87206.5 28.2 -72.1 1.534 

5 89 19 70 18943.7 161948.8 71.4 -133.7 1.516 

6 98 24 74 23070.9 176114.1 120,4 -149.2 1.642 

7 116 23 93 26635.0 209135.0 172.8 -180.7 1.787 

8 115 22 93 30349.5 203388.0 223.7 -183.4 1.831 

9 132 31 101 38982.5 229307.5 313.7 -208.1 1.890 

10 188 70 118 88491.2 293618.8 986.6 -243.1 2.241 

11 304 109 195 149660.5 468219.5 1638.9 -406.3 2.195 

12 381 160 221 229524.3 544858.2 2661.4 -462.7 2.258 

13 652 186 466 257278.2 1067911.8 2804.6 -1009.1 2.179 

14 833 192 641 274901.7 1418170.9 2903.7 -1398.5 2.131 

15 912 199 713 294251.1 1559389.0 3259.6 -1543.8 2.193 

16 884 213 671 290347,6 1506382.4 2632.3 -1443.5 1.966 

17 899 183 716 230409.9 1596807.6 2006.2 -1523.7 1.956 

18 853 181 672 216524.7 1517197.8 2190.4 -1428.1 2.140 

19 793 181 612 224820.8 1386951.8 2453.2 -1295.3 2.227 

20 730 182 548 225121.9 1258603.1 2529.7 -1171.2 2.257 

21 734 212 522 270892.7 1220962.2 3666.3 -1133.8 2.536 

22 723 228 495 286762.7 1182734.8 3542.2 -1045.6 2.405 

23 663 209, 454 285203.3 1062344.2 3118.6 -986.9 2.217 

24 638 233 405 312822.6 983912.4 3298.2 -862.0 2.173 

25 650 281 369 389399.2 931725.8 4327.1 -766.2 2.244 

26 652 344 308 464991.1 860198.9 5262.1 -619.0 2.268 

27 625 324 301 441324.8 828987.8 5652.3 -606.6 2.460 

28 579 342 237 478614.2 698203.3 6984.8 -456.9 2.667 

29 479 296 183 415863.8 557703.7 5937.7 -381.9 2.623 

30 384 241 143 338962.9 441517.1 4642.5 -290.7 2.554 

31 300 223 77 295231.1 314518.9 3920.7 -153.8 2.516 

32 220 181 39 249775.2 197374.8 4036.9 -66.2 2.856 

33 150 137 13 195474.3 109400.7 3117.2 -28.0 2.816 

34 100 94 6 140512.9 62737.1 2686.1 -12.1 3.192 

35 57 '56 1 83122.6 32729.9 1964.2 -2.7 3.741 

36 23 23 0 35842.0 10905.5 700.1 0.0 3.230 

Total 15030 5405 9625 7313691.1 23234784.1 89853.7 -20324.9 2.380 

Table 6.3 - Pit result without pit bottom smoothing - Case study 1 
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Level Number of blocks Tonnage (tonnes) Value (*10000) Mean 

grade 
No. Pit Ore Waste Ore Waste Ore Waste (9/0 

1 0 0 0 0.0 0.0 0.0 0.0 0.000 

2 7 0 7 0.0 14227.5 0.0 -15.7 0.000 
3 23 0 23 1569.4 45178.1 0.0 -49.5 0.787 

4 57 6 51 10601.1 105251.4 28.2 -89.1 1.402 

5 107 19 88 19553.7 197923.8 71.4 -171.4 1.504 

6 116 24 92 23970.6 211799.4 120.4 -186.3 1.621 

7 142 23 119 27388.1 261226.9 172.8 -235.5 1.771 

8 136 23 113 30461.6 245958.4 223.0 -229.3 1.828 

9 168 30 138 41592.6 299867.3 313.4 -280.5 1.834 

10 243 72 171 94148.6 399748.9 990.2 -344.6 2.177 

11 359 111 248 157585.0 572082.5 1640.5 -503.7 2.138 

12 451 159 292 235239.9 681417.6 2657.8 -592.5 2.230 

13 753 186 567 264089.0 1266383.5 2782.7 -1205.0 2.143 

14 974 192 782 286783.1 1692872.0 2910.8 -1674.4 2.088 

15 1041 202 839 307245.3 1808587.2 3275.1 -1784.5 2.152 

16 1009 214 795 300355.6 1750436.9 2626.6 -1689.8 1.933 

17 1030 184 846 241852.8 1851622.2 1993.2 -1771.5 1.909 

18 986 185 801 229267.3 1774777.8 2203.5 -1685.4 2.085 

19 902 186 716 233148.4 1600166.6 2463.2 -1511.8 2.189 

20 819 186 633 228408.5 1436209.0 2523.0 -1346.6 2.243 

21 841 215 626 277264.3 1432068.1 3638.4 -1338.9 2.498 

22 824 232 592 294185.4 1380594.6 3523.2 -1241.2 2.368 

23 760 211 549 295028.9 1249671.1 3114.3 -1173.7 2.180 

24 720 233 487 319485.8 1143914.2 3276.7 -1033.1 2.141 

25 766 280 486 400590.3 1156304.8 4326.5 -997.8 2.214 

26 753 348 405 476634.7 1053837.8 5267.2 -819.4 2.241 

27 739 327 412 457686.2 1044331.3 5657.7 -825.1 2.413 

28 708 349 359 497410.0 941600.0 6982.5 -703.4 2.607 

29 596 294 302 425643.9 785726.1 5911.9 -634.5 2.583 

30 495 239 256 350543.2 655544.3 4623.9 -526.8 2.500 

31 387 223 164 309017.7 477559.8 3885.9 -332.9 2.437 

32 311 187, 124 261608.8 370498.7 4042.4 -245.8 2.785 

33 237 142 95 210002.6 271699.9 3125.1 -202.5 2.704 

34 169 101 68 153993.9 189498.6 2696.1 -150.0 3.013 

35 125 65 60 97969.4 156093.1 1978.2 -132.0 3.354 

36 48 24 24 38001.9 59558.1 676.1 -49.1 3.063 

Total 17802 5472 12330 7598327.6 28584237.6 89722.3 -25773.3 2.330 

Table 6.4 - Pit result with pit bottom smoothing - Case study 1 



Chapter 6: Case studies 

This case study took 42-minutes of CPU time to determine the optimum pit limits 

with the use of a Pentium 200 PC computer. A minimum space of 30m 'x 30m is also 

used to carry out pit bottom smoothing for which the technical optimum pit limits in plan 

and sections are illustrated in Figures 6.7 to 6.9. Table 6.4 shows the overall result for 

the technical optimum pit limit for case study 1. 

6.3- Case study 2 

The, second case study is a low grade zinc-silver-gold-lead deposit. The block grade 

model file contains the co-ordinates of the mid-points of the blocks together with the 

grade of each metal in grams per tonne. Block dimensions are 1 0m 
, 
(east-west) x 15m 

(north-south) x 10m (vertical). The block model has also 93,171 and 24 blocks in the 

east-west, north-south and vertical directions respectively, giving a total of 381,672 

blocks. Other input data are listed below: 

Specific gravity of ore and waste 2.8 t. m3 

Processing cost, SEK40 t 'i of ore 

Cost of mining of ore and waste SEK8.10 t-1 (for level 1 and increasing at 
SEKO. 15 f1 every 1 Om) 

Base prices: 

Gold, SEK78.01 g"1 

Silver. SEK1.59 g-1 

Zinc- SEK9.13 kg" 

Lead SEK4.26 kg-l' 

Number of regions 1 

Pit slope angles: 

North face angle 500 

South face angle 50° 

East face angle 60°, 

West face angle, 500 -- 
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Chapter 6: Case studies 

Figures 6.10 to 6.13 show the distribution of gold, silver, zinc and lead grades on 
levels 12,16,14 and 15 respectively. - A block plot of the surface topography for this case 
is shown in Figure 6.14. - 

Level Number of blocks Tonnage (tonne) Value (* 10000) Mean grade (g/t) 

No. Pit Ore Waste Ore Waste Ore Waste Au Ag Zn Pb 

1 0_ 0- ,0 ,0 ,0 0 "- 0 '0 0 0 0 

2 48, 0 48 0 201,600 0 -166.3 0 0 0 0 

3 197 15 182 105,000 722,400 430,3 -669.8 0.549 3.504 7.348 1,612 

4 294 43 251 205,800 1,029,000 1,495.8 -925.9 " 0.835° 3.535 5.427 1,607 

5 846 61 785 315,000 3,238,200 1,473.6 -2,902.5 0.622 3.205 4,845 1,737 

6 1,139 131 1,008 659,400 4,124,400 2,718 -3,812 0.232 4.959 7,718 3,953 

7 1,075 217 858 1,071,000 3,444,000 4,596.9 -3,297.1 0.181 4.843 8,632 3,907 

8 972 218 754 1,121,400 2,961,000 5,343.0 -2,927.8 0.248 4.697 9,048 3,578 

9 912 219 693 1,150,800 2,679,600 5,501.3 -2,771.6 0.221 4.807 9,648 3,523 

10 829 243 586 1,188,600 2,293,200 6,390.1 -2,382.4 0.300 4.632 9,146 3,230 

11 684 248 436 1,205,400 1,667,400 6,883.5 -1,803.7 0.294 4.771 9.653 3.329 

12 496 249 247 1,129,800 953,400 7,258.8 -1,036.4 0.309 5.001 9,816 3,474 

13 329 215 114 970,200 411,600 6,566.6 -510.8 0.293 5.194 10,291 3.755 

14 188 134 54 609,000 180,600 4,600.8 -227.4 0.339 5.626 10,738 4,172 

15 96 84 12 357,000 46,200 2,325.7 . 51.2 0.191 6.041- -10,222 4.705 

16 35 . 33 2 147,000 0 1,208.7 - -12.7 0.062 9.288 12,773 7,990 

17 6, 
_6 

0 25,200 0 385.8 
.0 0.052 18.026 15,562 . 18,040 

18 2 2 0 8,400 0 143.6 0 0.050 10.305 23,656 1 
10,166 

19 0 0,1 0 0 0 0 0 0 0 0 0 

20 0 0 0 0 0 0 0 0 0 0 0 

21 0 0 0 0 0 0 0 0 0 0 0 

22 0 0 0 0 0 0 0 0 0 0 0 

23 0 0 0 0 0 0 0 0 0 0 0 

24 0 0 0 0 0 0 0 0 0 0 0 

total 8,148 2,118 6,030 10,269,000 23,952,600 57,322.5 -23,497.9 0.285 4.979 9,321 3,657 

Table 6.5- Pit result without pit bottom smoothing - Case study 2 

To evaluate the effect of the price and recovery factor on the optimum pit design, 

two alternatives were examined. For the first alternative, the recovery factor is taken as 

100%. For the second alternative it is'taken as 90%, 75%, 55% and 55% for gold, silver, 
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zinc and lead respectively. A metal-equivalent orebody block model is created for each 

alternative by using the Multi-Mineral Deposit to One command from the Tools menu 
for which the coefficients of each mineral are the product of its price and recovery factor. 

For each alternative five different metal-equivalent prices, SEKO. 70,0.85,1.0,1.2 and 

1.4, are used to create the orebody revenue block model. 

The orebody revenue block model contains 591,000 (125 x 197 x 24) blocks to 

which 13,19,13 and 13 blocks are added, respectively, to the eastern, western, southern 

and northern boundaries of the deposit. The optimum pit limit in plan and the results for 

the second alternative with a price of SEK1.4 are shown in Figure 6.15 and Table 6.5 

respectively. The overall results for both alternatives are summarized in Table 6.6. 

Alternative Price Tonnage (tonne) Net Value Stripping Mean grade (g/t) Optimum 

Ore Waste (+10000) ratio Au Ag Zn Pb depth (m) 

0.70 5,808,600 11,050,200 16,407.5 1.90 0.375 5.094 10,379 3,720 150 

0.85 10,676,400 25,061,400 31,785.6 2.35 0.260 4.979 9,512 3,669 180 

1 1.0 13.288.800 34,679,400 52,533.5 2.61 0.228 4.757 8,904 3,429 190 

1.2 18,261,600 59,442,600 87,282.7 3.26 0.184 4.526 8,497 3,232 220 

1.4 23,482,200 86,751,000 130,761.5 3.69 0.158 4.426 7,932 3,105 240 

0.70 1,591,800 1,885,800 2,870.1 1.18 0.555 6.049 12,995 4,805 130 

0.85 3,032,400 4,548,600 6,147.4 1.50 0.515 5.610 11,700 4,216 130 

2 1.0 4,662,000 8,681,400 11,663.6 1.86 0.494 5.264 10,731 3,878 140 

1.2 6,270,600 12,999,000 21,086.8 2.07 0.403 4.974 10,000 3,594 150 

1.4 10,269,000 23,952,600 33,824.6 2.33 0.285 4.979 9,321 3,657 180 

Alternative 1: Recovery= 100% 

Alternative 2: Recoveries 

for all minerals 
Au: 90% 

Ag: 75%_ 

Zn: 55% 

Pb: 55% 

Table 6.6- Comparison of results obtained with different prices and 

recovery factors for case study 2 
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Chapter 6: Case studies 

As can be seen from Table 6.6, an increase in the price leads to higher net profit 

and an increase in the optimum pit depth. It also generates a higher tonnage of ore with a 

lower mean grade and a higher stripping ratio. The consequence of a decrease in the 

recovery factor are lower values of total tonnage of ore and waste, net profit, stripping 

ratio and optimum pit depth and an increase in the mean grade of all metals. '' 

Price Number of blocks Computing time 

Ore Waste Air Minute 

0.70 1,631 456,475 132,894 1 

0.85 2,653 455,453 132,894 8 

1.0 3,483 454,623 132,894 38 

1.2 4,545 453,561 132,894 237 

1.4 5,302 452,804 132,894 338 

Table 6.7- Computing time for the second alternative 

Table 6.7 shows the computing times to determine the optimum pit for the second 

alternative with the use of a Pentium 400 PC. All the revenue block models for this case 

study contain 591,000 blocks but each has a different number of ore and waste blocks as 

illustrated in Table- 6.7. The results indicate that the computing time increases 

significantly as the price (and, consequently, the number of ore blocks) increases. Thus 

computing depends not only on the number of blocks in the model but also on the 

complexity of the deposit as defined by the spatial distribution of ore blocks.. As the 

complexity increases, the computing also increases. As it is difficult to measure the 

degree of the complexity of a deposit, it is also difficult to predict the computing time. 

6.4- Conclusion 

The application of the software to two case studies demonstrates that it works and is 

able to generate an optimum pit limit with variable slope angles, in particular for complex 

and low grade orebodies. Moreover, the software is capable of generating solutions on a 
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PC within reasonable times. It also generates numerical and graphical displays of the 

optimization providing a means of visualizing and interpreting the results of open pit 
design. 

The result shows that the computing time required to reach a solution depends 

primarily on the complexity of the deposit. As the complexity of the deposit increases 

computing time increases. However, with the use of a high-speed computer, it is now 

possible to determine the optimum pit limits with the variable slope version of the 

Lerchs-Grossmann algorithm for complex and large orebodies. 
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CHAPTER 7 

Conclusions and recommendations 

for future work 

Mineral deposits are generally extracted from the earth either by underground mining or 

by surface mining methods (open pit mining) and the objective is normally to extract ore 

at a profit.. The growth in demand for the raw material together with advances in mining 

technology and the depletion of high-grade, readily accessible sources of ore has led to 

an increase in the use of open pit mining to extract large, low grade deposits. This 

method permits the use of highly mechanised, large-scale production equipment, which is 

capital intensive but low in labour costs. Large-scale open pit mining is a complex 

operation that may extend over several decades and require very large investments. 

Smaller scale operations, usually for precious metals, are often more, complex 

because of the erratic nature of the mineralisation. These operations generally have a 

much shorter life (current developed world average of 5-7 years for gold) but 

proportionately they require an equally high capital investment. The erratic nature of the 

mineralisation means that these types of orebodies must be mined in a highly selective 

manner. In addition, pit designs and mining schedules are very sensitive to changes . in 

prices, costs and grades. 

Many studies have shown that the maximisation of net present value requires an 

operation to_ start with a relatively high-grade ore, which declines over . the, life of the 

mine. 
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Chapter 7: Conclusions 

The size, location and final shape of. an open pit are important in planning the 

location of waste dumps, stock piles; processing plant, access roads And other surface 

facilities ' and to develop a production programme. The pit design also defines minable 

reserves and the associated amount of waste to be removed during the life of the 

operation. This must be determined before the operation starts. The pit design, which is a 

function of numerous variables, may be re-evaluated many times during the life of the 

mine as design parameters change or, more information is obtained during the operation. 

The use of computer, methods is necessary-in order to re-design the pit as rapidly as 

possible. 

The use of computers in designing open pits begins with the development of a 
block model of the orebody. For this purpose, a. large rectangular block is - defined, 

sufficient to cover all the mineralisation. This large block is then sub-divided into a finite 

number of smaller blocks. Each block in the model is assigned an estimated 'ore grade 

obtained by the use of geostatistical or other block grade estimating techniques. 

Although there are many types of block models, the three-dimensional,, fixed block 

model, obtained by sub-dividing the deposit into- three-dimensional fixed-size blocks, is 

the most widely, used and the only one generally applicable to optimum pit design. The 

vertical height of the blocks is usually set to the planned bench height that will be used in 

the mining operation. The horizontal dimensions of. the blocks depend upon the density 

of drilling and sampling available to estimate the attributes (e. g. grade) of the blocks., 

With the advent and wide spread use of computers a number of algorithms have 

been developed to determine the optimum ultimate pit limits. The main objective of these 

algorithms, all of which use the block model, is to find groups of blocks -that should be 

removed to yield the maximum overall mining profit under specified economic conditions 

and technological constraints. The most common methods are: graph theory, network or 

maximal flow techniques, various versions of the floating or moving cone, the Korobov 

algorithm, dynamic programming and parameterization techniques. Of these, ° the 

algorithm developed by Lerchs and Grossmann, based on graph theory, is the only 
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algorithm-that can be proved, rigorously, always to generate the true optimum pit limit. 

However, the original algorithm was limited to only one slope angle defined by the block 

dimensions and was incapable of taking into account variable slope angles. - 

Many factors 'govern the size and shape of an open 'pit. The pit slope, which may 

vary throughout the deposit, is one of the key factors governing the amount of waste to 

be removed in order to gain access to the mineral deposit. Small changes in slope angle 

can change the amount of waste to be removed and significantly affect the degree of 

selectivity in' mining operations. For this reason, it is ver y important to change slope 

angles through the deposit in order to follow different structures'and rock types and keep 

the total amount of waste as small as possible. Any truly optimal pit design algorithm 

must, therefore, take into account variable slope angles. Incorporating variable slope 

constraints into the Lerchs-Grossmann algorithm will make it much more flexible, 

practical and reliable. Although many attempts'have been made to incorporate variable 

slope angles into the algorithm, none of them provide an adequate solution where there 

are variable slopes controlled by complex structures and geology. In chapter 3, the 

Lerchs-Grossmann algorithm was reconsidered' and modified to deal with variable slope 

angles. It is assumed, that the orebody and surrounding waste are divided into regions or 

domain sectors within which the rock characteristics are the, same and, each region is 

specified by four, principal slope angles: north, south, east and west faces. Pit slopes were 

then approximated, by. constructing a cone representing an extraction volume from the 

base block and extending it to the surface in such way that the side angles of the cone are 

equal to the four principal slope angles. This method was incorporated into the algorithm 

and its, operation demonstrated by examples and two case studies in chapter. 6. One of 

the most important outcomes of the work described here is that slope angles can vary, 

throughout the deposit to follow rock - characteristics. without, changing the -block 
dimensions. 

The, first step for determination of the optimal' pit shape is to create a revenue 
block model of the deposit. This model is the basis on which the pit is constructed. To do 
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this, an orebody block grade model is required. InAhe work described here it is assumed 
that this model has already been created and that the block attributes have been estimated 
by geostatistical or other block grade estimation methods. The method presented in 

Chapter 3 creates an orebody revenue block model in which for each block a net value is 

calculated by applying physical and economic factors to the block grade model. -In 
addition, when multiple mining slope regions are specified, four principal slope angles are 

assigned to the blocks. Finally, additional waste blocks are added around the borders of 
the block model in order to render minable the ore blocks at the bottom-most edge of the 
deposit. The optimum pit generated by the Lerchs-Grossmann algorithm may have a very 
irregular, bottom, which may not be feasible in practice because of the minimum space 

required for mining equipment to operate freely. It is possible to smooth the pit floor by 

incorporating minimum access space requirements into the algorithm but this 

significantly increases the, computing time required to reach a solution. The method 

presented in Chapter 3 determines the technical optimum pit limit and smooths the pit by 

removing non-practical blocks on the pit bottom and/or adds blocks to the optimum 

solution. 

The Lerchs-Grossmann algorithm with variable slope -angles requires , an 
estimation of a set of average and safe slope angles to determine the optimum pit limits. 

Various` procedures may be used to determine pit slope angles. If little geotechnical 
information is available they may, be found from other mines of -similar size and 

geological conditions. If the mine is in operation, predefined or existing pit slopes can be 

used to find the optimum pit limits. -In addition, in Chapter 4 two approaches and 
associated programs - steepest safe angle and the limit equilibrium method' - were 

presented to estimate a set of safe slope angles from the geotechnical information. The 

first approach determines- the' steepest safe angle with regard to, structural instability 

including plane and wedge failures without taking into account cohesion, density, ground 

water conditions and non-structural failure. This approach can be-used at design stages 

when little information is available (e. g. the pre-feasibility stage). The second approach, 

which-includes methods for the design of slopes using limit equilibrium analysis, can be 
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used when the input data are defined as fixed values (factor of safety) or as random 

variables (probability of failure). In the latter case the Monte Carlo simulation technique 

can be used to generate values of the variables. The advantage of a probabilistic 

approach over deterministic methods is that it takes into account the uncertainty inherent 

in the input data. Both approaches require engineering judgment to select' slope angles 
from the graph provided by the program. It should be noted that structural instabilities 

that can be determined kinematically are used to design slope angles. If the geology is 

complex potential failure modes may involve a combination of several mechanisms and 

when the geometry of the, slopes is well-known, slope angles must, be determined by 

more sophisticated methods such as numerical modelling. 

Almost all computer algorithms are based on a block model of the deposit, which 

requires a large memory to store block characteristics. Due to the limitation of memory 

under the DOS operating system, it is not possible to implement the Lerchs-Grossmann 

algorithm for block models that contain large numbers of blocks. DOS programs can use 

only 640 kb RAM memory, no matter how large the computer memory. Only relatively 

small deposits with up to approximately 50 x 50 x 10 blocks can be implemented on PC 

computers operating under DOS. One possible solution to overcome the memory 
limitation is to implement the algorithm on a workstation. However, workstations are not 

as widely used and available as PCs. In addition, PCs are rapidly approaching 

workstations in the storage and computational capabilities. Another solution is to use 

random access files to store block characteristics but this significantly increases the 

computing time required to determine the optimum pit. The recent developments in both 

PC hardware and software have been so rapid that many applications, including those in 

the minerals industries, have still to take advantage of the enormous potential now 

available. The PITWIN32 software, written in C++ and presented, in Chapter 5, is a 

Windows application running under 32-bit operating systems such as Windows' 95, 

Windows NT and Windows 98. It overcomes all memory limitations, by using dynamic 

memory allocation to store block characteristics. The' application of the software to 

optimal open pit design is very simple and non-computer professionals can use it. 
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Because of a different style of programming, the software is much faster than similar 

programs written in FORTRAN code. 

Any software without a good output presentation loses much of its functionality 

and purpose. Optimal pit design programs must be able to display the results of 

optimisation in such way that the user can readily understand all aspects of the design. As 

shown in Chapter 6, the PITWIN32 software provides graphical and numerical displays 

of input data and results as well as creating output files that can be subjected to further 

processing. These outputs display both the economic and technical optimum pits in plan 

and cross-sectional views and give results level by level including a summary of blocks in 

the pit, tonnage of ore and waste, value of ore and waste and mean grade of ore. The 

software provides displays of the surface topography and block plots of grade values. 

The main objectives of this work were to solve the variable slopes problem, 

incorporate slope design in optimum open pit design and implement the methods in 

general PC-based software. It is now possible to use the Lerchs-Grossmann algorithm 

with variable slope angles in planning the optimum pit limit for large, complex orebodies 

in which the 'pit slopes can vary throughout the deposit at every stage of the operation. 

However, many improvements can still be made and the following is a summary of 

recommendations for future work. 

" Production scheduling was excluded from this study. It is essential to develop 

and investigate an efficient method for production scheduling within the 

planned pit with, for example, the 
. use of artificial intelligence methods or 

other operation research techniques, and incorporate it into the software. 

" Haul roads are another important feature of open pit design that -was not 

considered in this study. It is recommended that a method for incorporating 

haul roads to be investigated and added into the software. For example, the 

method of Onur and Dowd (1993) could be readily adapted and incorporated 

into the software described here. 
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" To develop and incorporate a three-dimensional graphical display for 

visualisation of the optimum pit and the topography. 

" To develop and incorporate a graphical display for the optimum pit limits on 

cross-sections for any direction. 

" To add and incorporate geotechnical information for designing bench face 

angles. 
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Appendix A 

Instructions for executing software functions 

A. 1- To create control file 

The New command in the File menu invokes various dialogue boxes for entering the data 

required for pit optimisation and writing them into a text file (control file) for further use. 

These data include the name of the file containing the block grade model of the deposit, 

cost of mining, recovery factor and pit slopes. The following steps are required to create 

a control file: 

1- If necessary, start the PITWIN32 software. 

2- From the File menu, select the New command. 
The program displays the Control File Dialog (Basic Information) 

dialogue box illustrated in Figure A. 1. 

3- Enter the required information and use radio buttons to specify the type of the 

grade file, cost of mining and recovery factor. 

4- Choose OK. 

Depending on the specification of the cost of mining, different dialogue 

boxes are used for data entry. If the user defines cost of mining as a fixed 

value the dialogue box shown in Figure A. 2, otherwise the dialogue box 

shown in Figure A. 3 is displayed. 

Enter the cost of mining. 

6-' Choose OK. 

Depending on the specification of the recovery factor, different dialogue 

boxes are displayed for data entry. If the user defines the recovery factor as 

a fixed value the dialogue box shown in Figure A. 4 is displayed, otherwise 

the dialogue box illustrated in A. 5 is displayed. 
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Figure A. 1- Dialogue box for entering basic information 
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7- Enter the recovery factor. 

8- Choose OK. 

If one region is specified, only four principal slope angles are required to 

define pit slopes (Figure A. 6). If multiple regions are specified additional 

data including minimum and maximum depth and co-ordinates of each 

region are requested (Figure A. 7). 

9- Enter the required information on the pit slopes. 

10- Choose OK. 

The program displays the Save As dialogue box shown in Figure A. 8. 

11- In the File name List box, enter the control file name. 
12- To store the control file in a different directory or in a different drive, select the 

directory from the Folders list box and use Drives list box to choose an 

appropriate drive. 

13- Choose OK. 
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Figure A. 3- Dialogue box for entering variable cost of mining 
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If the control file is successfully created, the name of the mine will be added 

to the title bar. 
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Figure A. 8- Save as dialogue box for storing a control file 

It should be noted that some dialogue boxes for data entry (e. g., Figures A. 3 and 

A. 5) contain two extra buttons: Add and Del. The former can be used to transfer data 

from edit boxes to the list box below. The latter can be used to delete data from the list 

box provided that they have been transferred to the edit boxes. Data can also be 

transferred from the list box to edit boxes by clicking the left mouse button. It is possible 

to make changes to data with these two buttons. 

A. 2- To load an existing control file 

The following steps will load a control file: 

I- If necessary, start the PITWIN32 software. 
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2- From the File menu, select the Open command. 

The software displays the Open dialogue box shown in Figure A. 9. 

3- Locate drive, directory and then select the file to load. 

4- Choose OK. 

If the control file is successfully loaded, the name of the mine will be added 

to the title bar. 
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Figure A. 9- Open dialogue box for loading a control file 

A. 3- To edit an existing control file 

The following steps are used to edit an existing control file: 

1- If necessary, start the PITWIN32 software. 

2- Choose the Open command from the File menu to load a control file, if it has 

not already been loaded. 

3- From the File menu, choose the Edit command. 

The software invokes the various dialogue boxes in the same way as the 
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New command does. 

4- Edit the information displayed in the dialogue boxes. 

5- Follow the steps shown in the New command. 

It should be noted that when an existing control file is stored with the previous 

name, the software displays a message before saving the file, pointing out that other 

output files have been created before are not accessible and will be overwritten. This is 

due to possible changes in the control file data that may invalidate the output files. For 

example, if the cost of mining is changed, any previously created orebody revenue block 

model is invalid. These files must, therefore be created again. 
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Figure A. 10- Print Option dialogue box 

A. 4- To generate hard copy 

4 3A7AM 

The following steps generate a hard copy of the results displayed in the client area of the 

software: 

1- If necessary, start the PITWIN32 software. 
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2- ' If necessary, from the File menu, select Open to load a control file. 

3- If necessary, use, an appropriate command to display the required graphical or 

numerical results. 

4- If necessary, from the Tools menu, select the Graphical Display Option 

command to choose whether the graphical outputs are displayed with or 

without scale and to choose whether the X-axis is oriented east-west or north- 

south. 

5- If necessary, from the File menu, select Print Setup command. 

The software displays the Print Set up dialogue box. 

Select and set up the printer. Use portrait orientation for the pit results and 
landscape orientation for other outputs. Set the paper size to A4. 

7- Click the right button of the mouse to enter the figure number and adjust the 

margins. 
The program displays the Print Option dialogue box shown in 

Figure A. 10. 

8- Enter the figure or table number, top and left margin. 

9- From the File menu, choose the Print command. 

The software displays the Print dialogue box for entering the number of 
copies. 

IN Enter the required number of copies. 
11- Choose OK. 

A. 5- To. enter or edit geotechnical data 

The Geotechnical Data command in the Slope menu invokes various dialogue boxes for 

entering or editing the information required to design slope angles and to store these in a 

text file with the same name as 'the control file but with the extension of "SLD". If this 

file has already been created this command invokes information for editing. The 

information includes the simulation number, seed value for generating random numbers, 

type of failure criteria" used in analysing circular failure, strength and orientation of 
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discontinuities, rock mass strength, density and ground water conditions. The following 

steps are used to enter or edit the geotechnical data: 

a, 
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Figure A. 11- Dialogue box for entering data 

1- If necessary, start the PITWIN32 program. 

2- If necessary, from the File menu, select Open to load a control file. 

3- From the Slope menu, select Geotechnical Data option. 
The software displays the Slope Data File Dialog dialogue box as 

illustrated in Figure A. 11. 

4- Edit the seed value and simulation number and use the radio buttons to specify 

the type of failure criteria. 

5- Choose OK. 

The program displays the Slope Data File Dialog (Orientation of 

Discontinuities) dialogue box as shown in Figure A. 12. 

6- Edit or enter the orientation of discontinuities including dip and dip direction for 

each region. 
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Figure A. 12- Dialogue box for entering orientation of discontinuities 
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Figure A. 13- Dialogue box for entering strength of discontinuities 
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7- Choose OK. 

The software displays the Slope Data File . Dialog (Strength of 
Discontinuities) dialogue box as shown in Figure A. 13. 

8- Edit or, enter the strength of discontinuities including the cohesion and the 
friction angle for each region. 

9- Choose OK. 

Depending on the type of failure criteria, different dialogue boxes ' are 
displayed for data entry. For the Mohr-Coulomb criteria the dialogue box is 

shown in Figure A. 14, and for the Hoek Brown criteria the dialogue box is 

shown in Figure A. 15. 

10- Edit or enter the remaining information including rock mass strength, rock 
density, water table depth and slope height. 

11- Choose OK. 

12- Repeat steps 6 to 11 for all regions. 

It should be noted that any variable with a specified standard deviation of zero is 

considered to be a constant. 

The dialogue boxes illustrated in Figures A. 14 and A. 15 contain edit boxes for the 

maximum depth of region and for the slope height. If the optimum pit has not yet been 

determined then the program sets these two values as the maximum depth of the region. 

Once the optimum pit has been determined, the maximum depth of the region is changed 

to the maximum depth of the pit and the slope height remains fixed. If there is a 

significant difference between these two values the user may change the slope height and 

repeat the whole process - including designing slopes, creating an orebody revenue 

model and determining the optimal pit - until satisfactory results are obtained. 

A. 6- To determine the steepest safe angles 

The following steps'determine the steepest safe angle: 
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1- If necessary, start the PITWIN32 software. 

2- If necessary, from the File menu, select Open to load a control file. 

3- If necessary, from the Slope menu, select Geotechnical Data to enter the 

geotechnical information. 

4- From the Slope menu, select the option of Steepest Safe angle. 
The software calculates and displays the steepest safe angle for all the 

regions in the dialogue box illustrated in Figure A. 16. A slope value of -1 
indicates that the angle cannot be determined by this method due to lack of 

discontinuities. The user can accept, change or abandon these slope angles. 
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Figure A. 16- Four principal slope angles 
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5- Choose OK. 

The software displays a message asking the user whether or not the pit is to 

be designed with the slopes obtained by this method. 

6- Choose Yes or No to select whether the slope angles obtained by the steepest 

safe angle method are to be used to determine the optimum pit. 

0 
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If the response is Yes these slopes are replaced by the slope angles in the 

control file. 

The software can also take into account the effects of variation in dip and dip 
direction of discontinuities on the determination of the slope angles by the. steepest safe 
angle method provided that the lower (minimum) and upper (maximum) values of the 

orientation of the discontinuities are given. 

A. 7- To display the results of kinematic analysis 

The following steps will display a graphical representation of the results of kinematic 

analysis: 

1- If necessary, start the PITWIN32 software. 

2- If necessary, from the File menu, select Open to load a control file. 

3- If necessary, from the Slope menu, select Geotechnical Data to enter the 

geotechnical information. 

4- From the Slope menu, select the option of Kinematic Analysis. 

A. 8- To determine the slope angles with the limit equilibrium method 

The following steps will determine the factor of safety or the probability of failure versus 

slope angle: 

1- If necessary, start the PITWIN32 software. 

2- If necessary, from the File menu, select Open to load a control file. 

3- If necessary, from the Slope menu, select Geotechnical Data to enter the 

geotechnical information. 

4- From the Slope menu, select the command of Design of Slope. 

5- Wait until the program displays a message, indicating that the slopes are to be 

designed by the limit equilibrium method. 
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6- Choose OK. 

A. 9- To display the results of the slope design 

The following steps will display the factor of safety or the probability of failure versus 

slope angle: 

I- If necessary, start the PITWIN32 software. 

2- If necessary, from the File menu, select Open to load a control file. 

3- If necessary, from the Slope menu, select Geotechnical Data to enter the 

geotechnical information. 

4- If necessary, from the Slope menu, select Design of Slope to determine the 

factor of safety or the probability of failure versus slope angle. 

5- From the Slope menu, select the option of Result of Slope Design. 

0 

ILK 

Figure A. 17- Dialogue box for entering the region number 

and specifying the quadrant number 
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The software displays the Slope Data Dialog (Quadrant number) 

dialogue box illustrated in Figure A. 17. 

6- Enter the region number and use the radio button to specify the required 

quadrant. 
7- Choose OK. 

Romirmlo= Nil 

Pu I 

Figure A. 18- Dialogue box for entering the information required 

to determine the four principal slope angles 

A. 10- To determine the four principal slope angles 

The following these steps will determine four principal slope angles: 

1- If necessary, start the PITWIN32 software. 

2- If necessary, from the File menu, select Open to load a control file. 

3- If necessary, from the Slope menu, select Geotechnical Data to enter the 

geotechnical information. 
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If necessary, from the Slope menu, select Design of Slope to determine the 

factor of safety or the probability of failure versus slope angle. 
5- From the Slope menu, select the command of Principal Slope Angles. 

The software displays the dialogue box shown in Figure A. 18. 

6- Enter the minimum acceptable value for the factor of safety and maximum 

acceptable risk of failure and use the radio buttons to select the conditions for 

the slopes., 
7- Choose OK. 

The software calculates and displays the four principal slope angles for all 

regions in the dialogue box illustrated in Figure A. 16. The user can accept, 

change or abandon these slope angles. 

8- Choose OK. 

The software displays a message asking the user whether or not the pit is to 

be designed with the slopes obtained by this method. 

Choose Yes or No to specify whether or not to use the slope angles obtained by 

the limit equilibrium method to determine the optimum pit. 
If Yes is chosen, these slopes are replaced with the slope angles in the 

control file. 

A. 11- To create an orebody revenue block model 

The following steps will create a revenue block model: 

1- If necessary, start the PITWIN32 software. 

2- If necessary, from the File menu, select Open to load a control file. If a control 

file has not already been created, select the New command to create it. 

From the Run menu, select the command of Revenue Block Model. 

4- Wait until the program displays a message indicating that the orebody revenue 

block model has been created. 
5-' Choose OK. 
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A-12- To determine the optimum pit 

The following steps will determine the optimum pit: - 

I- If necessary, start the PITWIN32 software. 
2- 

, 
If necessary, from the File menu, select Open to load a control file. 

3- Choose Revenue Block Model from the Run menu to create an orebody 

revenue block model if it has not already, been created. 
4- From the Run menu, select the Optimum Pit Limit command. 
5- Wait until the program displays a message indicating that the optimum open pit 

limit has been determined. 

6- Choose OK. 

A. 13- To carry out pit bottom smoothing 

The following steps will smooth the pit bottom: 

1- If necessary, "start the'PITWIN32 software. 

2- If necessary, from the File menu, select Open to load a "control file. 

3- Choose Revenue Block Model from the Run menu to create an orebody 

revenue block model if it has not already been created. 
4- 'Choose Optimum Pit Limit from the Run menu to determine the optimum pit 

limit if it has not already been determined. 

5- From the Run menu, select the command of Pit Bottom Smoothing: 

The software displays the Smoothing width dialogue box for entering the 

minimum space required to smooth the pit bottom. 

6- Enter the minimum space required to carry out smoothing. 

7- Choose OK. 

8- Wait until the program displays a message indicating that the pit bottom has 

been smoothed. 
Choose OK. 
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A. 14- To display a block plot of the surface topography 

Use the following steps to display a block plot of the surface topography: 

1- If necessary, start the PITWIN32 software. 

2- If necessary, from the File menu, select Open to load a control file. 

3- Choose Revenue Block Model from " the Run menu to create an orebody 

revenue block model if one has not already been created. 
4- From the Graphical Display menu, select the Block Plot of Surface Topography 

command. 

A. 15- To display a block plot of grade value 

Use the following steps to display a block plot of the grade value for any level required: 

1- If necessary, start the PITWIN32 software. 

If necessary, from the File menu, select Open to load a control file, 

3- Choose Revenue Block Model from the Run menu to create an orebody 

revenue block model if one has not already been created. 

From the Graphical Display menu, select the Block Plot of Grade Value option. 

The program displays the dialogue box shown in Figure A. 19 for entering 

the level number and the required interval. 

5- Enter the required information. 

Choose OK. 

A. 16- To display the pit limit in plan without pit bottom smoothing 

Use the following steps to display the optimum pit without pit bottom smoothing: 

If necessary, start the PITWIN32 software. 

If necessary, from the File menu, select Open to load a control file. 

Choose Revenue Block Model from the Run menu to create an orebody 
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revenue block model if one has not already been created. 

4- Choose Optimum Pit Limit from the Run menu to determine the optimum pit 

outline if it has not already been determined. 

5- From the Graphical Display menu, select the Pit Limit Without Smoothing 

option. 
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Figure A. 19- Dialogue box for entering the level number and 

the required interval 

A. 17- To display an east-west cross-section of a pit without 

pit bottom smoothing 

Use the following steps to display an east-west cross-section of a pit without pit bottom 

smoothing: 

1- If necessary, start the PITWIN32 software. 

2- If necessary, from the File menu, select Open to load a control file. 
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3- Choose Revenue Block Model from the Run menu to create an orebody 

revenue block model if one has not already been created. 
Choose Optimum Pit Limit from the Run menu to determine the optimum pit 

outline if it has not already been determined. 

5- From the Graphical Display menu, select the Easting Section Without 

Smoothing option. 

The program displays the Easting Input dialogue box.. 

6- Enter the required Easting of the cross-section. 

7- Choose OK. 

A. 18- To display a north-south cross-section of a pit without 

pit bottom smoothing 

Use the following steps to display a north-south cross-section of a pit without pit bottom 

smoothing: 

l- If necessary, start the PITWIN32 software. 
2- If necessary, from the File menu, select Open to load a control file. 

3- Choose Revenue Block Model from the Run menu to create an orebody 

revenue block model if one has not already been created. 
Choose Optimum Pit, Limit from the Run menu, to determine the optimum pit 

outline if it has not already been, determined. 

From the Graphical Display menu, select Northing Section Without Smoothing 

The program displays the Northing Input dialogue box. 

Enter the required Northing of the cross-section. 
7- Choose OK. 

A. 19- To, display a pit limit in plan with pit bottom smoothing 

Use the following steps to display the optimum pit with pit bottom smoothing: , 
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'I- If necessary, start the PITWIN32 software. 

2- If necessary, from the File menu, select Open to load a control file. 

3- Choose Revenue Block Model from the Run menu to create an orebody 

revenue block model if one has not already been created. 
4- Choose Optimum Pit Limit from the Run menu to determine the optimum pit 

outline if one has not already been determined. 

5- Choose Pit Bottom Smoothing from the Run menu to carry, out pit bottom 

smoothing if the pit has not already. been smoothed. 
6- From the Graphical Display menu, 

, select the Pit Limit With Smoothing option. 

A. 20- To'display an east west cross-section of a pit with 

pit bottom smoothing 

Use the following steps to display an east-west cross-section of a pit with pit bottom 

smoothing: 

1- If necessary, start the PITWIN32 software. 
2- If necessary, from the File menu, select Open to load a control file. 

, 
3- Choose Revenue Block Model from the Run menu to create an orebody 

revenue block model if one has not already been created. 

4- Choose Optimum Pit Limit from the Run menu to determine the optimum pit if 

it has not already been determined. 

Choose Pit Bottom 'Smoothing from the Run menu to carry out pit bottom 

smoothing if it has not already been smoothed. 

6- From the Graphical Display menu, select Fasting Section With Smoothing. 

The software displays the Easting Input dialogue box. - 
7- Enter the Fasting of the required cross-section. 
8- Choose OK. ' 
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A. 21- To display a north-south cross-section of a pit with 

pit bottom smoothing 

Use the following steps . to display a north-south cross-section of a pit with pit bottom 

smoothing: 

1- If necessary, start the PITWIN32 software. 
2- If necessary, from the File menu, select Open to load a control file. 

3- Choose Revenue Block Model from the Run menu to create an orebody 

revenue block model if one has not already been created. 
4- Choose Optimum Pit Limit from the Run menu to determine the optimum pit 

outline if it has not already been determined. 

5- 
, 
Choose Pit Bottom Smoothing from the Run menu to carry out pit bottom 

smoothing if the pit has not already been smoothed. 

6- From the Graphical Display menu, select Northing Section With Smoothing. 

The software displays the Northing Input dialogue box. 

7- Enter the Northing of the required cross-section. 

Choose OK. 

A. 22- To display a numerical representation of the pit limit 

without pit bottom smoothing 

Use the following steps to generate a numerical display of a 'pit without pit bottom 

smoothing: 

1- If necessary, start the PITWIN32 software. '- 

2- If necessary, from the File menu, select Open to load a control file. 

3- Choose Revenue Block Model from the, Run menu to create an orebody 

revenue block model if. one has not already been created., 

4- Choose Optimum Pit Limit from the Run menu to determine the optimum pit if 

it has not already been determined. ' 
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5- From the Numerical Display menu, select the Pit Limit Without Smoothing 

option. 

A. 23- To display the results of optimisation without 

pit bottom smoothing 

Use the following steps to display the results of optimisation without pit bottom 

smoothing: 

1- If necessary, start the PITWIN32 software. 

2- If necessary, from the File menu, select Open to load a control file. 

3- Choose Revenue Block Model from the Run menu to create an orebody 

revenue block model if one has not already been created. 

4- Choose Optimum Pit Limit from the Run menu to determine the optimum pit if 

it has not already been determined. 

5- From the Numerical Display menu, select the Result Without Smoothing 

option. 

A. 24- To generate a numerical display of a pit with 

pit bottom smoothing 

Use the following steps to generate a numerical display of a pit with pit bottom 

smoothing: 

1- If necessary, start the PITWIN32 software., 

2- If necessary, from the File menu, select Open to load a control file. 

3- Choose Revenue Block Model from 'the Run menu to create an orebody 

revenue block model if one has not already been created. 

4- Choose Optimum Pit Limit from the Run menu 'to' determine the optimum pit if 

it has not already been determined. 

Choose Pit Bottom Smoothing from the Run menu to carry out pit bottom 
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smoothing if the pit has not already been smoothed. - 
6- ' From the Numerical Display menu, select the Pit Limit With Smoothing option. 

A. 25- To display the results of optimisation with pit bottom smoothing 

Use the following steps to display the results of optimisation with pit bottom smoothing: 

1- If necessary, start the PITWIN32 software. 

2- If necessary, from the File menu, select Open to load a control file. 

3- Choose Revenue Block Model from the Run menu to create an orebody 

revenue block model if one has not already been created. 

4- Choose Optimum Pit Limit from the Run menu to determine the optimum pit if 

it has not already been determined. 

5- Choose 'Pit Bottom Smoothing from the Run menu to carry out pit bottom 

smoothing if the'pit has not already been smoothed. 

6- From the Numerical Display menu, select the Result With Smoothing option. 

A. 26- To display a summary of the orebody block model 

Use the following steps to display a summary of the orebody block model: 

I- If necessary, start the PITWIN32 software. 

2- If necessary, from the File menu, select Open to load a control file. 

3- Choose Revenue Block Model from the Run menu to create an orebody 

revenue block model if one has not already been created. This option is only 

necessary for displaying a summary of the orebody revenue block model. 
From the Tools menu, select the Summary of Block Model option and then 

choose one of the two options: Grade Block Model or Revenue Block Model. 

The software displays a summary of the orebody block model in a dialogue 

box. 

5- Choose OK. 
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A. 27- To convert random access files to text files 

Use the follow these steps, to convert random access files created by the program to text 
files: 

1- If necessary, start the PITWIN32 software. 

2- If necessary, from the File menu, select Open to load a control file. 

3- Choose Revenue Block Model from the Run menu to create an orebody 

revenue block model if one has not already been created. 
Choose Optimum Pit Limit from the Run menu ' to determine ' the optimum pit if 

it has not already been determined. This option 'is 'only required to convert a 

random access file of an optimum pit to a text file. 

5-' Choose Pit Bottom Smoothing from the Run menu to carry out pit bottom 

smoothing if the pit has not already been smoothed. This option is only required 

to convert the technical optimum pit limit stored in' a random access file to a 

text file. - 

6- From the Tools menu, select the Random Access File to Text option and then 

choose one of the three options: Revenue Block Model, Pit Limit Without 

Smoothing and Pit Limit With Smoothing. 

The software displays a dialogue box for entering output file name. 

7- Enter the output file name. 

8- Choose OK. 

9- Wait until the software displays a message indicating that the output file has 

been created. 

A. 28- To create. text files for blocks inside the optimum pit limit 

Use, the following steps to create text files for blocks inside either the economical or 

technical optimum pit: 

1- If necessary, start the PITWIN32 software. 
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2- If necessary, from the File menu, select Open to load a control file. 

3- Choose Revenue Block Model from the Run menu to create an orebody 

revenue block model if one has not already been created. 
4- Choose Optimum Pit Limit from the Run menu to determine the optimum pit if 

it has not already been determined. 

5- Choose Pit Bottom Smoothing from the Run menu to carry out pit bottom 

smoothing if the pit has not already been smoothed. This option is only required 

to create a text file of blocks inside the technical optimum pit. 
6- From the Tools menu, select the Blocks Inside the Pit Limit option and then 

choose one of the six options which are available in this command. 

The software displays a dialogue box for entering the output file name. 
7- Enter the output file name. 
8- Choose OK. 

9- Wait until the software displays a message indicating that the output file has 

been created. 

A. 29- To create an equivalent orebody block model for 

a multi-mineral deposit 

Use the following steps to create an equivalent orebody grade block model for a multi- 

mineral deposit: 

1- If necessary, start the PITWIN32 software. 
2- From the Tools menu, select the option of Multi-Mineral Deposit to, One. 

The software displays a dialogue box for entering input and output file 

names and the required coefficient for each mineral. 

3- Enter the required information. 

4- Choose OK. 

5- Wait until the software displays a message indicating that the output file has 

been created. 
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A. 30- To change the direction of the Z axis in the orebody 

grade block model 

Use the following steps to change the direction of the vertical co-ordinate of the orebody 

grade block model: 

1- If necessary, start the PITWIN32 software. 

2- From the Tools menu, select the option of Change Vertical Co-ordinate. 

The software displays a dialogue box for entering input and output file 

names, block dimensions and the type of grade file. 

3- Enter the required information. 

4- Choose OK. 

5- Wait until the software displays a message indicating that the output file has 

been created. 

A. 31 - To quit the program 

Follow these steps to quit the software: 

1- From the File menu, select Exit. 

Program displays the exit dialogue box. 

2- Choose Yes. 
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